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ΚΕΦΑΛΑΙΟ  1 
Γενικές αρχές λειτουργίας και χρήσης λογιστικών 
φύλλων 
A.Σέξτος 
   

1.1 ΓΕΝΙΚΑ 

Καθώς η εργασία του μηχανικού είναι διαχρονικά συνυφασμένη με τη 
διαχείριση Στο Excel το αρχείο εργασίας και αποθήκευσης δεδομένων ονομάζεται 
βιβλίο εργασίας. Ένα βιβλίο εργασίας μπορεί να περιέχει πολλά φύλλα 
εργασίας (Sheets) ή αλλιώς λογιστικά φύλλα, όπου γίνεται η εισαγωγή και 
επεξεργασία των δεδομένων (Σχ. 1.1). Κάθε φύλλο εργασίας έχει τη μορφή 
πλέγματος στηλών και γραμμών που είναι αριθμημένες με γράμματα (Α, Β, C, …) 
και αριθμούς (1, 2, 3,…) αντίστοιχα. Σε ένα φύλλο υπάρχουν 256 γραμμές και 
65.536 γραμμές. Από την τομή μιας γραμμής και μιας στήλης σχηματίζεται ένα 
κελί το οποίο προσδιορίζεται από το αντίστοιχο γράμμα και αριθμό (αναφορά), για 
παράδειγμα το κελί Β2 βρίσκεται στη Β στήλη και στη 2η γραμμή. 

Το κελί το οποίο επεξεργαζόμαστε κάθε φορά ονομάζεται ενεργό κελί και 
διακρίνεται από το έντονο πλαίσιο που το περιβάλλει. Η αναφορά κάθε ενεργού 
κελιού, φαίνεται στο πλαίσιο ονόματος, ενώ το περιεχόμενο του κελιού, φαίνεται 
στη γραμμή τύπων. Το περιεχόμενο μπορεί να είναι κείμενο, αριθμός, 
ημερομηνία, συνάρτηση ή τύπος. 

Εξ ορισμού ένα νέο βιβλίο εργασίας περιλαμβάνει 3 φύλλα. Σε κάθε φύλλο 
αντιστοιχεί μία ετικέτα η οποία εμφανίζεται στο κάτω αριστερό μέρος, οπότε και 
είναι εύκολη η μετακίνηση από φύλλο σε φύλλο. Επιπλέον πατώντας το δεξί 
πλήκτρο του ποντικιού επάνω σε μια ετικέτα ενός φύλλου εργασίας, είναι δυνατή 
η εισαγωγή νέου φύλλου, καθώς και η διαγραφή, μετονομασία, μετακίνηση ή 
αντιγραφή του τρέχοντος φύλλου.  
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Σχήμα 1.1. Φύλλο εργασίας Excel. 

1.2  ΓΡΑΜΜΗ ΜΕΝΟΥ   

Η γραμμή μενού του Excel, περιλαμβάνει εννέα καταλόγους επιλογών (Σχ.1.2). Η 
επιλογή ενός πτυσσόμενου μενού οδηγεί σε ένα κατάλογο επιλογών μερικές εκ 
των οποίων τελειώνουν με αποσιωπητικά (π.χ Αποθήκευση ως…), που σημαίνει ότι 
η συγκεκριμένη εντολή οδηγεί σε άλλο πλαίσιο διαλόγου. 

Ετικέτα φύλλου Ενεργό κελί 
(Ε14) 

Πλαίσιο 
ονόματος 

Γραμμή 
τύπων 
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Σχήμα 1.2 Γραμμή μενού Excel. 

 

Αρχείο (File): Το κλασσικό μενού των προγραμμάτων σε περιβάλλον Windows, που 

περιλαμβάνει τις βασικές επιλογές διαχείρισης ενός αρχείου, όπως τη Δημιουργία, 

Άνοιγμα ή Κλείσιμο, καθώς και τις επιλογές Αποθήκευσης και Εκτύπωσης. 

Επεξεργασία (Edit): Περιλαμβάνει τις επιλογές Αναίρεσης ή Επανάληψης της 

τελευταίας εντολής, της Αποκοπής, Αντιγραφής ή Επικόλλησης του περιεχομένου 

ενός ή περισσοτέρων κελιών. Επίσης τις εντολές αυτόματης Συμπλήρωσης, 

Διαγραφής κελιών ή φύλλων, την Εύρεση και Αντικατάσταση του περιεχομένου 

ενός κελιού και τη Μετάβαση σε κάποια αναφορά. 

Προβολή (View): Περιέχει επιλογές  σχετικές με την κατάσταση προβολής των 

φύλλων εργασίας, καθώς και με επιλογές εμφάνισης εργαλείων του Excel. 

Εισαγωγή (Insert): Από εδώ είναι δυνατή η εισαγωγή νέων κελιών, γραμμών 

ή στηλών, καθώς και φύλλων εργασίας και γραφημάτων. Επίσης, περιέχονται 

οι επιλογές  εισαγωγής μιας συνάρτησης ή ενός σχολίου στο ενεργό κελί, 

καθώς και εισαγωγής εικόνας, αντικειμένων ή δεσμού σύνδεσης με άλλο 

έγγραφο ή διεύθυνση URL.   

Μορφή (Format): Στο μενού αυτό υπάρχουν εντολές σχετικές με την 

μορφοποίηση των κελιών, γραμμών, στηλών και φύλλων εργασίας. 

Εργαλεία (Tools): Περιλαμβάνονται επιλογές όπως ο ορθογραφικός 

έλεγχος ή η δημιουργία μακροεντολών, καθώς και διάφορες επιλογές 

ρυθμίσεων. 

Δεδομένα (Data): Περιέχονται διάφορες επιλογές διαχείρισης των 

δεδομένων. 
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1.3 ΓΡΑΜΜΕΣ ΕΡΓΑΛΕΙΩΝ  

 
Εκτός από τη γραμμή των μενού, υπάρχουν κάποιες γραμμές εργαλείων 

του Excel (toolbars), όπου περιέχονται βασικές επιλογές των μενού υπό τη μορφή 
κουμπιών.  Εξ ορισμού εμφανίζονται η βασική γραμμή (standard) και η γραμμή 
μορφοποίησης (formatting). Ωστόσο είναι δυνατή η προσθήκη και άλλων 
γραμμών ή η προσθήκη μεμονωμένων κουμπιών που αντιστοιχούν σε μια εντολή. 
Πατώντας το δεξί πλήκτρο του ποντικιού πάνω σε μια γραμμή εργαλείων, 
εμφανίζεται ένα μενού επιλογής επιπλέον γραμμών εργαλείων. Επιλέγοντας την 
Προσαρμογή, οδηγούμαστε σε ένα νέο παράθυρο, όπου στην καρτέλα Εντολές, 
είναι δυνατή η επιλογή συγκεκριμένων εντολών για τις διάφορες κατηγορίες, που 
σύρονται και προστίθενται με τη μορφή μεμονωμένων κουμπιών σε μια υπάρχουσα 
γραμμή εργαλείων (Σχ.1.3). Επίσης είναι δυνατή η δημιουργία προσαρμοσμένων 
γραμμών εργαλείων στην καρτέλα Γραμμές Εργαλείων. 
 

Σχήμα 1.3 Προσθήκη εντολών στη γραμμή εργαλείων 

 
Για παράδειγμα, στο παραπάνω σχήμα φαίνεται η επιλογή της εντολής Διαγραφής 
γραμμών, που ανήκει στην κατηγορία Επεξεργασία. Αφού επιλεχτεί η 
συγκεκριμένη εντολή, με τη βοήθεια του ποντικιού σύρεται ως κουμπί 
συντόμευσης πλέον, στην γραμμή εργαλείων.  
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Σχ. 1.4 Bασική γραμμή εργαλείων Excel. 

Δημιουργία - Άνοιγμα - Αποθήκευση αρχείου 

Εκτύπωση - Προεπισκόπηση εκτύπωσης - Έλεγχος ορθογραφίας 

Αποκοπή - Αντιγραφή - Επικόλληση κελιών. 

Αναίρεση - Επανάληψη τελευταίας εντολής. 

Πινέλο Μορφοποίησης. Επιλέγοντας ένα κελί και στη 

συνέχεια ενεργοποιώντας το πινέλο μορφοποίησης, είναι 

δυνατό να αντιγραφούν σε ένα ή περισσότερα κελιά οι 

ιδιότητες μορφοποίησης του κελιού που έχει επιλεxθεί 

αρχικά, π.χ περίγραμμα, στυλ ή μέγεθος γραμματοσειράς. 

Εισαγωγή δεσμού σύνδεσης με άλλο έγγραφο ή 

διεύθυνση URL - Ενεργοποίηση της 

εργαλειοθήκης Web. 

Ρύθμιση του Ποσοστού Ζουμ. 

Ενεργοποίηση της εργαλειοθήκης σχεδίασης 

Εισαγωγή χάρτη 

Εισαγωγή Γραφήματος. Ενεργοποιείται ο οδηγός γραφημάτων. 

Ταξινόμηση γραμμών ή στηλών κατά αύξουσα ή φθίνουσα σειρά 

με βάση το περιεχόμενο των κελιών μιας στήλης ή μιας γραμμής. 

Εισαγωγή συνάρτησης. Ενεργοποιείται ο οδηγός συναρτήσεων. 

Αυτόματη άθροιση. Με την εντολή αυτή στο ενεργό 

κελί εμφανίζεται το άθροισμα των τιμών όλων των 

κελιών που βρίσκονται από επάνω του. 
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H γραμμή μορφοποίησης (Σχ. 1.5) περιλαμβάνει, υπό μορφή κουμπιών, τις 
βασικές εντολές μορφοποίησης του περιεχομένου και της μορφής των κελιών. 
Μοιάζει με την αντίστοιχη γραμμή μορφοποίησης του κειμενογράφου (Word). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 1.5. Γραμμή μορφοποίησης Excel. 

Επιλογή γραμματοσειράς και μεγέθους. 

Επιλογή έντονης (Β), πλάγιας (Ι) ή υπογραμμισμένης 

(U) γραφής του περιεχομένου των κελιών. 

Στοίχιση αριστερά, στο κέντρο ή δεξιά, 

του περιεχομένου των κελιών. 

Συγχώνευση δύο ή περισσότερων 

επιλεγμένων κελιών. 

Αύξηση ή μείωση των δεκαδικών ψηφίων του αριθμού που 

περιέχεται στο επιλεγμένο κελί. Όταν το περιεχόμενο ενός κελιού 

εμφανίζεται όπως στο παρακάτω εικονίδιο, απαιτείται η μείωση των 

δεκαδικών ψηφίων, καθώς δεν επαρκεί το πλάτος του κελιού για να 

εμφανιστούν όλα τα ψηφία.    

 

Αύξηση ή μείωση της εσοχής εντός του επιλεγμένου κελιού. 

Πτυσσόμενο μενού επιλογών μορφοποίησης του 

περιγράμματος επιλεγμένων κελιών. 

Επιλογή χρώματος γεμίσματος κελιών και χρώματος της 

γραμματοσειράς  του περιεχομένου των κελιών. 
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1.4 ΓΡΑΜΜΗ ΤΥΠΩΝ 

Η γραμμή τύπων (Σχ. 1.6) είναι μια γραμμή που βρίσκεται κάτω από τις 
γραμμές εργαλείων του Excel και χρησιμοποιείται για την εισαγωγή ή επεξεργασία 
τύπων ή τιμών στα κελιά και γραφήματα, εμφανίζοντας την σταθερά ή τύπο του 
ενεργού κελιού. 
  

Σχήμα 1.6 Γραμμή τύπων Excel. 

 
Προκειμένου να ελέγξουμε ή να επεξεργαστούμε κάποιον τύπο, επιλέγουμε το κελί 
που τον περιέχει και στη συνέχεια κάνοντας κλικ στη γραμμή τύπων (Σχ. 1.7), 
χρωματίζονται διαφορετικά οι αναφορές των κελιών που περιέχονται στον τύπο, 
ενώ τα αντίστοιχα κελιά αποκτούν περίγραμμα με το ίδιο χρώμα, όπως και στη 
γραμμή τύπων. 

Σχήμα 1.7 Περιεχόμενα τύπου. 

 
 
 
 
 

Γραμμή τύπων. 
Αριστερά εμφανίζεται ο 
αριθμός του ενεργού κελιού 
(Β1) και δεξιά η τιμή ή τύπος 
που περιέχεται στο ενεργό 
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1.5 ΕΙΣΑΓΩΓΗ ΣΥΝΑΡΤΗΣΕΩΝ 

Το Excel παρέχει τη δυνατότητα εισαγωγής ποικίλων συναρτήσεων, οι οποίες 
είναι ταξινομημένες στις εξής κατηγορίες: οικονομικές, μαθηματικές και 
τριγωνομετρικές, στατιστικές, συναρτήσεις σχετικές με την ημερομηνία και ώρα, 
λογικές, αναζήτησης και αναφοράς, συναρτήσεις σχετικές με βάσεις δεδομένων, 
κειμένου και διαφόρων πληροφοριών. 
Πατώντας στο πλήκτρο συντόμευσης επικόλλησης συναρτήσεων, 

εμφανίζεται ένα νέο παράθυρο (Σχήμα 1.8), όπου φαίνονται όλες οι 
κατηγορίες με τις αντίστοιχες συναρτήσεις, ενώ στο κάτω μέρος δίνεται 
σύντομη περιγραφή της συνάρτησης που είναι ενεργοποιημένη κάθε φορά. 
Αφού επιλεχθεί μια συνάρτηση εμφανίζεται ένα παράθυρο-οδηγός, στο οποίο 
συμπληρώνονται στα κατάλληλα πεδία τα απαραίτητα ορίσματα, ενώ στο κάτω 
μέρος γίνεται περιγραφή του κάθε πεδίου.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Σχήμα 1.8 Μενού Επικόλλησης συνάρτησης. 

 
 
 
 
 

=SUM(A5,A10:A20,10,50)

Ορίσματα 

Οι παρενθέσεις εσωκλείουν τα ορίσματα 

Οι υποδιαστολές χωρίζουν τα ορίσματα 

Όνομα συνάρτησης 
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1.5.1 Βασικές Συναρτήσεις 
 
Οι συναρτήσεις είναι έτοιμοι τύποι που εκτελούν υπολογισμούς, 

χρησιμοποιώντας ειδικές τιμές που καλούνται ορίσματα, σε συγκεκριμένη σειρά, 

που καλείται σύνταξη. Κάθε συνάρτηση αποτελείται από τρία στοιχεία:  

Α. Το σύμβολο "=", που δείχνει ότι ακολουθεί συνάρτηση τύπος. 

Β. Το όνομα της συνάρτησης. 

Γ. Τα ορίσματα, που αντιστοιχούν στις τιμές που θα ενεργήσει η συνάρτηση. Τα 

ορίσματα μπορεί να είναι σταθερές (αριθμοί, κείμενο, λογικές τιμές όπως TRUE ή 

FALSE, πίνακες), αναφορές κελιών, τύποι ή άλλες συναρτήσεις. 

 

ΠΑΡΑΔΕΙΓΜΑ: 

 

 

 

ΣΥΝΑΡΤΗΣΗ ΠΕΡΙΓΡΑΦΗ ΕΦΑΡΜΟΓΗ 

SQRT Επιστρέφει τη ρίζα πραγματικού 

αριθμού. 

=SQRT(A6)  3,1623 

ABS Επιστρέφει την απόλυτη τιμή 

ενός αριθμού. 

=ABS(A4) 8,0 

AVERAGE Επιστρέφει τον αριθμητικό μέσο 

όρο ενός συνόλου ορισμάτων. 

=AVERAGE(Β1:Β7) 126,14 

SUM Επιστρέφει το άθροισμα των 

αριθμών μιας περιοχής. 

=SUM(A1:A7) 104,00 

MIN Επιστρέφει την μικρότερη τιμή 

ενός συνόλου ορισμάτων. 

=ΜΙΝ(Α1:Α6) -8,0 

MAX Επιστρέφει την μεγαλύτερη τιμή 

ενός συνόλου ορισμάτων. 

=ΜΑΧ(Β1:Β6) 532,0 

PI() Επιστρέφει τον αριθμό 

3.14159265358979, την 

μαθηματική δηλαδή σταθερά π, 

με ακρίβεια 15 δεκαδικών. 

=PI()*(A7^2) 

(εμβαδό κύκλου με 

ακτίνα 6) 

113,097 

EXP Επιστρέφει το e (βάση νεπέριου 

λογαρίθμου) υψωμένο σε κάποιο 

αριθμό. 

=ΕΧΡ(Β1) 1096,63 

LN Επιστρέφει το νεπέριο λογάριθμο =LN(A1) 2,398 
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1.5.2  Τριγωνομετρικες συναρτησεις 

Παρακάτω περιγράφονται οι πιο συχνά χρησιμοποιούμενες τριγωνομετρικές 
συναρτήσεις. Γενικά στο Εxcel οι γωνίες που εισάγονται στις τριγωνομετρικές 
συναρτήσεις είναι ακτίνια. Επειδή συνήθως χρησιμοποιούμε γωνίες εκφρασμένες 
σε μοίρες, πρέπει να γίνεται μετατροπή των μοιρών σε ακτίνια κατά την εφαρμογή 
των τριγωνομετρικών συναρτήσεων. Αυτό μπορεί να γίνει είτε με τη χρήση της 
συνάρτησης DEGREES είτε με των πολλαπλασιασμό των μοιρών κάθε φορά με την 
ποσότητα π/180. 
 
ΣΥΝΑΡΤΗ

ΣΗ 

ΠΕΡΙΓΡΑΦΗ ΕΦΑΡΜΟΓΗ 

COS Επιστρέφει το συνημίτονο μιας 

γωνίας (σε ακτίνια) 

=30*pi()/180 

(μετατροπή των 30 μοιρών σε 

ακτίνια)  

=COS(0,5236) 

0.5236 

 

 

0,866 

SIN Επιστρέφει το ημίτονο μιας 

γωνίας (σε ακτίνια) 

=SIN(0,5236) 0,5 

ΤΑΝ Επιστρέφει την εφαπτομένη μιας 

γωνίας (σε ακτίνια) 

=TAN(0,5236) 0,577 

ACOS Επιστρέφει το τόξο συνημιτόνου 

ενός αριθμού, σε ακτίνια και στο 

ευρος τιμών από 0 εως π. 

=ACOS(0,707)  
 
 

=ACOS(0,707)*180/PI()   

0,7855  
σε ακτίνια 

 
450 

σε μοίρες 

ASIN Επιστρέφει το τόξο ημιτόνου 

ενός αριθμού, σε ακτίνια και στο 

ευρος τιμών από –π/2 εως π/2. 

=ASIN(0,5)   
 

=ASIN(0,5)*180/PI() 

0,52359  
σε ακτίνια 

300       
σε μοίρες 

DEGREES Μετατρέπει τα ακτίνια σε μοίρες =DEGREES(1,266) 72,540 

RADIANS Μετατρέπει τις μοίρες σε ακτίνια =RADIANS(60) 1,0472 
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1.5.3  Στατιστικές Συναρτήσεις 

To Excel παρέχει ένα μεγαλο αριθμό συναρτήσεων στατιστικής. Παρακάτω 
εξετάζεται μια απλή εφαρμογή κανονικής κατανομής. 

 
ΠΑΡΑΔΕΙΓΜΑ 

Έστω οτι οι παρακάτω τιμές αντιστοιχούν στο φορτίο αστοχίας (tons) δοκιμαστικής 

φόρτισης 10 πασσάλων.  

 
 
Υπολογίζεται η μέση τιμή, η τυπική απόκλιση και η πιθανότητα να αστοχήσει ένας 
πάσσαλος για φόρτιση 88tons, θεωρώντας κανονική κατανομή για το φορτίο 
αστοχίας. 
 
Συνάρτηση Περιγραφή Εφαρμογή 

AVERAGE Επιστρέφει τον αριθμητικό 

μέσο όρο. 

=AVERAGE(Α1:Α11) 84 

STDEV Υπολογίζει την τυπική 

απόκλιση ενός συνόλου τιμών. 

=STDEV(A1:A10) 7,11 

ΝΟRMDIST Επιστρέφει την πιθανότητα για 
κανονική κατανομή με 
δεδομένη μέση τιμή και τυπική 
απόκλιση. 
=NORMDIST(εξεταζόμενη 
τιμή;μέσος όρος;τυπική 
απόκλιση;TRUE) 

=NORMDIST(D2;Β2;C2;T

RUE)  

72% 

 
Αν θέλαμε να βρούμε το φορτίο με το οποίο θα 
μπορούσαμε να φορτίσουμε τους πασσάλους 
έχοντας πιθανότητα το πολύ 10% για να 
αστοχήσουν, τότε συντάσουμε σε ένα κελί την 
συνάρτηση ως εξής: 
=NORMDIST(D2;B2;C2;TRUE), όπου D2 είναι το 
κελί στο οποίο θα εισάγουμε τιμές φόρτισης, 
ώσπου με δοκιμές να βρούμε τελικά 0,1 (10%). 
 

84 91.1 
μ-σ 

76.9 
μ-σ 
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1.5.4  Λογικές Συναρτήσεις 

Οι πιο συνηθισμένες από τις λογικές συναρτήσεις φαίνονται παρακάτω: 

 
ΠΑΡΑΔΕΙΓΜΑ 

 
IF Αποδίδει μια τιμή εάν μια 

καθορισμένη συνθήκη είναι 

TRUE και μια άλλη τιμή εάν είναι 

FALSE. 

=ΙF(B2<100;TRUE;FALSE) TRUE 

AND Ελέγχει εαν όλα τα ορίσματα 

είναι αληθή  

=AND(Α1>Β1;Α2<Β2) 

 

=AND(Α1>Β1;Α2>Β2) 

ΤRUE 

 

FALSE 

OR Ελέγχει εαν κάποιο από τα 

ορίσματα είναι αληθή. 

Επιστρέφει ΤRUE αν έστω και 

ένα είναι αληθές ή FALSE αν όλα 

είναι λάθος. 

=OR(Α1>Β1;Α2>Β2;A3>B3) 

 

=OR(A3=B3;A1<A2) 

TRUE 

 

FALSE 

 

 

Χρησιμοποιώντας παραπάνω από μια συνάρτηση, έχουμε τον σχηματισμό ενός 

τύπου. 

 

ΠΑΡΑΔΕΙΓΜΑ ΑΠΟΤΕΛΕΣΜΑ 

=SQRT(B5)+AVERAGE(B1:B7)-MAX(A1:B1) 138,21 

=IF(OR(A1>B1;AND(A2<B2;A6<B6));TRUE;FALSE) TRUE 
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1.6  ΑΥΤΟΜΑΤΗ ΕΙΣΑΓΩΓΗ ΔΕΔΟΜΕΝΩΝ 

 
Προκειμένου να εισάγουμε μια σειρά από αριθμούς πχ. από 1 έως 20, χωρίς να 
τους γράψουμε με το χέρι, χρησιμοποιούμε την εντολή "Συμπλήρωση" (Σχ.1.9). 
- Πληκτρολογούμε τον 1ο αριθμό (π.χ 1) και καθιστούμε το κελί με τον αριθμό 

αυτό ενεργό. 
- Επιλέγουμε από το μενού Επεξεργασία ⇒ Συμπλήρωση⇒ Σειρά. 
- Στο παράθυρο που εμφανίζεται επιλέγουμε Αριθμητική πρόοδος στην 

περιοχή Τύπος.  
- Στην περιοχή Σειρά σε, επιλέγουμε Γραμμές (για εμφάνιση των αριθμών 

οριζόντια) ή Στήλες (για εμφάνιση των αριθμών κάθετα). 
- Στο πεδίο Τιμή βήματος γράφουμε το βήμα που επιθυμούμε (π.χ 1). 
- Στο πεδίο Τελική τιμή γράφουμε την τελική τιμή (π.χ 20). 
 

Σχήμα 1.9 . Αυτόματη εισαγωγή σειράς αριθμών σε στήλη. 
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1.7 ΑΥΤΟΜΑΤΗ ΣΥΜΠΛΗΡΩΣΗ 

 
Η αυτόματη συμπλήρωση δίνει τη δυνατότητα αντιγραφής μιας τιμής ή ενός  
τύπου που βρίσκεται σε κάποιο κελί, σε άλλα κελιά με χρήση σχετικών, απολύτων 
ή μερικώς απολύτων τιμών. 
 
Γενικά η συμπλήρωση γίνεται εάν σύρουμε τη λαβή συμπλήρωσης ενός κελιού, 
αντιγράφοντας έτσι αυτό το κελί σε άλλα κελιά της ίδιας γραμμής ή στήλης. 
Λαβή συμπλήρωσης είναι το μικρό μαύρο τετράγωνο στη γωνία της επιλογής, το 
οποίο όταν επιλεχτεί μετατρέπεται σε μαύρο σταυρό. 
  
 
 
 
Εάν το κελί περιέχει αριθμό, ημερομηνία ή χρονική περίοδο που το Microsoft Excel 
μπορεί να επεκτείνει εν σειρά, οι τιμές προσαυξάνονται αντί να αντιγράφονται. Για 
παράδειγμα, αν το κελί περιέχει τη λέξη "Ιανουάριος", μπορούν να συμπληρωθούν 
γρήγορα άλλα κελιά της γραμμής ή της στήλης με τις λέξεις "Φεβρουάριος", 
"Μάρτιος" κ.ο.κ.  
 
Αντιγραφή με σχετικές τιμές  
 
- Εισάγουμε τα δεδομένα (Σχ. 1.10) π.χ στη στήλη Α τους αριθμούς 1,3,5.. 

(κελιά Α2:Α5) που αντιστοιχούν στις μεταβλητές x για τις οποίες θέλουμε να 
υπολογίσουμε την τιμή του τύπου x+x2. 

- Στο κελί Β2 εισάγουμε τον τύπο =Α2+Α2^2 που υπολογίζει την τιμή για την 
μεταβλητή που περιέχεται στο κελί Α2. 

- Για να υπολογίσουμε τις τιμές και για τις παρακάτω μεταβλητές, απλά σύρουμε 
τη λαβή συμπλήρωσης του κελιού Β2 προς τα κάτω, οπότε αυτόματα στα κελιά 
της στήλης Β σχηματίζεται ο αντίστοιχος τύπος και εμφανίζεται η τιμή του. 

Σχήμα 1.10. Στη στήλη Α είναι οι μεταβλητές x, στη στήλη Β υπολογίζονται οι τιμές του τύπου 
Χ+Χ2. Δεξιά φαίνεται ο τύπος σε κάθε κελί όπως σχηματίζεται με τη διαδικασία της 
αντιγραφής. 

 
 

Λαβή συμπλήρωσης 
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Αντιγραφή με απόλυτες τιμές 
 
Στην περίπτωση που θέλουμε κάποια από τις παραμέτρους ενός τύπου να μην 
αλλάζει καθώς ο τύπος αντιγράφεται σε άλλα κελιά, χρησιμοποιούμε την απόλυτη 
τιμή.  
Για παράδειγμα (Σχ. 1.11) αν θέλουμε να υπολογίσουμε την τιμή του τύπου 
Χ+aΧ2, όπου το a δεν μεταβάλλεται (πχ a=10), ακολουθούμε την ίδια με πριν 
διαδικασία, αλλά στη θέση του a, εισάγουμε την αναφορά (κελί Β1), αλλά με την 
μορφή $Β$1, οπότε κατά την αντιγραφή του τύπου στα παρακάτω κελιά η 
αναφορά αυτή παραμένει σταθερή.  

Σχήμα 1.11 Αντιγραφή με απόλυτες τιμές. Δεξιά φαίνεται ο τύπος που περιέχεται στη στήλη Β. 

 
Ένας εύκολος τρόπος για την σύνταξη του $Β$1 είναι να πατήσουμε F4, αφού 
εισάγουμε την αναφορά Β1 στον τύπο. 
 
Αντιγραφή με μερικώς απόλυτες τιμές 
 
Έστω ότι ο τύπος που θέλουμε να αντιγράψουμε είναι =Α1. Η αντιγραφή με 
μερικώς απολύτως τιμές σημαίνει ότι είναι δυνατόν κατά την αντιγραφή να 
διατηρείται μόνο η στήλη ή η γραμμή σταθερή κατά περίπτωση. Για παράδειγμα, 
εάν εισάγουμε στο κελί C1 την συσχέτιση =Α1 ως: 
=Α$1 τότε η γραμμή παραμένει σταθερή ανεξαρτήτως της θέσης αντιγραφής.  
=$Α1 τότε η στήλη παραμένει σταθερή ανεξαρτήτως της θέσης αντιγραφής.  
Ένας εύκολος τρόπος για τη σύνταξη του Α$1 και $Α1, είναι να πατήσουμε 
διαδοχικά F4, αφού εισάγουμε την αναφορά Α1. 
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1.8  ΔΗΜΙΟΥΡΓΙΑ ΓΡΑΦΗΜΑΤΩΝ 

Μία από τις βασικότερες δυνατότητες του Excel είναι η δημιουργία 
γραφημάτων, δηλαδή γραφική παράσταση των δεδομένων που έχουν 
προηγουμένως καταχωρηθεί ή υπολογιστεί σε ένα φύλλο εργασίας. Οι πιο 
συνηθισμένοι τύποι γραφημάτων είναι: Γραμμές, διασπορά (ΧΥ), στήλες ή ράβδοι 
τμημάτων, πίτα. Στο παρακάτω σχήμα φαίνονται οι βασικές περιοχές ενός 
γραφήματος.  

Σχήμα 1.12 Βασικά στοιχεία γραφήματος. 

 

Τα βήματα για τη δημιουργία  ενός γραφήματος είναι τα παρακάτω: 
ΒΗΜΑ 1: Εισάγουμε τα δεδομένα Χ και Υ. 
ΒΗΜΑ 2: Επιλέγουμε την περιοχή των δεδομένων που θέλουμε να 
χαρτογραφήσουμε (Α1:Β6) 
ΒΗΜΑ 3: Από τη βασική γραμμή εργαλείων επιλέγουμε τον οδηγό 
γραφημάτων. 
ΒΗΜΑ 4: Στο εμφανιζόμενο μενού επιλέγουμε τον τύπο γραφήματος που 
επιθυμούμε. Για χαρτογράφηση δεδομένων ΧΥ, επιλέγουμε τον τύπο Διασπορά ΧΥ. 
(Σχήμα 1.13) 

Τίτλος γραφήματος

0
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200
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δεδομένων 
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Σχήμα 1.13 Οδηγός Γραφημάτων-Επιλογή τύπου γραφήματος 

 
ΒΗΜΑ 5: Συνεχίζουμε, πατώντας "Επόμενο", οπότε εμφανίζεται ένα μενού με την 
προεπισκόπηση του γραφήματος και την αντίστοιχη περιοχή δεδομένων (Σχ.1.14).  

Σχήμα 1.14 Οδηγός Γραφημάτων-Περιοχή δεδομένων/Προεπισκόπησης γραφήματος 
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ΒΗΜΑ 6: Επιλέγουμε "Επόμενο" και εμφανίζεται ένα μενού με διάφορες επιλογές 
του γραφήματος (Σχ.1.15). Έτσι μπορούμε να δώσουμε στην καρτέλα "Τίτλοι" 
τους τίτλους των αξόνων και του γραφήματος, στην καρτέλα "Άξονες" να 
επιλέξουμε την εμφάνιση ή μη των αξόνων, στις "Γραμμές Πλέγματος" να 
επιλέξουμε την εμφάνιση ή μη των κύριων και δευτερευουσών γραμμών, στο 
"Υπόμνημα" τη θέση του υπομνήματος και στις "Ετικέτες δεδομένων" την 
εμφάνιση ή μη των τιμών Χ και Υ δίπλα στα αντίστοιχα σημεία του γραφήματος. 

Σχήμα 1.15 Οδηγός Γραφημάτων-Επιλογές γραφήματος 

 
ΒΗΜΑ 7: Στο επόμενο βήμα του οδηγού γραφήματος επιλέγουμε αν το γράφημα 
θα τοποθετηθεί μεμονωμένο σε νέο φύλλο εργασίας ή ως αντικείμενο στο τρέχον 
φύλλο. 
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1.8.1  Μορφοποίηση γραφήματος 

Με διπλό πάτημα του αριστερού πλήκτρου του ποντικιού πάνω στο στοιχείο του 
γραφήματος που θέλουμε να μορφοποιήσουμε (άξονας, σειρά δεδομένων, περιοχή 
γραφήματος, περιοχή σχεδίασης), εμφανίζεται ένα μενού όπου υπάρχουν διάφορες 
επιλογές μορφοποίησης, όπως χρωμάτων, γραμματοσειρών κτλ.  

Σχήμα 1.16 Μενού μορφοποίησης άξονα γραφήματος 

 
Μορφοποίηση άξονα 
Συχνά απαιτείται η αλλαγή των χαρακτηριστικών των αξόνων ενός γραφήματος. 
Με διπλό πάτημα του αριστερού πλήκτρου του ποντικιού στον αντίστοιχο άξονα 
εμφανίζεται το παράθυρο μορφοποίησής του (Σχ. 1.16 ). Στην καρτέλα "Κλίμακα" 
μπορούμε να αλλάξουμε το ελάχιστο και μέγιστο του άξονα, την κύρια μονάδα του 
άξονα, το σημείο διασταύρωσης με τον άλλο άξονα, καθώς και την μετατροπή του 
σε λογαριθμική κλίμακα. 
 
Στην καρτέλα "Μοτίβα" παρέχεται η δυνατότητα προσαρμογής του στυλ γραμμής, 
χρώματος και πάχους του επιλεγμένου άξονα. Επιπλέον μπορεί να γίνει επιλογή 
του τύπου υποδιαίρεσης, (τα σημάδια υποδιαίρεσης είναι μικρές γραμμές μέτρησης 
που τέμνουν τον άξονα και μοιάζουν με υποδιαιρέσεις χάρακα). 

 
Εναλλακτικά, μπορούμε να μορφοποιήσουμε ορισμένα στοιχεία ενός από τα 
στοιχεία του γραφήματος, απλά επιλέγοντας το και εν συνεχεία χρησιμοποιώντας 
αντίστοιχα κουμπιά συντόμευσης από την γραμμή μορφοποίησης. Έτσι γίνεται να 
αλλάξουμε χαρακτηριστικά όπως, το χρώμα ή μέγεθος των αριθμών ενός άξονα, 
καθώς και τον αριθμό τον δεκαδικών τους ψηφίων, ενώ στην περίπτωση τίτλου ή 
υπομνήματος την γραμματοσειρά, χρώμα, μέγεθος κτλ. με την βοήθεια των 
αντιστοίχων κουμπιών της γραμμής μορφοποίησης. 
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Με δεξί κλικ επί του γραφήματος εμφανίζεται ένα μενού πολλαπλών επιλογών 
(Σχ. 1.17). Σε αυτό μπορούμε να αλλάξουμε τον τύπο γραφήματος, τα δεδομένα 
προέλευσης ή άλλες επιλογές του γραφήματος όπως τίτλους, υπόμνημα γραμμές 
πλέγματος κτλ. 

 

Σχήμα 1.17 Μενού επιλογών γραφήματος(δεξί κλικ). 
 

1.8.2 Γράφημα με 2 σετ τιμών Υ 

Είναι σύνηθες να απαιτείται η δημιουργία γραφήματος που περιλαμβάνει δυο 
σετ τιμών y για τα ίδια x, δηλαδή γραφήματος που θα έχει δύο (ή και 
περισσότερες) καμπύλες (Σχ. 1.18). Σε αυτή την περίπτωση, αφού 
καταχωρήσουμε τα δεδομένα έτσι ώστε η στήλη με τις τιμές x να βρίσκεται 
αριστερά των στηλών με τις τιμές των y, επιλέγουμε την περιοχή με τα δεδομένα 
x,y και ακολουθούμε τα ίδια με προηγουμένως βήματα. 

 

Σχήμα 1.18. Γράφημα με 2 σετ τιμών Υ. 
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1.8.3  Προσθήκη σειράς δεδομένων σε γράφημα 

Εάν θέλουμε να προσθέσουμε στο ίδιο γράφημα επιπλέον καμπύλες που 
αντιστοιχούν σε διαφορετικές τιμές x και y, τότε ακολουθούμε τα εξής βήματα: 
- Κάνουμε δεξί κλικ επάνω στο γράφημα που θέλουμε να προσθέσουμε 

δεδομένα. 
- Στο εμφανιζόμενο μενού επιλέγουμε "Δεδομένα προέλευσης". 
- Στο εμφανιζόμενο παράθυρο επιλέγουμε την καρτέλα "Σειρά" (Σχ.1.19).  
Πατάμε "Προσθήκη" και στα πεδία που αντιστοιχούν στις τιμές Χ και Υ εισάγουμε 
την αντίστοιχη περιοχή δεδομένων επιλέγοντάς τα με το ποντίκι από το φύλλο 
εργασίας. Πχ στο παρακάτω σχήμα  προκειμένου να προσθέσουμε τα δεδομένα 
Χ,Υ3 στο πεδίο των τιμών Χ επιλέγουμε από το φύλλο εργασίας τα κελιά (Α9:Α13) 
και στο πεδίο των τιμών Υ τα κελιά (Β9:Β13). Από το ίδιο παράθυρο μπορούμε να 
καταργήσουμε μια σειρά δεδομένων επιλέγοντας τη σειρά με το ποντίκι και 
πατώντας "Κατάργηση". Εναλλακτικά είναι δυνατό να επιλέξουμε την καμπύλη 
απευθείας στο γράφημα και να την καταργήσουμε πατώντας "Delete" στο 
πληκτρολόγιο. 

-  

Σχήμα 1.19. Προσθήκη σειράς δεδομένων σε γράφημα 

 
 
1.9 ΠΡΟΣΘΗΚΗ ΓΡΑΜΜΗΣ ΤΑΣΗΣ ΣΕ ΓΡΑΦΗΜΑ 
 

Είναι δυνατό να προσθέσουμε μια γραμμή τάσης σε μια σειρά δεδομένων που 
περιέχονται σε ένα γράφημα (π.χ ΧΥ διασποράς), δηλαδή μιας γραμμής με γνωστή 
εξίσωση που θα προσεγγίζει τα δεδομένα μας. Αυτή μπορεί να είναι γραμμικού, 
λογαριθμικού, πολυωνυμικού, υπερβολικού ή εκθετικού τύπου. Για παράδειγμα 
συχνά είναι απαραίτητο να βρούμε μια εξίσωση που θα προσεγγίζει τις μετρήσεις 
ενός πειράματος (παλινδρόμηση). 
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Τα βήματα που ακολουθούμε είναι τα εξής: 
- Επιλέγουμε τη σειρά δεδομένων επάνω στο γράφημα που έχουμε ήδη 

δημιουργήσει. 
- Με δεξί κλικ πάνω στην επιλεγμένη σειρά δεδομένων, εμφανίζεται ένα μενού 

όπου επιλέγουμε "Προσθήκη γραμμή τάσης" 
- Στο παράθυρο που εμφανίζεται, επιλέγουμε στην καρτέλα "Τύπος", τον τύπο 

γραμμής τάσης που θεωρούμε πως προσεγγίζει καλύτερα τα δεδομένα (π.χ 
γραμμικός). Εάν πρόκειται για πολυωνυμικό τύπο μπορούμε να επιλέξουμε έως 
6 τάξης από το πεδίο "Διάταξη". 

- Στην καρτέλα "Επιλογές" είναι δυνατό να  δώσουμε όνομα στη γραμμή τάσης, 
να ορίσουμε τον αριθμό μονάδων (Χ) εμπρός και πίσω από τα δεδομένα του 
γραφήματος, που ενδεχομένως θέλουμε να επεκταθεί η γραμμή τάσης 
(προβλέποντας τις αντίστοιχες τιμές Υ) και ακόμη να επιλέξουμε την προβολή 
εμφάνισης της εξίσωσης στο γράφημα. 

- Με διπλό κλικ επάνω στη γραμμή τάσης εμφανίζεται το μενού μορφοποίησής 
της, όπου μπορούμε επιπλέον να αλλάξουμε τα μοτίβα της, όπως χρώμα, πάχος 
κτλ., αλλά και να μορφοποιήσουμε κάποιες από τις προηγούμενες επιλογές, 
όπως να αλλάξουμε τον τύπο της γραμμής, όνομα κτλ. 

 
Για παράδειγμα στο παρακάτω φύλλο εργασίας, έχουν καταχωρηθεί οι μετρήσεις 
περιεκτικότητας σε C% με το βάθος για μια περιοχή (στήλες Α και Β), ενώ δεξιά  
φαίνεται το αντίστοιχο διάγραμμα διασποράς των μετρήσεων. Ακολουθώντας τα 
βήματα που προαναφέρθηκαν, μπορούμε να κάνουμε προσθήκη μιας γραμμής 
τάσης (γραμμικού τύπου), με προβολή της αντίστοιχης εξίσωσης στο γράφημα. 

Σχήμα 1.20 Παράδειγμα γραφήματος τύπου διασποράς ΧΥ 
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Σχήμα 1.21. Καρτέλα επιλογής τύπου γραμμής τάσης. Καρτέλα επιλογών γραμμής τάσης.  

    Εμφάνιση γραμμής τάσης και εξίσωσης στο γράφημα. 
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1.10 ΓΡΑΦΗΜΑ ΜΟΡΦΗΣ ΣΤΗΛΗΣ 
 

Έκτος από τα γραφήματα μορφής διασποράς (Χ,Υ) που είναι και τα πιο 
διαδεδομένα, υπάρχουν και άλλοι τύποι. Έτσι, σε κάποιες περιπτώσεις απαιτείται η 
απεικόνιση δεδομένων σε μορφή ράβδων ή πίτας, έτσι ώστε να φαίνεται η 
κατανομή ορισμένων υποσυνόλων ή κατηγοριών σε σχέση με το σύνολο ή ακόμη 
η διακύμανση μιας ποσότητας. Για παράδειγμα στο σχήμα 1.22 φαίνεται η 
μεταβολή του πληθυσμού της Θεσσαλονίκης σε σχέση με το χρόνο, υπό μορφή 
γραφήματος τύπου στηλών.  
  

 
Σχήμα 1.22. Παράδειγμα γραφήματος μορφής στηλών. 

 
Τα βήματα που ακολουθούνται για τη δημιουργία του παραπάνω γραφήματος είναι 
τα ίδια με αυτά που περιγράφτηκαν στην παρ.1.8, με τη διαφορά ότι σ’αυτήν τη 
περίπτωση επιλέγονται τα στοιχεία της ποσότητας της οποίας την μεταβολή 
θέλουμε να απεικονίσουμε με μορφή στηλών (Β2:Β15), ενώ στη συνέχεια από τον 
οδηγό γραφημάτων επιλέγεται ο τύπος Στήλες. Στο επόμενο βήμα είναι δυνατός ο 
καθορισμός της κατηγορίας για τον άξονα x (Σχήμα 1.23). Στο παράδειγμα είναι η 
περιοχή Α3:Α15 (έτη που αντιστοιχούν στους πληθυσμούς).    
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Σχήμα 1.23. Επιλογές γραφήματος μορφής στηλών. Προσδιορισμός τιμών του άξονα χ. 

 
 
1.11 ΠΡΑΞΕΙΣ ΜΕ ΠΙΝΑΚΕΣ 
 
Στο Excel είναι δυνατό να κάνουμε πράξεις μεταξύ πινάκων. 
Παρακάτω παρουσιάζεται ένα παράδειγμα πρόσθεσης πινάκων, εύρεσης 
αντιστρόφου και πολλαπλασιασμού πινάκων (Σχ.1.24).  
 
Πρόσθεση πινάκων 
Έστω ότι έχουμε τους 2x2 πίνακες Α και Β (περιοχή Α2:Β3 και D2:E3). 
Για να προσθέσουμε τους δύο πίνακες (Γ=Α+Β), εισάγουμε στο κελί G2 τον τύπο 
=Α2+D2 και τον αντιγράφουμε στην περιοχή G2:H3. 
 
Εύρεση αντιστρόφου 
Έστω ότι έχουμε τον 2X2 πίνακα  Α (περιοχή Α6:Β7). Για να υπολογίσουμε τον 
αντίστροφο Α-1, επιλέγουμε την περιοχή D6:E7, εισάγουμε τον τύπο 
=ΜΙΝVERSE(A6:B7) και πατάμε Ctrl+Shift+Enter. 
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Πολλαπλασιασμός Πινάκων 
Για να πολλαπλασιάσουμε δυο πίνακες π.χ τους Α και Α-1 επιλέγουμε την περιοχή 
G6:H7, εισάγουμε τον τύπο =MMULT(A6:B7;D6:E7) και πατάμε 
Ctrl+Shift+Enter. Το αποτέλεσμα είναι ο μοναδιαίος πίνακας (Α*Α-1=Ι). 

Σχήμα 1.24. Παράδειγμα πράξεων μεταξύ πινάκων. 

 
Σημείωση: Κατά την σύνταξη ενός τύπου η εισαγωγή μιας αναφοράς κελιού ή 
περιοχής κελιών που περιλαμβάνονται εντός του τύπου γίνεται με επιλογή των 
αντίστοιχων κελιών με το ποντίκι (άσπρος σταυρός). 
 
 
1.12 ΕΚΤΥΠΩΣΗ ΛΟΓΙΣΤΙΚΩΝ ΦΥΛΛΩΝ 
 

Μετά το τέλος των εργασιών σε ένα λογιστικό φύλλο του Excel, συχνά 
απαιτείται η εκτύπωση των δεδομένων καταχώρισης ή των αποτελεσμάτων σε 
πινακοποιημένη μορφή, καθώς και των γραφημάτων.  
Προκειμένου να κάνουμε προεπισκόπηση του φύλλου εργασίας που θέλουμε να 
εκτυπώσουμε, από το μενού File επιλέγουμε την εντολή Προεπισκόπηση 

Εκτύπωσης ή από τη βασική γραμμή εργαλείων το εικονίδιο   
Στις επιλογές του παραθύρου που εμφανίζεται με την προεπισκόπηση των 

φύλλων προς εκτύπωση (Σχήματα 1.25-1.26), έχουμε την δυνατότητα να 
εστιάσουμε στο φύλλο εργασίας, να μορφοποιήσουμε το πλάτος των στηλών του 
φύλλου, να διαμορφώσουμε την σελίδα (προσανατολισμός, περιθώρια, μέγεθος 
κτλ) και να προχωρήσουμε στη διαδικασία εκτύπωσης. Ενεργοποιώντας την 
επιλογή Περιθώρια (margins), εμφανίζονται οι μαύροι ενδείκτες ελέγχου του 
πλάτους των στηλών.  
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Σχήμα 1.25. Προεπισκόπηση εκτύπωσης 

 

 

Σχήμα 1.26. Επιλογές προεπισκόπησης φύλλου εργασίας. 
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Ενεργοποιώντας την επιλογή Εκτύπωση (Print) εμφανίζεται ένα παράθυρο-οδηγός 
(Σχ.1.27), απ’ όπου είναι δυνατό να ρυθμιστούν οι ιδιότητες εκτύπωσης και 
εκτυπωτή, με παρόμοιο τρόπο όπως και στα άλλα προγράμματα των Windows.  
 

 
Σχήμα 1.27. Παράθυρο επιλογών εκτύπωσης φύλλου εργασίας Εxcel. 

 
 

Αν το φύλλο εργασίας περιέχει πολλά δεδομένα και κυρίως πολλές στήλες, 
είναι πιθανόν να μην προσαρμόζονται στις σελίδες εκτύπωσης ή να θέλουμε να 
εκτυπώσουμε μια συγκεκριμένη περιοχή μόνο. Σ’ αυτή την περίπτωση μπορούμε 
αφού πρώτα επιλέξουμε την περιοχή που θέλουμε να εκτυπωθεί, να ανοίξουμε το 
παράθυρο επιλογών εκτύπωσης (Αρχείο → Εκτύπωση), και να ενεργοποιήσουμε 
την «Επιλογή» στο κάτω αριστερά τμήμα του παραθύρου. Έτσι θα εκτυπωθεί μόνο 
η επιλεγμένη περιοχή του φύλλου. 

 Ένας άλλος τρόπος είναι, αφού επιλέξουμε την περιοχή όπως και πριν, από 
το μενού Αρχείο να επιλέξουμε Αρχείο→ Περιοχή Εκτύπωσης→ Ορισμός Περιοχής 
Εκτύπωσης, οπότε κάθε φορά θα εκτυπώνεται η συγκεκριμένη περιοχή. Για να 
επανέλθουμε στην αρχική κατάσταση ακολουθούμε την διαδρομή Αρχείο→ 
Περιοχή Εκτύπωσης→ Καθαρισμός Περιοχής Εκτύπωσης. 

 
Εκτύπωση Γραφήματος 

 
Εάν θέλουμε να εκτυπώσουμε σε μια ολόκληρη σελίδα ένα γράφημα που 

δημιουργήσαμε σε φύλλο του Εxcel, απλά επιλέγουμε με αριστερό κλικ το 
συγκεκριμένο γράφημα, ενώ στη συνέχεια κατά την προεπισκόπηση εμφανίζεται 
μόνο το επιλεγμένο γράφημα στη σελίδα εκτύπωσης, της οποίας μπορούμε να 
διαμορφώσουμε τα περιθώρια και τελικά να εκτυπώσουμε κατά τα γνωστά. 



ΚΕΦΑΛΑΙΟ 2: Εφαρμογές Λογιστικών Φύλλων στις Συγκοινωνίες                          

 

32 

ΚΕΦΑΛΑΙΟ  2 
Εφαρμογές Λογιστικών Φύλλων στην 
Συγκοινωνίες: Διαχείριση δεδομένων 
κυκλοφοριακού φόρτου 

 

Α. Γραμμενίδου, Λέκτoρας Συγκoιvωvιακής Τεχvικής, 
Μαθηματικός Α.Π.Θ. 

Ε. Ζαχαράκη, MSc Συγκοινωνιολόγος (Imperial College), Διπλ. 
Πολ. Μηχ. Α.Π.Θ. 

 2.1 ΕΙΣΑΓΩΓΗ ΔΕΔΟΜΕΝΩΝ 

Έχουμε έναν κόμβο μορφής σταυρού στον οποίο επιτρέπονται οι κινήσεις Αδ, 
Αα, Βε, Βα, Γδ, Γε, Γα, Δε, Δδ, όπου το γράμμα ε σημαίνει ευθεία, το α αριστερά 
και το δ δεξιά κίνηση. (εικ.2.1) 

Εικ.2.1: Υπό μελέτη κόμβος 

 
Στον κόμβο έχουν γίνει μετρήσεις των αυτοκινήτων που διέρχονται (ΙΧ, 

φορτηγά, λεωφορεία, δίκυκλα) για τρία δεκαπεντάλεπτα κάθε ώρα και για τρεις 
συνεχόμενες ώρες. Θέλουμε να βρούμε τα οχήματα που διέρχονται από τον κόμβο 

 Αριστοφάνους

Γ  

5 6

4

Βενιζέλου 9 7 Βενιζέλου 
Δ  3 Β  

8 2

1

Α  
Ανοίξεως
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κάθε ώρα, την αναγωγή τους σε ΜΕΑ (μονάδες επιβατικών αυτοκινήτων) με 
δείκτες αναγωγής ΙΧ = 1 ΜΕΑ, φορτηγά = 2 ΜΕΑ, λεωφορεία = 3  ΜΕΑ, δίκυκλα 
= 0,5 ΜΕΑ. Επίσης θέλουμε τη σύνθεση της κυκλοφορίας του κόμβου και την 
ωριαία καθώς και την δεκαπεντάλεπτη διακύμανση των κυκλοφοριακών φόρτων. 

Αρχικά κάνουμε εισαγωγή των δεδομένων των μετρήσεων σε ένα φύλλο του 
excel. Πέρα από τα αριθμητικά δεδομένα εισάγουμε και κάποια στοιχεία που μας 
βοηθούν στην κατανόηση των στοιχείων μας, όπως ημερομηνία, κίνηση στην 
οποία αναφερόμαστε, είδος οχήματος.  
Κάθε σειρά του φύλλου αναφέρεται σε μία κίνηση, και σε ένα δεκαπεντάλεπτο.  

 

 

Εικ. 2.2: Φύλλο excel με τα δεδομένα 

 

2.2 ΜΕΤΑΤΡΟΠΗ ΤΩΝ ΟΧΗΜΑΤΩΝ ΣΕ ΜΕΑ 

Για να μετατρέψουμε τα οχήματα της μέτρησης σε ΜΕΑ, ορίζουμε τα 
περιεχόμενα καθενός από τα επόμενα κελιά με το αποτέλεσμα των πράξεων που 
πρέπει να γίνουν. 

Πηγαίνουμε στο κελί F4. Μετά πατάμε το = στη μπάρα εργαλείων και στο 
παράθυρο που ανοίγει = Β4, γιατί σ αυτό το κελί έχουμε τα αντίστοιχα ΜΕΑ για τα 
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ΙΧ και 1 ΙΧ =1 ΜΕΑ. (Εικ. 2.3). Μετά πατάμε OK και η τιμή μπαίνει στο αντίστοιχο 
κελί. 

Στο επόμενο κελί, το G4, που περιέχει τα αντίστοιχα ΜΕΑ για τα φορτηγά, 
πατάμε = C4*2, γιατί ένα φορτηγό αντιστοιχεί σε 2 ΜΕΑ. Στο επόμενο Η = D4*3 
(1 λεωφορείο = 3 ΜΕΑ) και I = E*0,5 (1 δίκυκλο = 0,5 ΜΕΑ). Έτσι έχει 
μετατραπεί η πρώτη σειρά μετρήσεων, αυτή που αντιστοιχεί στην κίνηση Αα, σε 
ΜΕΑ. 
 

 

 

Εικ. 2.3: Γέμισμα κελιού με πράξεις από άλλα κελιά 

 

Για να επαναλάβουμε την ίδια διαδικασία για τις υπόλοιπες κινήσεις κάνουμε 
κλικ με το ποντίκι στο κελί F4 και κρατώντας το πατημένο το κατεβάζουμε προς τα 
κάτω μέχρι να φτάσουμε στην  κίνηση Δε. Αφήνοντας το ποντίκι το πρόγραμμα 
υπολογίζει τις υπόλοιπες τιμές σύμφωνα με τον ίδιο τύπο.(εικ.2.4) 
Επαναλαμβάνουμε  την ίδια διαδικασία και για τις υπόλοιπες στήλες που αφορούν 
τα φορτηγά, λεωφορεία και δίκυκλα. Τα αποτελέσματα που προκύπτουν φαίνονται 
πιο κάτω. (εικ.2.5) 
  Μετά  προσθέτουμε τίτλους πάνω από τις στήλες (ΜΕΑ, ΙΧ, ΦΟΡΤ, ΛΕΩΦ, 
ΔΙΚΥΚΛΑ). 
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Εικ.2.4: Υπολογισμός στήλης με τον ίδιο τύπο 

 

 
Εικ.2.5: Επανάληψη του ίδιου τύπου για όλες τις στήλες 
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Αθροίσματα στηλών, γραμμών 

Για να βρούμε τα αθροίσματα των ΜΕΑ για κάθε κίνηση και για κάθε 
κατηγορία οχημάτων μπλοκάρουμε το αντίστοιχο κομμάτι στήλης ή σειράς και 
πατάμε το πλήκτρο Σ στην μπάρα των εργαλείων. Αυτόματα το πρόγραμμα 
δημιουργεί τα αθροίσματα και τοποθετεί το αποτέλεσμα στο αμέσως από κάτω ή 
στο πλάι κελί, ανάλογα με το αν πρόκειται για άθροισμα στήλης ή σειράς. 

 
Χρωματισμός σειρών  
 

Για να μπορούμε να ξεχωρίσουμε τις μετρήσεις που αναφέρονται σε κάθε 
κίνηση ανεξάρτητα από ώρα χρωματίζουμε διαφορετικά τις σειρές, με το ίδιο 
χρώμα κάθε κίνηση. Αυτό γίνεται μπλοκάροντας την σειρά που αναφέρεται π.χ. 
στην κίνηση Αα και πατώντας ταυτόχρονα το πλήκτρο Ctrl επιλέγουμε όλες τις 
μετρήσεις που αναφέρονται σ αυτήν την  κίνηση. Κατόπιν πηγαίνουμε στο κουτί με 

το χρώμα στη μπάρα με τα εργαλεία  επιλέγουμε ένα χρώμα. Κάνουμε το ίδιο 
για τις υπόλοιπες κινήσεις επιλέγοντας διαφορετικό χρώμα κάθε φορά. Το 
αποτέλεσμα αυτών των ενεργειών μας φαίνεται παρακάτω. (εικ.2.6) 

 

 

Εικ.2.6: Χρωματισμός των μετρήσεων στις διάφορες κινήσεις 
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Μετατροπή δεκαδικών σε ακέραιους 

Κάποια από τα νούμερα των αθροισμάτων είναι δεκαδικά. Τα ΜΕΑ όμως τα 
θέλουμε σε ακέραιους αριθμούς. Για το σκοπό αυτό πηγαίνουμε στην μπάρα 
εντολών στο πλήκτρο που μειώνει τα δεκαδικά ψηφία. Αν αυτό δεν μπορεί να γίνει 
απευθείας για ολόκληρη στήλη ή γραμμή, λόγω ανομοιομορφίας των τιμών, 
αυξάνουμε πρώτα  τα δεκαδικά και αμέσως μετά τα μειώνουμε ώστε όλα τα 

νούμερά μας να είναι ακέραια. Τα πλήκτρα    είναι αυτά που χρησιμοποιούμε 
σ αυτή τη διαδικασία. 

2.3 ΣΥΝΑΡΤΗΣΕΙΣ 

Θεωρητικό υπόβαθρο 
Το Excel διαθέτει περισσότερες από 300 συναρτήσεις, από τις οποίες μόλις 

το 10% είναι ικανό να προσφέρει απαντήσεις σε καθημερινά, αλλά και 
περισσότερο πολύπλοκα προβλήματα. Το σύνολο των συναρτήσεων μπορεί κανείς 
να το βρει ακολουθώντας την πορεία Insert – Function, και στη συνέχεια από το 
παράθυρο διαλόγου μπορεί κανείς να επιλέξει πρώτα τη γενική κατηγορία 
συναρτήσεων στην οποία εντάσσεται η συνάρτηση που θέλει να εισάγει από το 
υπομενού Function Category και στη συνέχεια από το υπομενού που θα προβληθεί 
στο Function name να επιλέξει τη συνάρτηση που ενδιαφέρεται. Στη συνέχεια 
δίνονται διαδοχικά τα βήματα και η μορφή που έχουν τα παραπάνω μενού και 
υπομενού σ’ ένα φύλλο excel.   

Εικ. 2.7: Εισαγωγή συνάρτησης 
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Εικ.2.8: Μενού συναρτήσεων 

Εναλλακτικά, στη μορφή της Εικ.2.8 είναι δυνατό να φτάσουμε και πατώντας τα 

πλήκτρα   (από την εργαλειοθήκη) - όπου καταλήγουμε απευθείας στην Εικ. 
6.8 - ή πατώντας το  από τη γραμμή εντολών του προγράμματος όπου η οθόνη 
λαμβάνει τη μορφή της Εικ. 2.9. 

 

Εικ.2.9: Εισαγωγή συναρτήσεων με τη βοήθεια της γραμμής εντολών του προγράμματος  
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Η συνάρτηση AVERAGE 

Η συγκεκριμένη συνάρτηση δίνει το μέσο όρο των τιμών που είναι στο όρισμα και 
συντάσσεται ως εξής: = AVERAGE(number1;number2;…). Αναφέρονται δύο 
χαρακτηριστικά παραδείγματα: 
Εάν γράψουμε = AVERAGE(F2;F12;…), η συνάρτηση επιστρέφει τον μέσο όρο 
των τιμών της περιοχής από το F2 έως το F12.  
Εάν γράψουμε = AVERAGE(F2;F12;G2), η συνάρτηση επιστρέφει τον μέσο όρο 
των τιμών της περιοχής από το F2 έως το F12 και του G2. 
 

 
Παράδειγμα υπολογισμού μέσου όρου 

 
Ως ωριαίο κυκλοφοριακό φόρτο στην πράξη λαμβάνουμε το μέσο όρο από τις 
επιμέρους μετρήσεις που πραγματοποιήθηκαν (και αφού βέβαια έχουν ήδη γίνει οι 
αναγκαίες ανάγωγες). Μέσα από το παράδειγμα υπολογισμού του κυκλοφοριακού 
φόρτου ουσιαστικά θα δοθεί με μια διαδικασία βημάτων ο υπολογισμός του μέσου 
όρου. 
Βήμα 1ο: Μετά τους αναγκαίους υπολογισμούς έχουμε καταλήξει στο 
συγκεντρωτικό πίνακα της Εικ. 6.10, ο οποίος περιέχει τα βασικά δεδομένα για την 
εύρεση του μέσου κυκλοφοριακού φόρτου συνολικά για τον κόμβο. 

 

 

Εικ. 2.10: Πίνακας δεδομένων για τον υπολογισμό του μέσου όρου 
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Βήμα 2: Επιλέγουμε το κελί στο οποίο θα βάλουμε την τιμή του μέσου όρου. Στη 
συνέχεια, για τον υπολογισμό του συνολικού μέσου όρου (Σ) ενεργοποιούμε τη 
γραμμή υπολογισμών του προγράμματος πατώντας = και λαμβάνουμε την Εικ. 
2.11 

 

Εικ. 2.11: Ενεργοποίηση γραμμής υπολογισμών 

Βήμα 3: Επιλέγουμε τη συνάρτηση AVERAGE από το υπομενού που βρίσκεται στα 
αριστερά του = και προκύπτει η εικόνα 2.12 

 

Εικ. 2.12: Επιλογή συνάρτησης 
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Βήμα 4: Προσθέτουμε τους αριθμούς των οποίων το μέσο όρο ζητάμε, είτε 
βάζοντας την ονομασία των αντίστοιχων κελιών στις ενδείξεις number 1, number 
2 ….), είτε βάζοντας το αντίστοιχο όρισμα περιοχής στη γραμμή υπολογισμών και 
μέσα στην παρένθεση της συνάρτησης (Εικ. 2.13).   

 

Εικ. 2.13: Υπολογισμός μέσου όρου 

Βήμα 5: Η διαδικασία ολοκληρώνεται πατώντας OK και πλέον ο μέσος όρος έχει 
υπολογιστεί (Εικ. 2.14) 

 

Εικ. 2.14: Τελικό αποτέλεσμα  
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2.4 ΑΝΤΙΓΡΑΦΗ 

Θεωρητικό υπόβαθρο 

Γενικά η αντιγραφή αποτελεί απλή διαδικασία και διακρίνεται σε αντιγραφή 
αλφαριθμητικής τιμής ή σε αντιγραφή τύπου. Η αντιγραφή από ένα κελί σε ένα 
άλλο κάποιου αριθμού ή αλφαριθμητικής τιμής γίνεται με εύκολο τρόπο με τις 
επιλογές Copy & Paste είτε από το μενού edit είτε από την εργαλειοθήκη του 
προγράμματος. Ειδικότερα για καθεμία από τις δύο αυτές περιπτώσεις 
σημειώνονται τα εξής: 
Αντιγραφή με τη βοήθεια του μενού edit: Επιλέγουμε το κελί όπου βρίσκεται ο 

αριθμός που θέλουμε να αντιγράψουμε και από το edit επιλέγουμε Copy κάνοντας 
μονό κλικ με το αριστερό πλήκτρο του ποντικιού (Εικ.2.15)   

 

 

Εικ. 2.15: Επιλογή της εντολής αντιγραφή 

 
Στη συνέχεια επιλέγουμε το κελί στο οποίο θέλουμε να αντιγράψουμε την τιμή και 
από το μενού edit επιλέγουμε την εντολή Paste (επικόλληση) με απλό κλικ του 
αριστερού πλήκτρου του ποντικιού. Η διαδικασία έχει ολοκληρωθεί επιτυχώς (Εικ. 
2.16). 
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Εικ. 2.16:Επικόλληση και ολοκλήρωση της διαδικασίας  

 
Αντιγραφή με τη βοήθεια της βασικής εργαλειοθήκης του προγράμματος: Για αυτή 

τη μέθοδο χρησιμοποιούνται τα κουμπιά  και  της βασικής εργαλειοθήκης. 
Ειδικότερα, επιλέγουμε και πάλι το κελί του οποίου την τιμή θέλουμε να 
αντιγράψουμε και κάνουμε ένα κλικ με το αριστερό πλήκτρο του ποντικιού στο 

κουμπί  (Εικ. 2.17). 

 

Εικ. 2.17: Αντιγραφή με κουμπί Copy 
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Στη συνέχεια επιλέγουμε το κελί στο οποίο θέλουμε να βάλουμε τη συγκεκριμένη 

τιμή και κάνουμε ένα κλικ με το αριστερό πλήκτρο του ποντικιού στο κουμπί  . 
Η διαδικασία έχει πλέον ολοκληρωθεί επιτυχώς (Εικ.2.18). 

 

 

Εικ. 2.18: Ολοκλήρωση της διαδικασίας με το κουμπί Paste 

 
Η αντιγραφή τύπων από ένα κελί σε ένα άλλο γίνεται όπως ακριβώς και η 
αντιγραφή αλφαριθμητικών χαρακτήρων. Υπάρχουν όμως περιπτώσεις όπου 
θέλουμε να αντιγράψουμε το κελί που περιέχει κάποιον τύπο, αλλά στη νέα θέση 
του (κελί) θέλουμε να έχουμε μόνο την τιμή που υπολόγισε και όχι τον ίδιο τον 
τύπο. Στην περίπτωση αυτή ακολουθούμε την εξής διαδικασία: 
Επιλέγουμε το κελί που περιέχει τον τύπο και από το μενού edit επιλέγουμε και 
πάλι Copy (Εικ. 2.19) 
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Εικ. 2.19: H εντολή Copy  για αντιγραφή τιμής που προέκυψε από τύπο 

 
Επιλέγουμε το κελί ή τα κελιά στα οποία θέλουμε να αντιγράψουμε την τιμή 
Στη συνέχεια επιλέγουμε edit – paste special και από το πλαίσιο που θα εμφανιστεί 
επιλέγουμε values (Eικ. 2.20) 
 

 

Εικ. 2.20: Ενεργοποίηση της αντιγραφής τιμής μόνο από τύπο 
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Εικ. 2.21: Ολοκλήρωση αντιγραφής τιμής μόνο 

Η διαδικασία έχει πλέον ολοκληρωθεί επιτυχώς (Εικ. 2.21)  

Υπολογισμός και Αντιγραφή Τύπου 

Οι διάφοροι τύποι ουσιαστικά αποτελούν ένα σύνολο αριθμητικών πράξεων, το 
οποίο θα πρέπει να ακολουθήσει τη σειρά εκτέλεση πράξεων όπως αυτή ορίζεται 
και στα μαθηματικά. Δηλαδή η προτεραιότητα των τελεστών του προγράμματος 
είναι ίδια με την προτεραιότητα που ήδη γνωρίζουμε. Επίσης το Excel με τις 
εντολές αντιγραφής ή μετακίνησης των τύπων δίνει τη δυνατότητα αλλαγής των 
τύπων, σύμφωνα με τις διευθύνσεις των νέων κελιών, αυτόματα. Ωστόσο θα 
πρέπει να είμαστε προσεκτικοί , γιατί υπάρχει και η περίπτωση να μη συμφωνούν 
οι τύποι με το δικό μας ζητούμενο. 
 

Μέσα από τη διαδικασία υπολογισμού ποσοστών – για την εύρεση της σύνθεσης 
της κυκλοφορίας -  είναι δυνατό να αντιληφθούμε αυτές τις λειτουργίες, αλλά και 
τις ιδιαιτερότητες του προγράμματος. Ειδικότερα: 
Βήμα 1: Επιλέγουμε το κελί αποτελέσματος και ορίζουμε τον τύπο (Εικ. 2.22) 
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Εικ. 2.22: Προσδιορισμός τύπου 

 
Βήμα 2: Απενεργοποιούμε το κελί και βλέπουμε το αποτέλεσμα του τύπου 
Βήμα 3: Κάνουμε απλό κλικ στο κελί του τύπου και πιάνοντας την κάτω δεξιά 
γωνία με το ποντίκι σέρνουμε προς τα δεξιά για να υπολογιστεί η σύνθεση της 
κυκλοφορίας και για τις επόμενες κατηγορίες οχημάτων 
Βήμα 4: Η διαδικασία ολοκληρώθηκε επιτυχώς και εφαρμόζεται το ίδιο και για τις 
στήλες, με τις κατάλληλες προσαρμογές (Εικ. 2.23) 
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Εικ. 2.23: Αντιγραφή τύπου 

 
ΠΡΟΣΟΧΗ:  
Παρατηρούμε στον ορισμό του τύπου ότι ο παρονομαστής δεν εισήχθηκε με 
αναφορά στο κελί, αλλά ως αριθμός. Αυτό συνέβη διότι η οριζόντια αντιγραφή του 
τύπου θα είχε ως αποτέλεσμα την αλλαγή του αριθμητή κατά ένα κελί δεξιότερα – 
που επιθυμούμαι – αλλά και τη μετατόπιση του παρονομαστή κατά τον ίδιο τρόπο 
που δεν επιθυμούμε. Αυτό άλλωστε αποτελεί και την «προσαρμογή» για τις στήλες 
που σημειώθηκε στο 4ο βήμα.  
Για να έχουμε ως τελικό αποτέλεσμα ποσοστά χωρίς να κάνουμε περισσότερο 
πολύπλοκο τον τύπο αρκεί να επιλέξουμε την αντίστοιχη περιοχή, δηλ. τα κελιά 

που θα μπουν τα αποτελέσματα και να πατήσουμε στη συνέχεια το κουμπί . Η 
διαδικασία αυτή μπορεί να γίνει και εκ των υστέρων. 
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2.5 ΓΡΑΦΗΜΑΤΑ 

Θεωρητικό υπόβαθρο 

To Excel έχει τη δυνατότητα να παράγει διάφορους τύπους γραφημάτων δισδιάστατων – που είναι 

και αυτά που χρησιμοποιούμε συχνότερα - αλλά και τρισδιάστατων (Εικ. 2.24). 

 

 

Εικ. 6.24: Γενικές κατηγορίες γραφημάτων 

 
Γενικά, υπάρχουν αρκετοί τρόποι δημιουργίας γραφημάτων, όμως ο γρηγορότερος 

τρόπος είναι με τη βοήθεια του κουμπιού οδηγού γραφημάτων  που μας 
εισάγει κατευθείαν στο προηγούμενο μενού (Εικ. 2.25). Έτσι λοιπόν τα στάδια 
δημιουργίας ενός γραφήματος είναι: 
Βήμα 1: Επιλέγουμε την περιοχή δεδομένων που θέλουμε να απεικονίσουμε στο 
γράφημα 

Βήμα 2: Πατάμε στο κουμπί  
Βήμα 3: Επιλέγουμε τη γενική μορφή του γραφήματος και την ειδικότερη 
υποκατηγορία στη συνέχεια 
Βήμα 3: Πατάμε next και ελέγχουμε τη μορφή του γραφήματος μέσα από την 
προεπισκόπηση που μας δίνει. Εναλλακτικά μπορούμε να παραλείψουμε το Βήμα 1 
και να επιλέξουμε τα δεδομένα σε αυτό το βήμα (Εικ. 2.25) 
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Εικ. 2.25: Επιλογή δεδομένων και προεπισκόπηση γραφήματος  

 
Βήμα 4: Πιέζουμε next και εμφανίζεται το παράθυρο διαλόγου που σχετίζεται με 
τον τίτλο του γραφήματος, τους άξονες κ.λ.π. (Εικ. 2.26) 

 

 

Εικ.2.26: Τίτλοι γραφήματος 
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Βήμα 5: Αφού συμπληρώσουμε τα απαραίτητα πεδία με τους τίτλους πιέζουμε και 
πάλι next, όπου πλέον εμφανίζεται το παράθυρο διαλόγου σχετικά με το πού 
θέλουμε να μπει τα γράφημα (στο ίδιο φύλλο ή σε άλλο) (Εικ. 2.27) 

   

Εικ.2.27: Παράθυρο διαλόγου για το φύλλο του γραφήματος 

Βήμα 6: Η διαδικασία ολοκληρώθηκε επιτυχώς (Εικ. 2.28) 
 

 

Εικ. 2.28: Ολοκλήρωση της διαδικασίας δημιουργίας γραφήματος
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ΚΕΦΑΛΑΙΟ  3 
Εφαρμογές Λογιστικών Φύλλων στην Υδραυλική: 
Διαστασιολόγηση Ταμιευτήρα Φράγματος 
Δ. Τολίκας, καθηγητής Α.Π.Θ. 
 

3.1 ΕΙΣΑΓΩΓΗ 

Τα φράγματα συγκαταλέγονται στα μεγαλύτερα έργα Πολιτικού Μηχανικού. 

Είναι έργα τεράστιου κόστους και διακρίνονται από άποψη κατασκευής σε α) 

χωμάτινα και β) σε φράγματα από οπλισμένο σκυρόδεμα. Τα φράγματα 

διακόπτουν τη ροή ενός ποταμού και στο πίσω μέρος τους (στο ανάντι) 

σχηματίζεται ένας ταμιευτήρας νερού, δηλαδή μια τεχνητή λίμνη (σχ. 3.1). 

 

 
 

Σχήμα 3.1 

Ο σκοπός των φραγμάτων είναι η αναρύθμιση της εισροής και εκροής του 

νερού του ταμιευτήρα. Έτσι, ο ταμιευτήρας θα μπορούσε να χαρακτηρισθεί ως ένα 

σύστημα που αποθηκεύει υδατικές ποσότητες με προοπτική μελλοντικής χρήσης. 

Εύκολα γίνεται αντιληπτό ότι τα φράγματα είναι έργα που κατέχουν σημαίνουσα 

θέση στη διαχείριση των υδατικών πόρων μιας περιοχής. 
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Ανάλογα με τη χρήση του αποθηκευόμενου νερού, τα φράγματα 

διακρίνονται σε υδρευτικά, αρδευτικά, υδροηλεκτρικά κ.λ.π. Στον ταμιευτήρα ενός 

φράγματος, π.χ. αρδευτικού, συγκεντρώνονται μεγάλες ποσότητες νερού κατά τις 

περιόδους έντονων βροχοπτώσεων, οι οποίες στη συνέχεια χρησιμοποιούνται κατά 

την αρδευτική περίοδο το καλοκαίρι για να εξυπηρετήσουν τις αρδευτικές ανάγκες 

μιας περιοχής. Τα μεγάλα φράγματα λειτουργούν κατά κανόνα σε υπερετήσια 

βάση. Η επιλογή της θέσης κατά μήκος του ποταμού, όπου θα κατασκευασθεί το 

φράγμα, αποτελεί ένα σημαντικό και κρίσιμο στάδιο του όλου έργου. Θα πρέπει ο 

μηχανικός να επιλέξει την προσφορότερη θέση από γεωλογική και τοπογραφική 

άποψη, ώστε να περιορίσει τις διηθήσεις του νερού στο έδαφος και να 

κατασκευάσει το οικονομικότερο και αρτιότερο έργο. Όμως, η πρωταρχική δουλειά 

σ’ αυτή τη φάση της μελέτης του έργου είναι η διαστασιολόγηση του ταμιευτήρα, 

ως συνάρτηση του ύψους του φράγματος, της τοπογραφικής διαμόρφωσης της 

περιοχής, των εισροών και των εκροών του νερού προς και από τον ταμιευτήρα. 

Η διαστασιολόγηση ενός ταμιευτήρα φράγματος αποτελεί το αντικείμενο 

αυτού του κεφαλαίου. Αναπτύσσεται σ’ ένα απλοποιημένο πλαίσιο, ώστε το θέμα 

να γίνεται κατανοητό ακόμα και από μη έχοντες γνώσεις υδρολογίας ή 

υδραυλικής. Το βασικότερο μειονέκτημα των απλοποιητικών παραδοχών είναι ότι 

το όλο  φαινόμενο αντιμετωπίζεται ως καθαρά ντετερμινιστικό. Είναι γνωστό όμως, 

ότι οι εισροές στον ταμιευτήρα είναι φαινόμενα τυχαίας μεταβλητής, αφού 

προέρχονται από τις βροχοπτώσεις. Επομένως οι στατιστικές μέθοδοι είναι οι πλέον 

ενδεδειγμένες για τη μελέτη του φαινομένου. Πάντως, το κεφάλαιο αυτό με την 

απλότητά του συνιστά ένα εξαιρετικό διδακτικό θέμα, τόσο για την εισαγωγή σε 

θέματα υδρολογίας και υδραυλικής, όσο και για την κατανόηση και εμπέδωση 

βασικών εντολών και χειρισμού λογισμικών φύλλων. 

3.2 ΔΙΑΤΥΠΩΣΗ ΤΟΥ ΠΡΟΒΛΗΜΑΤΟΣ 

Θεωρούνται γνωστές κατά τη διάρκεια ενός εξεταζόμενου υδρολογικού έτους 

οι παροχές εισροής, δηλαδή οι όγκοι του νερού ανά εβδομάδα που εισέρχονται 

στον ταμιευτήρα. Με την ίδια χρονική κλίμακα είναι γνωστή η χρονοσειρά των 

παροχών εκροής. Στόχος του προβλήματος είναι ο υπολογισμός ανά εβδομάδα του 

όγκου του νερού του ταμιευτήρα, καθώς και της στάθμης του. Θα πρέπει να 

σημειωθεί ότι η στάθμη του νερού στον ταμιευτήρα δεν μπορεί να ανεβεί πάνω 

από μια μέγιστη στάθμη, όπου βρίσκεται η στέψη του υπερχειλιστή, γιατί τότε 
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συμβαίνει υπερχείλιση του νερού. Το νερό που υπερχειλίζει δε συνεισφέρει 

καθόλου στην ικανοποίηση των αναγκών κατανάλωσης. Επίσης η στάθμη του 

νερού στον ταμιευτήρα δεν επιτρέπεται να κατεβεί κάτω από μια ελάχιστη στάθμη, 

ενδεικτική του ότι ο ταμιευτήρας είναι ουσιαστικά άδειος. Σε μια τέτοια περίπτωση 

διακόπτεται η εκροή του νερού και φυσικά δεν ικανοποιούνται οι ανάγκες 

κατανάλωσης. 

3.2.1 Μεθοδολογία επίλυσης 

Θεωρείται ως βήμα χρόνου Δt για τους υπολογισμούς το χρονικό διάστημα 

μιας εβδομάδας. Κατά τη διάρκεια του τυχαίου χρονικού βήματος i ισχύει η βασική 

εξίσωση 

VAi – VBi = ΔVi (1) 

όπου, VAi ο όγκος του νερού που εισήλθε στον ταμιευτήρα κατά τη διάρκεια του 

χρονικού βήματος i, VBi ο όγκος του νερού που εξήλθε από τον ταμιευτήρα κατά 

τη διάρκεια του χρονικού βήματος i και ΔVi η μεταβολή του αποθηκευμένου όγκου 

νερού στον ταμιευτήρα κατά τη διάρκεια του ίδιου χρονικού διαστήματος.  

Η εξίσωση (1) πηγάζει από την αρχή της διατήρησης της μάζας και αποτελεί 

ουσιαστικά τη θεμελιώδη «εξίσωση συνεχείας» της υδρολογίας διατυπωμένη υπό 

την απλούστερη δυνατή μορφή της. 

Οι υπολογισμοί αρχίζουν από το πρώτο χρονικό βήμα, οπότε ο αρχικός όγκος του 

νερού στον ταμιευτήρα είναι V0 και συνεχίζονται διαδοχικά σ’ όλα τα χρονικά 

βήματα, μέχρις ότου καλυφθεί όλο το υδρολογικό έτος. Κατ’ αυτόν τον τρόπο 

υπολογίζονται η μεταβολή του αποθηκευμένου όγκου νερού, καθώς και η 

συνολική ποσότητα νερού στον ταμιευτήρα.σε κάθε χρονικό βήμα. 

Από τον ήδη υπολογισθέντα όγκο νερού προκύπτει η στάθμη του νερού στον 

ταμιευτήρα, αφού είναι γνωστή από τα γεωμετρικά χαρακτηριστικά του ταμιευτήρα 

η σχέση που συνδέει τον όγκο Vo,i και τη στάθμη του νερού ho,i σ’ αυτόν 

 Vo,i = V(ho,i) (2) 

Με βάση την τιμή ho,i που υπολογίζεται σε κάθε χρονικό βήμα ελέγχεται αν η 

στάθμη του νερού υπερβαίνει τη μέγιστη τιμή hmax, οπότε δημιουργείται 

υπερχείλιση ή γίνεται μικρότερη από την ελάχιστη δυνατή στάθμη hmin, οπότε 

διακόπτεται η εκροή. 
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3.2.2 Δεδομένα του προβλήματος 

Τα δεδομένα του προβλήματος καταχωρούνται στην πρώτη σελίδα (sheet1), 

όπως φαίνονται στο σχ. 3.2. 

 
Σχήμα 3.2 Ένα τμήμα της πρώτης σελίδας του λογισμικού φύλλου, όπου εμφαίνονται τα δεδομένα 

της μελέτης. 
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Περιλαμβάνουν α) Την αρχική στάθμη του νερού στον ταμιευτήρα ho, β) Τη 

στάθμη του υπερχειλιστή hmax, γ) την ελάχιστη στάθμη του νερού στον ταμιευτήρα 

hmin, πέρα από την οποία διακόπτεται η εκροή από τον ταμιευτήρα δ) τα ζεύγη 

τιμών ho,i και Vo,i, που δίνουν τον όγκο Vo,i του νερού στον ταμιευτήρα 

συναρτήσει της στάθμης του ho,i, ε) τη χρονοσειρά παροχών εισροής QAi (όγκος 

νερού/εβδομάδα) και στ) τη χρονοσειρά παροχών εκροής QBi (όγκος 

νερού/εβδομάδα). 

Στην ίδια σελίδα (sheet1) γίνεται μια πρώτη επεξεργασία των δεδομένων, 

ώστε να τα συστηματοποιήσουμε, να αποκτήσουμε εποπτικότερη εικόνα τους και 

να διευκολυνθούμε στη συνέχεια στη φάση των υπολογισμών. Αυτή η αρχική 

επεξεργασία των δεδομένων περιλαμβάνει α) τη γραφική παράσταση στάθμης – 

όγκου νερού στον ταμιευτήρα β) τη γραφική παράσταση εισροής και εκροής νερού 

συναρτήσει του χρόνου και γ) τον υπολογισμό του αρχικού, μέγιστου και 

ελάχιστου όγκου νερού συναρτήσει της αρχικής, μέγιστης και ελάχιστης στάθμης 

νερού. 

3.2.3 Γραφική παράσταση στάθμης – όγκου νερού στον ταμιευτήρα 

α) Επιλόγονται από τη σελίδα 1 οι σειρές από B5 (άνω αριστερή γωνία) 

μέχρι L6 (κάτω δεξιά γωνία) που περιέχουν τα γεωμετρικά δεδομένα του 

ταμιευτήρα, δηλαδή τα ζεύγη τιμών ho,i και Vo,i (στάθμης - όγκου νερού). 

 
Σχήμα 3.3 
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β) Επιλέγεται από το menu η εντολή Insert > Chart και διαδοχικά εμφανίζονται 

τα παράθυρα των σχημάτων 3.3 ως 3.7, όπου φαίνονται οι επιλογές που γίνονται 

 
Σχήμα 3.4 

 
Σχήμα 3. 5 
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Σχήμα 3.6 

 

 
Σχήμα 3.7 

 

Όπως φαίνεται από το σχήμα 3.6 η καμπύλη στάθμης – όγκου νερού 

στρέφει τα κοίλα προς τα κάτω, επειδή για μεγάλες τιμές της στάθμης μια μικρή 

αύξησή της, αυξάνει πολύ τον όγκο του νερού, ενώ το αντίθετο συμβαίνει όταν η 

στάθμη έχει μικρές τιμές. 

3.2.4  Γραφική παράσταση εισροής εκροής νερού 

Ακολουθώντας διαδικασία ανάλογη μ’ αυτή της προηγούμενης παραγράφου, 

δημιουργείται η γραφική παράσταση εισροής, εκροής συναρτήσει του χρόνου (των 

52 εβδομάδων). Επιλέγονται τα στοιχεία υπό τους τίτλους ‘Εβδομάδα’, ‘Εισροή’, 

‘Εκροή’ από τη σελίδα 1, δηλαδή οι στήλες από Β10 (άνω αριστερά) μέχρι D62 

(κάτω δεξιά) και δημιουργείται το σχ. 3.8. 
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Σχήμα 3. 8 

Η καμπύλη εισροής εμφανίζει μεγάλες μεταβολές κατά τη διάρκεια του 

χρόνου, ενώ αντίθετα η καμπύλη εκροής είναι πιο ομαλή. Μια τέτοια καμπύλη 

εκροής μπορεί να εμφανιστεί σε υδρευτικό φράγμα που υδροδοτεί μια 

μεγαλούπολη. Επίσης, διακρίνονται οι εποχιακές μεταβολές τόσο της εισροής όσο 

και της εκροής, απ’ όπου διαπιστώνεται ότι όταν αυξάνονται εποχιακά οι εκροές 

μειώνονται οι εισροές και αντιστρόφως. 

3.2.5 Υπολογισμός αρχικού, μέγιστου και ελάχιστου όγκου νερού 

Από τις γνωστές στάθμες νερού ho, hmax και hmin είναι δυνατόν να 

υπολογισθούν οι αντίστοιχοι όγκοι νερού Vo, Vmax και Vmin. Ο υπολογισμός καθενός 

από τους παραπάνω όγκους, π.χ. του. Vo γίνεται με μια διαδικασία γραμμικής 

παρεμβολής μεταξύ δύο γειτονικών τιμών Vo,i και Vo,i+1 ως εξής: 

Συγκρίνεται η τιμή ho με τις τιμές των δεδομένων σταθμών ho,i της σχ. 2. 

Προσδιορίζονται δύο διαδοχικές τιμές ho,i και ho,i+1, τέτοιες ώστε να ισχύει η σχέση 

 1i,o0i,o hhh +≤≤   (3) 

Ο ζητούμενος όγκος Vo που αντιστοιχεί στη στάθμη ho προκύπτει από γραμμική 

παρεμβολή στις τιμές Vo,i  = V(ho,i) και Vo,i+1 = V(ho,i+1)  δηλαδή 

 
i,o1i,o

i,oo
i,o1i,oi,oo hh

hh
)VV(VV

−

−
−+=

+
+   (4) 

Στο λογισμικό φύλλο η διαδικασία παρεμβολής και υπολογισμού του όγκου Vo 

γίνεται ως εξής: 

Στο κελί D7 γράφεται η εντολή 

=IF($B2>=B$5;IF($B2<C$5;B$6+(C$6-B$6)*($B2-B$5)/(C$5-B$5);0);0) (5) 

Αυτή η εντολή είναι σύνθετη και αποτελείται από δύο συναρτήσεις ‘IF’. Η δεύτερη 

εμπεριέχεται στην πρώτη και διακριτοποιείται στη σχ. 5 υπογραμμίζοντάς την. 
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 Κάθε συνάρτηση ‘IF’ π.χ. η εσωτερική (η υπογραμμισμένη) αποτελείται από 

τρία μέρη που διαχωρίζονται με το σύμβολο ‘;’ και εσωκλείονται σε παρενθέσεις. 

Στο πρώτο μέρος διατυπώνεται μια συνθήκη και ελέγχεται αν ισχύει (TRUE) ή όχι 

(FALSE). Στην προκειμένη περίπτωση η συνθήκη είναι ‘$B2<C$5’. Ελέγχεται 

δηλαδή, αν το περιεχόμενο του κελιού Β2 είναι μικρότερο από το περιεχόμενο του 

κελιού C5. Αν το αποτέλεσμα του ελέγχου είναι ‘TRUE’, τότε το περιεχόμενο του 

κελιού D7 υπολογίζεται από τη σχέση που βρίσκεται στο δεύτερο μέρος της 

συνάρτησης ‘IF’, δηλαδή, ‘B$6+(C$6-B$6)*($B2-B$5)/(C$5-B$5)’. Στην αντίθετη 

περίπτωση, δηλαδή όταν το περιεχόμενο του ελέγχου είναι ‘FALSE’, το 

περιεχόμενο του κελιού D7 υπολογίζεται από τη σχέση που βρίσκεται στο τρίτο 

μέρος της συνάρτησης ‘IF’ (στην προκειμένη περίπτωση είναι μηδέν). 

     Στην εξωτερική συνάρτηση ‘IF’ η προς έλεγχο συνάρτηση είναι ‘$B2>=B$5’. 

Στην περίπτωση που ο έλεγχος δώσει αποτέλεσμα ‘TRUE’ εκτελείται το δεύτερο 

μέρος της συνάρτησης, δηλαδή η εσωτερική συνάρτηση ‘IF’ που αναλύθηκε 

προηγουμένως. Στην αντίθετη περίπτωση εκτελείται το τρίτο μέρος της 

συνάρτησης, δηλαδή τίθεται μηδενική τιμή στο κελί D7. 

Αν εφαρμοσθούν τα αριθμητικά δεδομένα των κελιών που υπεισέρχονται στη σχ. 5 

προκύπτει ότι η προς έλεγχο συνθήκη του εξωτερικού ‘IF’ δίνει αποτέλεσμα ‘TRUE’ 

(’52>=0’ = ‘TRUE’) και επομένως εκτελείται η εσωτερική συνάρτηση ‘IF’. Σ’ αυτήν 

η προς έλεγχο συνάρτηση δίνει αποτέλεσμα ‘FALSE’ (‘52<10’ = ‘FALSE’), οπότε 

στο κελί D7 καταχωρείται μηδενική τιμή. 

     Αξίζει να προσεχθεί και να διερευνηθεί το γεγονός ότι στην εντολή 5, σ’ 

ορισμένες συντεταγμένες κελιών προηγείται το σύμβολο ‘$’ (απόλυτες 

συντεταγμένες), ενώ σ’ άλλες όχι (σχετικές συντεταγμένες). Π.χ. στο πρώτο κελί 

που εμφανίζεται στην εντολή 5, (το ‘$B2’), η στήλη ‘B’ αποτελεί απόλυτη 

συντεταγμένη στήλης και παραμένει πάντα η ίδια, ενώ η σειρά ‘2’ αποτελεί σχετική 

συντεταγμένη σειράς. Αυτού του είδους η γραφή έχει πολύ μεγάλη σημασία και 

δίνει τη δυνατότητα στον προγραμματιστή να επαναλάβει κατά ανάλογο τρόπο τη 

διαδικασία υπολογισμού του περιεχομένου του κελιού D7 σ’ ένα πλήθος άλλων 

κελιών. Για τη συγκεκριμένη γραμμική παρεμβολή, ξεκινώντας από το κελί D7 

επιλέγονται τα 10 επόμενα κελιά που βρίσκονται στη σειρά ‘7’, δηλαδή τα E7, F7, 

... N7. Ακολούθως με την εντολή Edit > Fill > Right υπολογίζονται οι τιμές των 

κελιών E7, F7, ... N7 κατ’ ανάλογο τρόπο μ’ αυτόν του κελιού D7. Έτσι, η εντολή 

που γράφεται για το κελί E7, που βρίσκεται δεξιά από το D7, έχει τη μορφή 
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=IF($B2>=C$5;IF($B2<D$5;C$6+(D$6-C$6)*($B2-C$5)/(D$5-C$5);0);0) (6) 

Παρατηρούμε ότι στη σχ. 6 έχουν μεταβληθεί σε σύγκριση με τη σχ. 5, που ισχύει 

για το κελί D7, μόνο οι σχετικές συντεταγμένες, ενώ παρέμειναν αναλλοίωτες οι 

απόλυτες συντεταγμένες. Π.χ. το κελί Β$5 της σχ. 5 μεταβλήθηκε σε C$5 στη σχ. 

6. Με τον υπολογισμό αριθμητικών τιμών στα κελιά D7 ως N7 ελέγχεται αν η τιμή 

της στάθμης ho (περιεχόμενο του κελιού B2) ικανοποιεί ή όχι τη σχ. 3. Είναι 

φανερό ότι η σχ. 3 ικανοποιείται μόνο σ’ ένα κελί (από D7 ως N7), ενώ σ’ όλα τ’ 

άλλα δεν ικανοποιείται. Σ’ αυτό το κελί καταχωρείται η τιμή για τον όγκο Vo 

σύμφωνα με τη σχ. 4 της γραμμικής παρεμβολής, ενώ σ’ όλα τ’ άλλα 

καταχωρούνται μηδενικές τιμές. 

     Ο ζητούμενος όγκος Vo είναι η τιμή που προκύπτει από τη γραμμική 

παρεμβολή. Ως θετικός αριθμός έχει πάντα μεγαλύτερη τιμή σε σχέση με τις 

μηδενικές τιμές των άλλων κελιών από D7 ως N7. Έτσι, ο όγκος Vo καταχωρείται 

στο κελί B7 με την εντολή 

 =MAX(D7:N7) (7) 

Η συνάρτηση ΜΑΧ(D7:N7) υπολογίζει τη μέγιστη τιμή που περιέχεται στα κελιά 

από D7 ως N7. 

Με ανάλογη διαδικασία υπολογίζονται οι τιμές των όγκων Vmax και Vmin. 

Η ίδια διαδικασία γραμμικής παρεμβολής θα εφαρμοστεί και στην επόμενη 

παράγραφο για τον υπολογισμό των σταθμών h από τους όγκους V σε κάθε 

χρονικό βήμα υπολογισμού. 

3.2.6 Υπολογισμοί στο λογισμικό φύλλο 

Στο σχ. 2.9 φαίνεται η γενική διάταξη των υπολογισμών στο λογισμικό 

φύλλο (sheet2), ενώ παρακάτω περιγράφεται αναλυτικά η πορεία υπολογισμών. 

3.2.6.1 Υπολογισμός όγκου ανά εβδομάδα 

Στις στήλες υπό τους τίτλους, «Εβδομάδα», «Εισροή» και «Εκροή» 

περιέχονται τα δεδομένα όγκων εισροών και εκροών νερού ανά εβδομάδα σε m-
3.106

. Στο πρώτο κελί (D2) κάτω από τον τίτλο «Όγκος», προκειμένου να 

υπολογισθεί ο όγκος του νερού στον ταμιευτήρα κατά την πρώτη εβδομάδα, 

γράφεται η εντολή 

 =Sheet1!$B$7+B2-C2 (8) 
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Σχήμα 3.9 Ένα τμήμα της δεύτερης σελίδας του λογισμικού φύλλου, όπου εμφαίνεται το κυρίως 

μέρος των υπολογισμών. 
 

και σημαίνει ότι η τιμή που γράφεται στο κελί D2 είναι ίση με τον αρχικό όγκο 

νερού στον ταμιευτήρα, δηλαδή την τιμή που περιέχει το κελί B7 της σελίδας 1 

(Sheet1) συν την τιμή που περιέχεται στο κελί B2 (όγκος εισροής νερού κατά την 
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1η εβδομάδα) μείον την τιμή που περιέχεται στο κελί C2 (όγκος εκροής νερού κατά 

την 1η εβδομάδα). Τα σύμβολα $ εμπρός από το Β και το 2 που υπεισέρχονται 

στην εντολή (8) δηλώνουν τις απόλυτες συντεταγμένες (σειρά και στήλη) του 

κελιού αυτού. Στο παρακάτω κελί της ίδιας στήλης (D3), προκειμένου να 

υπολογισθεί ο όγκος του νερού κατά τη 2η εβδομάδα, γράφεται η εντολή 

 =F2+B3-C3 (9) 

και σημαίνει ότι η τιμή που γράφεται στο κελί D3 είναι ίση με την τιμή που περιέχει 

το κελί F2 (όγκος νερού κατά την 1η εβδομάδα μετά την πιθανή υπερχείλιση ή το 

άδειασμα του ταμιευτήρα) συν την τιμή που περιέχεται στο κελί B3 (όγκος εισροής 

νερού κατά τη 2η εβδομάδα) μείον την τιμή που περιέχεται στο κελί C3 (όγκος 

εκροής νερού κατά την 2η εβδομάδα). Στην εντολή αυτή, σε αντίθεση με την 

εντολή (8) δεν υπεισέρχονται οι απόλυτες συντεταγμένες κάποιου κελιού, αλλά 

μόνο οι σχετικές. Έτσι μπορούμε να υπολογίσουμε τις τιμές όλων των κελιών της 

στήλης D με ανάλογο τρόπο. 

3.2.6.2 Υπολογισμός στάθμης ανά εβδομάδα 

     Μετά τον υπολογισμό του όγκου Vj κατά την εβδομάδα j είναι δυνατό να 

υπολογισθεί η στάθμη του νερού hj στον ταμιευτήρα από τη σχέση 2 με διαδικασία 

γραμμικής παρεμβολής παρόμοια μ’ αυτή που χρησιμοποιήθηκε στην προηγούμενη 

παράγραφο 3.2.5. Η όλη πορεία συνοψίζεται στα εξής: 

Α) Συγκρίνεται η τιμή Vj με τις τιμές των δεδομένων όγκων Vo,i της σχ.2. 

Προσδιορίζονται δύο διαδοχικές τιμές Vo,i και Vo,i+1, τέτοιες ώστε να ισχύει η σχέση 

 1i,oji,o VVV +≤≤  (10) 

Η ζητούμενη στάθμη hj που αντιστοιχεί στον όγκο Vj προκύπτει από γραμμική 

παρεμβολή στις τιμές Vo,i και Vo,i+1 δηλαδή 

  
i,o1i,o

i,oj
i,o1i,oi,oj VV

VV
)hh(hh

−

−
−+=

+
+  (11) 

Β) Στο κελί J2 γράφεται η σύνθετη εντολή ‘IF’ που είναι ανάλογη της εντολής 5 

 

=IF($D2>=Sheet1!B$6;IF($D2<Sheet1!C$6;Sheet1!B$5+ 

(Sheet1!C$5-Sheet1!B$5)*($D2-Sheet1!B$6)/(Sheet1!C$6-Sheet1!B$6);0);0)      

   (12) 

 



ΚΕΦΑΛΑΙΟ 3: Εφαρμογές λογιστικών Φύλλων στην Υδραυλική                          

 

64 

Επιλέγονται τα κελιά K2, L2, ... T2. Με την εντολή Edit > Fill > Right 

υπολογίζονται οι τιμές αυτών των κελιών κατ’ ανάλογο τρόπο μ’ αυτόν του κελιού 

J2. Με τον υπολογισμό αριθμητικών τιμών στα κελιά J2 ως T2 ελέγχεται αν η τιμή 

του όγκου του νερού στον ταμιευτήρα (περιεχόμενο του κελιού D2) ικανοποιεί ή 

όχι τη σχ.10. Είναι φανερό ότι η σχ. 10 ικανοποιείται μόνο σ’ ένα κελί (από J2 ως 

T2), ενώ σ’ όλα τ’ άλλα δεν ικανοποιείται. Σ’ αυτό το κελί καταχωρείται η τιμή για 

τη στάθμη h σύμφωνα με τη σχ. 11 της γραμμικής παρεμβολής, ενώ σ’ όλα τ’ 

άλλα καταχωρούνται μηδενικές τιμές. 

C) Η ζητούμενη στάθμη του νερού στον ταμιευτήρα είναι η τιμή που προκύπτει 

από τη γραμμική παρεμβολή και καταχωρείται στο κελί Ε2. Αυτή η τιμή, όπως 

εξηγήθηκε στην προηγούμενη παράγραφο 3.2.5 είναι η μέγιστη που εμφανίζεται 

στα κελιά από J2 ως T2. Δηλαδή, για το κελί Ε2 γράφεται η εντολή 

 =MAX(J2:T2) (13) 

3.2.6.3  Υπολογισμός όγκου μετά από πιθανή υπερχείλιση ή άδειασμα του 
ταμιευτήρα 

     Ο όγκος που υπολογίσθηκε στο κελί D2 ενδέχεται να υπερβαίνει τη μέγιστη 

χωρητικότητα του ταμιευτήρα (Vj>Vmax) ή να είναι μικρότερος του ελάχιστου 

όγκου Vmin (άδειασμα του ταμιευτήρα). Στη στήλη F υπολογίζεται ο όγκος μετά 

από πιθανή υπερχείλιση ή άδειασμα του ταμιευτήρα. Έτσι, για το κελί F2 γράφεται 

η εντολή 

 

=IF(D2<=Sheet1!$B$8;IF(D2>=Sheet1!$B$9;D2;Sheet1!$B$9);Sheet1!$B$8) 

   (14) 

Αυτή αποτελείται από δύο ‘IF’.Στο εξωτερικό ‘IF’ ελέγχεται αν η τιμή που 

περιέχεται στο κελί D2 είναι μικρότερη ή ίση της τιμής που περιέχεται στο κελί B8 

της Sheet1. Ελέγχεται δηλαδή,  αν ο όγκος που υπολογίσθηκε είναι μικρότερος ή 

ίσος από τη μέγιστη χωρητικότητα Vmax του ταμιευτήρα. Στην περίπτωση που το 

αποτέλεσμα της σύγκρισης είναι ‘TRUE’ εκτελείται η εσωτερική εντολή ‘IF’ (που 

είναι υπογραμμισμένη). Στην αντίθετη περίπτωση (αποτέλεσμα σύγκρισης FALSE) 

στο κελί F2 καταχωρείται η τιμή που περιέχεται στο κελί Β8 της Sheet1,  δηλαδή η 

τιμή του Vmax. Στο εσωτερικό ‘IF’ (που είναι υπογραμμισμένο) ελέγχεται αν η τιμή 

που περιέχεται στο κελί D2 είναι μεγαλύτερη ή ίση από το περιεχόμενο του κελιού 

Β9 της Sheet1. Ελέγχεται δηλαδή, αν ο όγκος του νερού είναι μεγαλύτερος ή ίσος 

από τον ελάχιστο όγκο νερού Vmin στον ταμιευτήρα. Στην περίπτωση που το 
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αποτέλεσμα της σύγκρισης είναι ‘TRUE’ στο κελί F2 καταχωρείται η τιμή του κελιού 

D2, δηλαδή η τιμή του όγκου που ήδη υπολογίσθηκε. Στην αντίθετη περίπτωση 

(αποτέλεσμα σύγκρισης ‘FALSE’) στο κελί F2 καταχωρείται η τιμή του κελιού Β9 

της Sheet1 (ελάχιστος όγκος νερού Vmin). 

3.2.6.4  Υπολογισμός στάθμης μετά από πιθανή υπερχείλιση ή άδειασμα του 
ταμιευτήρα 

     Ο στάθμη που υπολογίσθηκε στο κελί Ε2 ενδέχεται να υπερβαίνει τη στάθμη 

υπερχείλισης (hj>hmax) ή να είναι μικρότερη της ελάχιστης hmin (άδειασμα του 

ταμειευτήρα). Στη στήλη G υπολογίζεται η στάθμη μετά από πιθανή υπερχείλιση ή 

άδειασμα του ταμιευτήρα. Έτσι, για το κελί G2 γράφεται η εντολή 

 

=IF(E2<=Sheet1!$B$3;IF(E2>=Sheet1!$B$4;E2;Sheet1!$B$4);Sheet1!$B$3)

   (15) 

 

Αυτή είναι παρόμοια με την εντολή 14 και δηλώνει ότι στο  κελί G2 καταχωρείται η 

τιμή που περιέχεται στο κελί Ε2, δηλαδή η hj, εφόσον ισχύει η συνθήκη 

maxjmin hhh ≤≤ . Στην  αντίθετη περίπτωση καταχωρείται η τιμή hmax (όταν 

hj>hmax), ή η τιμή hmin (όταν hj<hmin). 

3.2.6.5 Υπερχείλιση – Έλλειψη νερού 

     Όταν ο όγκος του νερού Vj που υπολογίζεται  στο κελί D2 είναι μεγαλύτερος 

από τη μέγιστη χωρητικότητα του ταμιευτήρα Vmax, τότε υπερχειλίζει από το 

φράγμα ποσότητα νερού  

 Vυπερχ = Vj - Vmax (16) 

Ο όγκος που υπερχειλίζει Vυπερχ καταχωρείται στη στήλη Η και υπολογίζεται από 

την εντολή 

 =IF(D2>Sheet1!$B$8;D2-Sheet1!$B$8;0) (17) 

Στην περίπτωση που ο όγκος Vj είναι μικρότερος από τον ελάχιστο όγκο Vmin, τότε 

διακόπτεται η εκροή από τον ταμιευτήρα και δημιουργείται έλλειψη νερού στην 

κατανάλωση ίση με τη διαφορά των όγκων 

 Vελλειψ = Vmin - Vj (18) 

Ο όγκος Vελλειψ καταχωρείται στη στήλη I και υπολογίζεται από την εντολή 

 =IF(D2<Sheet1!$B$9;Sheet1!$B$9-D2;0) (19) 
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3.2.6.6  Ολοκλήρωση των υπολογισμών για όλο το έτος 

      Μετά τη συμπλήρωση των δύο πρώτων σειρών, που αντιστοιχούν στις δύο 

πρώτες εβδομάδες, συμπληρώνονται όλες οι σειρές της Sheet2 από Α3 (άνω 

αριστερά) μέχρι Τ53 (κάτω δεξιά). Ακολουθείται η γνωστή διαδικασία 

συμπλήρωσης με την επιλογή των κατάλληλων κελιών και την εντολή Edit > Fill 

> Down. 

3.2.7  Τελικά διαγράμματα - Συμπεράσματα 

      Στη σελίδα 3 (Sheet3) αντιγράφονται από τη Sheet2 οι στήλες ‘Εβδομάδα’, 

‘Όγκος ΜΥΑ’, ‘Στάθμη ΜΥΑ’, ‘Υπερχείλ’ και ‘Έλλειψη’, όπου έχουν καταχωρηθεί οι 

ζητούμενες τιμές του όγκου και της στάθμης του νερού στον ταμιευτήρα, καθώς 

και οι όγκοι υπερχείλισης ή έλλειψης νερού. 

Με διαδικασία παρόμοια μ’ αυτήν που χρησιμοποιήθηκε στις παραγράφους 3.2.3 

και 3.2.4 κατασκευάζεται η γραφική παράσταση των μεγεθών όγκου, στάθμης 

νερού, υπερχείλισης και έλλειψης νερού συναρτήσει του χρόνου (σχ. 3.10). 

 

ΟΓΚΟΣ - ΣΤΑΘΜΗ - ΥΠΕΡΧΕΙΛΙΣΗ - ΕΛΛΕΙΨΗ
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Σχήμα 3.10: Διάγραμμα μεταβολής όγκου-στάθμης-υπερχείλισης και έλλειψης με τον χρόνο 
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      Από τις καμπύλες όγκου και στάθμης φαίνεται ότι κατά τη διάρκεια του 

εξεταζόμενου υδρολογικού έτους δημιουργείται θετικό ισοζύγιο, αφού ο όγκος του 

νερού στο τέλος του έτους είναι μεγαλύτερος απ’ ότι στην αρχή. Διαπιστώνεται 

επίσης, ότι σε καμιά χρονική στιγμή δε δημιουργείται έλλειψη νερού, ενώ ο όγκος 

που υπερχειλίζει είναι μικρός. 

      Εύκολα γίνεται αντιληπτό ότι, αν τα δεδομένα εισροής και εκροής δοθούν σε 

λεπτομερέστερη χρονική κλίμακα (π.χ. ημερήσια ή ωριαία), τότε ο συνολικός 

όγκος υπερχείλισης θα προκύψει μεγαλύτερος και τα αριθμητικά αποτελέσματα θα 

προσεγγίζουν καλύτερα το πραγματικό φαινόμενο. Η παρούσα μελέτη, έχοντας 

κυρίως διδακτικό χαρακτήρα, εκπονήθηκε με χρονικό βήμα εβδομάδας, ώστε να 

αποφευχθούν μακροσκελείς πίνακες και πολυάριθμα νούμερα. Πάντως, η κάλυψη 

του φαινομένου υπό άλλη χρονική κλίμακα σε μεγαλύτερη ανάλυση δεν θέτει 

καμιά επί πλέον δυσκολία. 
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ΚΕΦΑΛΑΙΟ  4 
Εφαρμογές Λογιστικών Φύλλων στην Γεωτεχνική 
Μηχανική: Εύρεση οριακού φορτίου 
Θ. Χατζηγώγος, καθηγητής Α.Π.Θ. 
Χ. Χατζηγώγος, πολ. Μηχανικός, MSc 

4.1 ΥΠΟΛΟΓΙΣΜΟΣ ΤΗΣ ΦΕΡΟΥΣΑΣ ΙΚΑΝΟΤΗΤΑΣ ΤΟΥ ΕΔΑΦΟΥΣ ΣΤΗΝ 

ΠΕΡΙΠΤΩΣΗ ΜΙΑΣ ΕΠΙΦΑΝΕΙΑΚΗΣ ΘΕΜΕΛΙΩΣΗΣ 

4.1.1. Το φυσικό πρόβλημα  

Σκοπός μίας θεμελίωσης είναι η μεταφορά των φορτίων της ανωδομής στο έδαφος 
με ασφαλή τρόπο. Καταστροφές μιας θεμελίωσης παρατηρούνται με μία από τις 
δύο μορφές: 
 
Μορφή Α. Θραύση του εδάφους λόγω υπέρβασης της αντοχής του σε 
διάτμηση. Καταστροφές αυτού του τύπου έχουν σαν αποτέλεσμα μεγάλες 
κατακόρυφες μετακινήσεις και γενικά έντονη παραμόρφωση του εδάφους με 
άμεσο αποτέλεσμα την καταστροφή της υπερκείμενης κατασκευής που γίνεται 
απότομα. Το φαινόμενο αυτό εκδηλώνεται απότομα. 
 
Μορφή Β. Υπερβολικές καθιζήσεις λόγω παραμορφώσεων του εδάφους, 
που μερικώς οφείλονται στις διατμητικές τάσεις που εμφανίζονται λόγω των 
φορτίων της ανωδομής και μερικώς στη στερεοποίηση του εδάφους. 
 
Η αντοχή του εδάφους σε θραύση ονομάζεται φέρουσα ικανότητα του εδάφους. 
Τόσο η φέρουσα ικανότητα του εδάφους όσο και η τιμή της καθίζησης που 
παρατηρείται, εξαρτώνται γενικά από τις διαστάσεις και το σχήμα της θεμελίωσης, 
από τα εφαρμοζόμενα φορτία και από τη φύση του εδάφους. Για την εκλογή του 
τύπου και των διαστάσεων της θεμελίωσης πρέπει να εξετασθεί τόσο το πρόβλημα 
της φέρουσας ικανότητας, δηλαδή της θραύσης του εδάφους (μορφή Α), όσο και 
το πρόβλημα των καθιζήσεων. 
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4.1.2 Το μηχανικό προσομοίωμα  

Ο υπολογισμός της φέρουσας ικανότητας μίας επιφανειακής θεμελίωσης 
είναι πρόβλημα ελαστοπλαστικής ισορροπίας που επιλύεται με ακρίβεια μόνο σε 
λίγες ειδικές περιπτώσεις. Η κυριότερη δυσκολία παρουσιάζεται στην εκλογή μίας 
μαθηματικής σχέσης τάσεων – παραμορφώσεων που αντιπροσωπεύει 
ικανοποιητικά το έδαφος.  

Στα παρακάτω θα αναπτυχθεί μία λύση στο πρόβλημα της φέρουσας 
ικανότητας που βασίζεται στο ακόλουθο μηχανικό προσομοίωμα. Κατά την 
περιγραφή του μηχανικού προσομοιώματος εισάγονται μερικά μεγέθη που θα 
μπορούσαν να χαρακτηρισθούν σαν τα δεδομένα του προβλήματος (input). Αυτά 
σημειώνονται με έντονους χαρακτήρες. Επίσης θεωρούνται και κάποιες παραδοχές 
ή κάποιοι περιορισμοί, που καθορίζουν επακριβώς το πρόβλημα που εξετάζεται. Οι 
παραδοχές σημειώνονται με πλάγιους χαρακτήρες. Το ζητούμενο του 
προβλήματος, που θα επιλυθεί μέσω του προσομοιώματος είναι ένα και 
σημειώνεται με υπογράμμιση. Πρόκειται για το οριακό κατακόρυφο φορτίο Q: 
 Ένα ορθογώνιοα πέδιλο με μήκος L (μεγάλη πλευρά) και πλάτος B 
(μικρή πλευρά) είναι θεμελιωμένοβ σε βάθος Df μέσα στο έδαφος. Εξεταζεται η 
περίπτωση κατακόρυφου φορτίου Qγ στο κέντρο της θεμελίωσηςδ. Η εδαφική μάζα 
είναι ένας  ομογενής ημίχωροςε με φαινόμενο βάρος γ. Τα χαρακτηριστικά της 
διατμητικής αντοχής του εδάφους είναιστ η γωνία εσωτερικής τριβής φ και της 
συνοχής c. Το έδαφος συμπεριφέρεται ως στερεό ιδεατά πλαστικό υλικόζ.  

Αυτό είναι το μηχανικό προσομοίωμα που θα χρησιμοποιηθεί για την 
επίλυση του εξεταζόμενου φυσικού προβλήματος. Οι παραδοχές ή υποθέσεις που 
εισάγονται στο ως άνω προσομοίωμα μπορούν να ονομασθούν παραδοχές 
προσομοιώματος και είναι οι ακόλουθες (η διατύπωσή τους σημειώνεται και στην 
περιγραφή του μηχανικού προσομοιώματος): 
 α. Εξετάζεται η περίπτωση ορθογωνικού πεδίλου και όχι κυκλικού ή 
κάποιου άλλου πεδίλου διαφορετικού σχήματος κάτοψης. Στην κατήγορία των 
ορθογωνικών πεδίλων ανήκουν, επίσης, τα τετράγωνα πέδιλα και οι πεδιλοδοκοί. 
Οι πεδιλοδοκοί είναι ορθογωνικά πέδιλα, στα οποία η μία διάσταση είναι πολύ 
μεγαλύτερη από την άλλη. Συνήθως ένα ορθογωνικό πέδικο θεωρείται 
πεδιλοδοκός αν ο λόγος της μεγάλης προς τη μικρή πλευρά είναι L/B > 5. Πολύ 
συχνά θεωρείται για την περίπτωση πεδιλοδοκών ότι η μεγάλη διάσταση τείνει στο 
άπειρο, κάτι που μπορεί να απλοποιεί τους υπολογισμούς. 
 β. Το πέδιλο υποτίθεται ότι έιναι θεμελιωμένο σε οριζόντιο επίπεδο μέσα 
στο έδαφος. Επίσης υποτίθεται ότι η ελεύθερη επιφάνεια του εδάφους είναι 
οριζόντια. 
 γ. Το φορτίο που φορτίζει το πέδιλο και μέσω αυτού το έδαφος 
θεωρείται ότι είναι κατακόρυφο. Δηλαδή το πέδιλο δε φορτίζεται ούτε με ροπή, 
ούτε με οριζόντια φορτία, ούτε με καταναγκασμένες μετακινήσεις. 
 δ. Το κατακόρυφο φορτίο, που μεταφέρεται από το πέδιλο στο έδαφος 
δρά στο κέντρο του ορθογωνικού πεδίλου. Αυτό συνάδει με την παραδοχή γ, γιατί 
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σε περίπτωση που το κατακόρυφο φορτίο δε δρούσε στο κέντρο του πεδίλου αλλά 
σε κάποιο άλλο σημείο, τότε θα μπορούσε να αντικατασταθεί από ένα ίσο 
κατακόρυφο φορτίο στο κέντρο και μία ροπή στο κέντρο ίση με το φορτίο επί την 
απόσταση μεταξύ του κέντρου του πεδίλου και του αρχικού σημείου εφαρμογής 
του φορτίου. 
 ε. Το έδαφος θεωρείται ως ομογενής ημίχωρος. Και ως προς το 
«ομογενής», αυτό σημαίνει ότι κάποιες ιδιότητες του εδάφους (π.χ. φαινόμενο 
βάρος, μέτρο ελαστικότητας, λόγος του Poisson) λαμβάνουν την ίδια τιμή σε όλα 
τα σημεία του εδάφους. Αν για κάποια εδαφική ιδιότητα δεν ισχύει το «ομογενές» 
τότε αυτό θα σημειώνεται. Σε αντίθετη περίπτωση θα θεωρείται ότι ισχύει το 
«ομογενές». Ως προς το «ημίχωρος», σημαίνει ότι μοναδικό όριο του εδάφους 
είναι η ελεύθερη επιφάνεια του εδάφους. 
 στ. Η διατμητική αντοχή του εδάφους είναι δυνατό να περιγραφεί για 
κάθε θέση του εδάφους από δύο παραμέτρους. Εδώ πρέπει να σημειωθεί ότι η 
διατμητική αντοχή του έδάφους δεν είναι η ίδια σε όλα τα σημεία του εδάφους 
κάτι που αντιβαίνει με την «ομογένεια» του εδάφους, γιατί η διατμητική αντοχή σε 
ένα σημείο εξαρτάται και από τη θέση του σημείου. Δηλαδή το έδαφος ως προς τη 
διατμητική αντοχη θεωρείται μη ομογενές. Οι δύο παράμετροι όμως που 
καθορίζουν μαζι με τη θέση, τη διατμητική αντοχή του εδάφους, θεωρείται ότι 
είναι ίδιες σε όλα τα σημεία του εδάφους. Αυτές οι παράμετροι είναι η γωνία τριβής 
φ και η συνοχή c. 
 ζ. Η συμπεριφορά του εδάφους σε διάγραμμα τάσης - παραμόρφωσης 
είναι στερεή – ιδεατά πλαστική. Αυτό σημαίνει, ότι το διάγραμμα αποτελείται από 
ένα ευθύγραμμο τμήμα με άκρα την αρχή των αξόνων και το σημείο στο άξονα 
των τάσεων που ισούται με την αντοχή του εδάφους, και από μία ημιευθεία με 
άκρο το σημείο στον άξονα των τάσεων που ισούται με την αντοχή του εδάφους 
και διεύθυνση παράλληλη στον άξονα των παραμορφώσεων. 
 

 
 

Σχήμα 4.1: Διάγραμμα τάσεων – παραμορφώσεων για στερεό – ιδεατά πλαστικό υλικό 
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Τα μεγέθη που εισάγονται ως δεδομένα – δηλαδή, τα οποία πρέπει να είναι 
γνωστά, για να είναι δυνατή η λύση στο πρόβλημα – είναι τα ακόλουθα: 
 
 1. Το μήκος L του πεδίλου. Το μέγεθος αυτό έχει διαστάσεις μήκους [m] 
και αναφέρεται πάντοτε στη μεγάλη πλευρά του πεδίλου. Αν το πρόβλημα 
αναφέρεται σε πεδιλοδοκό τότε το L  ∞. 
 2. Το πλάτος Β του πεδίλου. Το μέγεθος αυτό έχει διαστάσεις μήκους 
επίσης [m] και αναφέρεται στη μικρή πλευρά του πεδίλου. 
 3. Το βάθος θεμελίωσης Df, με διαστάσεις επίσης μήκους [m]. 
 4. To φαινόμενο βάρος του εδάφους γ, με διαστάσεις ειδικού βάρους 
[N/m3]. Συνήθως το μέγεθος αυτό δίνεται σε [kN/m3]. 
 5. Η γωνία εσωτερικής τριβής του εδάφους φ με διαστάσεις γωνίας 
[rad]. Συνήθως το μέγεθος αυτό δίνεται σε μοίρες, οπότε πρέπει να γίνει η 
αντίστοιχη μετατροπή.  
 6. Η συνοχή c του εδάφους, η οποία έχει μονάδες τάσης [Pa]. Συνήθως 
το μέγεθος αυτό δίνεται σε [kPa]. 
Όλα τα παραπάνω μεγέθη είναι θετικά, εκτός από το φ και c που είναι μη αρνητικά 
(δηλαδή μπορεί να είναι και μηδέν). 
Ως τώρα, έχει καθορισθεί επακριβώς το μηχανικό προσομοίωμα που περιγράφει το 
φυσικό πρόβλημα ως προς τις διάφορες παραδοχές και υποθέσεις που ισχύουν σε 
αυτό, και έχουν καθορισθεί τα μεγέθη, η τιμή των οποίων πρέπει να είναι γνωστή 
και να χρησιμοποιηθεί ως δεδομένη, για την εξεύρεση λύσης στο πρόβλημα. Για να 
καταστεί δυνατή η μετάβαση από το μηχανικό προσομοίωμα σε ένα σύνολο 
εξισώσεων που υπολογίζουν την επιθυμητή λύση πρέπει να γίνουν και μερικές 
επιπλέον παραδοχές. Αυτές μπορούν να ονομασθούν παραδοχές επίλυσης, σε 
αντιδιαστολή με τις παραδοχές προσομοιώματος. Οι παραδοχές επίλυσης λοιπόν 
είναι οι ακόλουθες: 
 Α. Το έδαφος είναι ξηρό. Δηλαδή, μεταξύ των κόκκων του εδάφους δεν 
υπάρχει ελεύθερο νερό. Διαφορετικά μπορεί να ειπωθεί πως στο πρόβλημα δεν 
εμφανίζεται στάθμη υπόγειου υδροφόρου ορίζοντα. 
 Β. Αγνοείται η διατμητική αντίσταση του εδάφους πάνω από το επίπεδο 
θεμελίωσης. Δηλαδή, η διατμητική αντοχή του εδάφους στο ευθύγραμμο τμήμα 
(cd) του ακόλουθου σχήματος  θεωρείται μηδενική. 
 Γ. Αγνοείται η τριβή μεταξύ του υπερκείμενου εδάφους και του πεδίλου. 
Δηλαδή στα πλευρικά κατακόρυφα τοιχώματα του πεδίλου που εφάπτονται με 
έδαφος, δεν αναπτύσσονται δυνάμεις τριβής. Παραδείγματος χάριν, στο σχήμα , 
κατά μήκος του ευθύγραμμου τμήματος (ad) οι δυνάμεις τριβής είναι μηδέν. 
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Σχήμα 4.2 : Μηχανικό προσομοίωμα για τον υπολογισμό του οριακού κατακόρυφου φορτίου σε 

ορθογωνικό πέδιλο. 

 

4.1.3 Διατύπωση των εξισώσεων  

Με βάση τα παραπάνω είναι πλέον δυνατόν να διατυπωθούν οι εξισώσεις που 
υπόκεινται στις παραδοχές επίλυσης (Α έως Γ) και που υπολογίζουν το οριακό 
φορτίο μιας επιφανειακής θεμελίωσης που υπόκειται στις παραδοχές του 
προσομοιώματος (α έως ζ). Για την εύρεση λύσης πρέπει να χρησιμοποιηθούν 
δεδομένες τιμές για τα μεγέθη 1 έως 6. 
 
Οι εξισώσεις που λύνουν το πρόβλημα είναι οι ακόλουθες: 
 

Q0 = q(BL)          (1) 
 

q = SCNCc + SqNqγDf + 0.5SγΝγΒγ      (2) 
 
Στις παραπάνω εξισώσεις ορίζονται τα ακόλουθα: 
• q: η αντοχή θραύσης του συστήματος πέδιλο – έδαφος σε κατακόρυφο 
φορτίο. Το μέγεθος αυτό ονομάζεται φέρουσα ικανότητα του πεδίλου και έχει 
διαστάσεις τάσης [Pa]. Το ορίακο κατακόρυφο φορτίο Q0 που είναι και το 
ζητούμενο υπολογίζεται ως το γινόμενο της φέρουσας ικανότητας q επί το 
εμβαδόν κάτοψης του πεδίλου. 
• ΝC, Nq, Nγ: συντελεστές φέρουσας ικανότητας (αδιάστατοι). Οι συντελεστές 
φέρουσας ικανότητας είναι αδιάστατοι και αποτελούν συνάρτηση της εσωτερικής 
γωνίας τρίβής του εδάφους φ.  
• SC, Sq, Sγ: συντελεστές σχήματος (αδιάστατοι). Οι συντελεστές σχήματος 
είναι συνάρτηση τόσο της γωνίας εσωτερικής τριβής του εδάφους όσο και των 
διαστάσεων του πεδίλου.  
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Διάφοροι ερευνητές έχουν προτείνει αναλυτικές εκφράσεις για τους παραπάνω 
συντελεστής. Ο Ευρωκώδικας 7*, προβλέπει ότι στη γενική περίπτωση οι 
συντελεστές φέρουσας ικανότητας  ΝC, Nq, Nγ και οι συντελεστές σχήματος SC, Sq, 
Sγ δίνονται από τις παρακάτω σχέσεις: 
 

 
 
 
 
          (3) 
            
 

και: 
 
 
 
 
 
 
             (4) 

 
Διακρίνονται δύο ειδικές περιπτώσεις: 
 
 Ι. Το πρόβλημα της φέρουσας ικανότητας αφορά σε πεδιλοδοκό. 
Σε αυτή την περίπτωση το μήκος L  ∞. Επομένως οι συντελεστές σχήματος 
γίνονται: 
 
 
 
 
 
        (4α) 
 
 
Δηλαδή για την περίπτωση της πεδιλοδοκού, οι συντελεστές σχήματος μπορούν να 
αγνοηθούν και ο τύπος της φέρουσας ικανότητας γίνεται: 
 
q = NCc + NqγDf + 0.5ΝγΒγ     (2α) 
 

 
* Ευρωκώδικας 7 (Eurocode 7 ή EC7) είναι το κείμενο των ευρωπαϊκών προδιαγραφών για το σχεδιασμό των 

γεωτεχνικών έργων. 
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ΙΙ. Η γωνία εσωτερικής τριβής του εδάφους φ είναι μηδέν, φ = 0. 
Από την εξίσωση που υπολογίζει τον συντελεστή φέρουσας ικανότητας Nc 

προκύπτει διαίρεση με το μηδέν δηλαδή απροσδιοριστία. Σε αυτή την περίπτωση 
ορίζονται τα ακόλουθα: 
 
 
 
 
 
            (3β) 
 
Ομοίως: 
 
 
 
 
 
            (4β) 
 
 
Ο τύπος της φέρουσας ικανότητας γίνεται: 
 
q = 5.14(1+0.2Β/L)c + γDf         (2β) 
 
Στην περίπτωση πεδιλοδοκού και εδάφους με φ = 0, λαμβάνουμε: 
 
q = 5.14c + γDf           (2γ) 
 
Τέλος, σε περίπτωση τετραγωνικού πεδίλου σε έδαφος με φ = 0 και με μηδενικό 
βάθος θεμελίωσης (το πέδιλο δηλαδή εδράζεται στην οριζόντια ελεύθερη 
επιφάνεια του εδάφους), λαμβάνουμε: 
 
q  6.2c           (2δ) 

 
Με αντίστοιχο τρόπο είναι δυνατόν να υπολογισθεί η φέρουσα ικανότητα του 
εδάφους για διάφορους συνδυασμούς εδαφικών ιδιοτήτων και γεωμετρικών 
χαρακτηριστικών του πεδίλου. 
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4.1.4  Επέκταση της θεωρίας – Γραμμική αύξηση της συνοχής του εδάφους c με το 

βάθος  

Το μηχανικό προσομοίωμα που περιγράφηκε, χρησιμοποιείται για την 
υπολογισμό της φέρουσας ικανότητας και τον έλεγχο σε θραύση του εδάφους 
θεμελίωσης για την περίπτωση κατακόρυφο φορτίου στο πέδιλο. Ωστόσο η ισχύς 
του είναι περιορισμένη και υπόκειται στις παραδοχές που αφορούν τόσο στο ίδιο το 
προσομοίωμα (π.χ. σχήμα πεδίλου, ιδιότητες εδάφους), όσο και στις παραδοχές 
επίλυσης. Με άλλα λόγια, το μηχανικό προσομοίωμα που παρουσιάσθηκε μέχρι 
τώρα και οι εξισώσεις που το συνοδεύουν, μπορούν να δώσουν απάντηση όσον 
αφορά σε ένα ορθογωνικό πέδιλο εδραζόμενο σε ομογενές έδαφος, αλλά όχι στην 
περίπτωση που το πέδιλο έχει λόγου χάριν κυκλική κάτοψη ή εδράζεται σε 
ανομοιογενές υπόστρωμα ως προς κάποιες εδαφικές ιδιότητες. Αν το πρόβλημα 
που τίθεται δεν εμπίτπει στο εύρος των προβλημάτων που καλύπτει το 
προτεινόμενο μηχανικό προσομοίωμα, τότε το προσομοίωμα πρέπει να επεκταθεί.  

Επέκταση ενός μηχανικού προσομοιώματος σημαίνει ότι πιθανόν σε αυτό 
εισάγονται κάποια νέα μεγέθη ως δεδομένα ή αίρονται κάποιες από τις παραδοχές 
που ίσχυαν. Είναι πιθανό η εισαγωγή ενός νέου μεγέθους ως δεδομένου να 
οδηγήσει στην εισαγωγή και καινούριων παραδοχών ή στην τροποποίηση των 
υπαρχουσών έτσι ώστε να δοθεί λύση στο πρόβλημα. Για την περίπτωση του 
προβλήματος της φέρουσας ικανότητας που εξετάζεται, θα παρουσιασθεί μία 
επέκταση του μηχανικού προσομοιώματος που αφορά στο μέγεθος της συνοχής 
του εδάφους c. Ως τώρα, έχει υποτεθεί ότι το μέγεθος αυτό, που αποτελεί 
χαρακτηριστικό του εδάφους θεμελίωσης, είναι σταθερό σε κάθε σημείο του 
εδάφους. Στην πραγματικότητα, ωστόσο, συνηθέστερη είναι η περίπτωση κατά την 
οποία η συνοχή του εδάφους βαίνει αυξανόμενη γραμμικά με το βάθος. Αν ισχύει 
αυτό, τότε τα δεδομένα του προβλήματος δεν εμπίπτουν στην περιοχή εύρους του 
μηχανικού προσομοιώματος και είναι αναγκαίο αυτό να επεκταθεί. 

Οι Booker & Davies (1973) παρουσίασαν μία λύση για το πρόβλημα της 
φέρουσας ικανότητας όταν το έδαφος παρουσιάζει συνοχή που δεν είναι σταθερή, 
αλλά βαίνει αυξανόμενη με το βάθος. Για λόγους απλότητας, και χωρίς βλάβη της 
γενικότητας, θα παρουσιασθεί η περίπτωση πεδιλοδοκού που εδράζεται στην 
επιφάνεια εδάφους με φ = 0ο και συνοχή c που μεταβάλλεται γραμμικά με το 
βάθος. Για να περιγράψουν τη μεταβολή της συνοχής αντικατέστησαν τη μία και 
μόνη παράμετρο c του αρχικού προσομοίωματος με δύο νέες παραμέτρους: την 
παράμετρο c0 και την παράμετρο ρ. Η παράμετρος c0 ορίσθηκε ως η τιμή της 
συνοχής στην επιφάνεια του εδάφους, ενώ η παράμετρος ρ ως το αντίστροφο της 
τιμής του ρυθμού μεταβολής της συνοχής με το βάθος (ρ = σταθερό, αφού η 
μεταβολή είναι γραμμική). Επίσης εισήγαγαν έναν διορθωτικό συντελεστή F, στον 
τύπο της φέρουσας ικανότητας, που αποτελεί συνάρτηση των μεγεθών ρ [Pam-1], 
c0 [Pa] και του πλάτους Β [m] της πεδιλοδοκού. Συγκεκριμένα, ο συντελεστής F 
[αδιάστατος] είναι συνάρτηση του επίσης αδιάστατου λόγου ρΒ/c0. Ο παρακάτω 
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πίνακας συνοψίζει την επέκταση της θεωρίας από τους Booker & Davies (1973) για 
το πρόβλημα της γραμμικής αύξησης της συνοχής του εδάφους με το βάθος. 
 

 ΣΥΝΟΧΗ ΠΑΡΑΜΕΤΡΟΙ 
ΦΕΡΟΥΣΑ 
ΙΚΑΝΟΤΗΤΑ 

ΑΡΧΙΚΟ 
ΠΡΟΣΟΜΟΙΩΜΑ 

 

c q = 5.14c 

BOOKER & DAVIES 
(1973) 

 

c0, ρ, F(c0, ρ, B) q = F(5.14c0 + ρΒ/4) 

 
Για το διορθωτικό συντελεστή F οι Booker & Davies πρότειναν το παρακάτω 
δίαγραμμα υπολογισμού: 

Μεταβολή του διορθωτικού συντελεστή F συναρτήσει με το λόγο ρB/c0
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Όπως φαίνεται από το διάγραμμα ο διορθωτικός συντελεστής F λαμβάνει τιμές 
μεγαλύτερες από τη μονάδα. 
 
ΕΦΑΡΜΟΓΕΣ ΣΤΟ MS EXCEL 
 
Η θεωρία που αναπτύχθηκε στα προηγούμενα και αναφέρεται στο πρόβλημα της 
φέρουσας ικανότητας ορθογωνικού πεδίλου αποτελεί την αφορμή για την 
ανάπτυξη ορισμένων εφαρμογών λογιστικών φύλλων με το ΜS Excel. O φοιτητής 
δεν είναι υπεύθυνος για τη γνώση της θεωρίας της φέρουσας ικανότητας. Το 
αντικείμενο αυτό διδάσκεται αναλυτικά σε επόμενα εξάμηνα. 



ΚΕΦΑΛΑΙΟ 4: Εφαρμογές λογιστικών φύλλων στη Γεωτεχνική Μηχανική                          

 

77 

 4.2 ΠΑΡΑΔΕΙΓΜΑΤΑ ΣΤΟ ΠΡΟΒΛΗΜΑ ΤΗΣ ΦΕΡΟΥΣΑΣ ΙΚΑΝΟΤΗΤΑΣ 

ΟΡΘΟΓΩΝΙΚΟΥ ΠΕΔΙΛΟΥ  

4.2.1 Στόχος και δομή των εφαρμογών 

Στα πλαίσια του μαθήματος του δευτέρου εξαμήνου «ΕΦΑΡΜΟΓΕΣ ΤΗΣ 
ΠΛΗΡΟΦΟΡΙΚΗΣ ΣΕ ΘΕΜΑΤΑ ΠΟΛΙΤΙΚΟΥ ΜΗΧΑΝΙΚΟΥ» και όσον αφορά στο 
αντικείμενο της Γεωτεχνικής Μηχανικής, θα παρουσιασθεί ένας αριθμός 
εφαρμογών στο MS EXCEL που αναφέρονται στο πρόβλημα της φέρουσας 
ικανότητας μίας επιφανειακής ορθογωνικής θεμελίωσης. Έχει ήδη παρουσίασθεί εν 
συντομία η θεωρία, η σχετική με το πρόβλημα από την σκοπιά της Γεωτεχνικής 
Μηχανικής. Εδώ θα αναπτυχθούν και θα περιγραφούν οι εφαρμογές – 
συγκροτημένες σε ενότητες - που θα κληθούν να υλοποιήσουν οι φοιτητές του 
δευτέρου εξαμήνου στη νησίδα Προπτυχιακών Φοιτητών του Τμήματος Πολιτικών 
Μηχανικών. 

Κάθε ενότητα εφαρμογών στοχεύει στην παρουσίαση κάποιου εργαλείου ή 
κάποιας τεχνικής του ΜS EXCEL. Αντικειμενικός στόχος δεν αποτελεί η κατανόηση 
κάποιας θεωρίας της Γεωτεχνικής Μηχανικής, για την οποία δεν υπάρχουν ακόμη 
οι προαπαιτούμενες γνώσεις, αλλά η εκμάθηση συγκεκριμένων τεχνικών και 
δυνατοτήτων του προγράμματος. Αυτές οι εφαρμογές στο σύνολό τους, και σε 
συνδυασμό με εκείνες που αναφέρονται στους υπόλοιπους τομείς της Επιστήμης 
του Πολιτικού Μηχανικού, αποσκοπούν εν τέλει στη βελτίωση της ικανότητας των 
φοιτητών ως προς τη χρήση λογιστικών φύλλων και άλλων τύπων λογισμικού για 
την αντιμετώπιση προβλημάτων που θα εμφανισθούν στις μετέπειτα σπουδές τους. 

Θα παρουσιασθούν και θα υλοποιηθούν συνολικά τέσσερεις ενότητες 
εφαρμογών. Ως προς την παρουσίαση των ενοτήτων εφορμογών θα ακολουθηθεί 
η εξής λογική: Για κάθε ενότητα θα καταγράφεται αρχικά ο αντικειμενικός στόχος. 
Δηλαδή, τι θα πρέπει να έχει αποκομίσει ο φοιτητής στο τέλος κάθε ενότητας. Στη 
συνέχεια, θα παρουσιάζονται εν συντομία πληροφορίες σχετικές με τα εργαλεία και 
τις δυνατότητες του προγράμματος που θα χρησιμοποιηθούν κατά την εκτέλεση 
της ενότητας. Οι πληροφορίες αυτές συγκροτούν τις απαραίτητες γνώσεις που 
πρέπει να έχει ο φοιτητής για να χρησιμοποιήσει το MS EXCEL κατά την εκτέλεση 
κάθε ενότητας εφαρμογών. Τέλος, δίνονται αναλυτικές οδηγίες για την 
παρακολούθηση ή εκτέλεση της ενότητας των εφαρμογών. Κάθε ενότητα 
απαρτίζεται από μία ή δύο εφαρμογές στο MS EXCEL που παρουσιάζονται με 
μορφή επίδειξης από το διδάσκοντα και από μία εφαρμογή που πρέπει να 
εκτελέσουν οι φοιτητές, βάσει αυτών που τους παρουσιάσθηκαν. Δίνονται λοιπόν 
λεπτομερείς επεξηγήσεις, τόσο για την φάση της παρουσίασης των εφαρμογών 
από το διδάσκοντα, όσο και για τη φάση υλοποίησης των εφαρμογών από τους 
φοιτητές. 

Οι τέσσερεις ενότητες εφαρμογών περιγράφονται εν συντομία παρακάτω: 
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• ΕΝΟΤΗΤΑ 1:  Η πρώτη ενότητα εφαρμογών αφορά στην κατασκευή 
ενός λογιστικού φύλλου στο MS EXCEL και στη διαμόρφωσή του στην 
κλασική μορφή του προγραμματισμού, κατά την οποία, αφού κατασκευασθεί 
ο υπολογιστικός αλγόριθμος από μία σειρά εντολών, εισάγονται τα δεδομένα 
του προβλήματος, γίνεται η επεξεργασία τους και υπολογίζονται τα 
εξαγόμενα. 

• ΕΝΟΤΗΤΑ 2: Η δεύτερη ενότητα εφαρμογών αφορά στην παρουσίαση 
του εργαλείου Solver στο ΜS EXCEL και στη χρησιμοποίησή του για τη λύση 
γραμμικών και μη γραμμικών προβλημάτων. 

• ENOTHTA 3: H τρίτη ενότητα εφαρμογών αφορά στην παρουσίαση 
μερικών δυνατοτήτων που αφορούν στη στατιστική ανάλυση δεδομένων. Η 
ενότητα στοχεύει στο να καταδειχθεί ο πλούτος των εργαλείων που διαθέτει 
το MS EXCEL και στην επιλογή της καταλληλότερης μεθοδολογίας για την 
αντιμετώπιση ενός συγκεκριμένου προβλήματος. Γίνεται επίσης μία σύντομη 
αναφορά στα «πρόσθετα» εργαλεία του MS EXCEL. 

• ΕΝΟΤΗΤΑ 4: Η τέταρτη ενότητα εφαρμογών αποτελεί μία εισαγωγή 
στις μακροεντολές του MS EXCEL και στην VBA και συγκεκριμένα στη 
δυνατότητα δημιουργίας προσαρμοσμένων συναρτήσεων για τις εφαρμογές 
του χρήστη. Η ενότητα δεν στοχεύει στην αναλυτική παρουσίαση αυτών 
των αντικειμένων τόσο, όσο στο να καταδείξει το βάθος που μπορεί να 
πάρει η χρήση ενός προγράμματος όπως το ΜS EXCEL και να προσφέρει ένα 
κίνητρο στους φοιτητές για περαιτέρω μελέτη και αξιοποίηση του 
προγράμματος. 

 

4.3  ΠΡΩΤΗ ΕΝΟΤΗΤΑ ΕΦΑΡΜΟΓΩΝ – ΕΙΣΑΓΩΓΗ ΣΤΟ MS ΕXCEL ΩΣ 

ΠΡΟΓΡΑΜΜΑΤΙΣΤΙΚΟ ΕΡΓΑΛΕΙΟ 

4.3.1 Αντικειμενικός στόχος της ενότητας  

 Ο αντικειμενικός στόχος της πρώτης ενότητας εφαρμογών στο πλαίσιο της 
παρουσίασης «Εφαρμογές των λογιστικών φύλλων στη γεωτεχνική μηχανική» δεν 
είναι άλλος από το να καταδειχθεί η χρησιμοποίηση του προγράμματος MS ΕXCEL 
ως προγραμματιστικού εργαλείου για τις ανάγκες ενός φοιτητή των 
Εφαρμοσμένων θετικών επιστημών. Τα λογιστικά φύλλα που παρέχονται από το 
MS ΕXCEL μπορούν να διαμορφωθούν με τέτοιο τρόπο έτσι ώστε να 
χρησιμοποιηθούν ως «προγράμματα» – όπως θα τα αποκαλούσε κανείς με την 
κλασσική και σε όλους γνωστή έννοια του όρου – δηλαδή ως ένα σύνολο από 
εκτελέσιμες εντολές στον υπολογιστή που απαρτίζουν έναν αλγόριθμο. Σε αυτή τη 
διαδικασία κατασκευής ενός «προγράμματος» - όπως ακριβώς θα γινόταν και σε 
μία συμβατική γλώσσα προγραμματισμού - ο χρήστης πρέπει να ορίσει τις 
μεταβλητές του προβλήματος, να καταγράψει τις εντολές επεξεργασίας και 
υπολογισμού των μεταβλητών και να καθορίσει τον τρόπο και τη μορφή με την 
οποία επιθυμεί να λάβει τα εξαγόμενα αποτελέσματα.  Επίσης έχει τη δυνατότητα 
να «τρέξει» το πρόγραμμα όσες φορές θέλει, αλλάζοντας τα δεδομένα, κάνοντας 
τις μεταβολές που θέλει στον υπολογιστικό αλγόριθμο και αλλάζοντας τη μορφή 
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των εξαγομένων αποτελεσμάτων. Το πρόγραμμα μπορεί να τηρηθεί στο σκληρό 
δίσκο του υπολογιστή μέχρι ο χρήστης να θελήσει να το χρησιμοποιήσει ξανά.  
 Έτσι αυτή η ενότητα λειτουργεί και ως ένα προοίμιο για να θέσει κανείς το 
ερώτημα: «Μπορεί το MS ΕXCEL να χρησιμοποιηθεί ως γλώσσα 
προγραμματισμού;». Για το ερώτημα αυτό θα επιχειρηθεί να δοθεί μία απάντηση 
με την ολοκλήρωση και της τέταρτης ενότητας, όπου θα γίνει μία αναφορά στις 
μακροεντολές του MS ΕXCEL και στην «κανονική» γλώσσα προγραμματισμού που 
κρύβεται πίσω από αυτό: τη VBA (Visual Basic for Applications). 
 
4.3.2 Απαιτούμενες γνώσεις στο Excel 
 
 Ως προς τις γνώσεις στο MS ΕXCEL, που απαιτούνται για την υλοποίηση της 
πρώτης ενότητας εφαρμογών αυτές έχουν παρουσιασθεί και σε προηγούμενα 
εργαστήρια του μαθήματος. Ο φοιτητής καλείται να εισαγάγει τον τύπο που 
χρειάζεται στα κελιά του λογιστικού φύλλου για να μπορέσει να λύσει το 
πρόβλημα του υπολογισμού του οριακού φορτίου σε μία επιφανειακή θεμελίωση. 
Ως προς τις συναρτήσεις που απαιτούνται στον αλγόριθμο του προβλήματος, ο 
φοιτητής θα χρησιμοποιήσει τις μαθηματικές συναρτήσεις του MS ΕXCEL, καθώς 
επίσης και τη συνάρτηση IF. Όταν η εφαρμογή υλοποιηθεί στη Νησίδα του 
Τμήματος το λογιστικό φύλλο δίνεται διαμορφωμένο κατάλληλα, έτσι ώστε ο 
φοιτητής να χρειαστεί να γράψει μόνο τους τύπους που διαμορφώνουν τη ροή 
υπολογισμού στο λογιστικό φύλλο, και όχι π.χ. τα συνοδευτικά αλφαριθμητικά 
δεδομένα, το στυλ γραμματοσειράς κτλ.   
 
4.3.3 Εκτέλεση της ενότητας εφαρμογών  
 
Εκφώνηση. Η ενότητα αυτή  - κατ’ εξαίρεση σε σχέση με τις υπόλοιπες ενότητες - 
δεν περιλαμβάνει παρά μόνο μία εφαρμογή που θα εκτελεσθεί κατ’ ευθείαν από 
τους φοιτητές. Η εφαρμογή αφορά στο πρόβλημα του υπολογισμού οριακού 
φορτίου μίας επιφανείακής θεμελίωσης, η εκφώνηση του οποίου δίνεται 
ακολούθως: 
 
Δίνεται ορθογωνικό πέδιλο με μεγάλη διάσταση L =2m και μικρή διάσταση Β [m]. 
Το πέδιλο είναι θεμελιωμένο σε βάθος Df = 1m σε ομογενές εδαφικό υλικό που 
παρουσιάζει συνοχή c = 50kPa και εσωτερική γωνία τριβής φ [ο]. Το ειδικό βάρος 
του εδάφους είναι γ = 20kN/m3. Ζητείται να υπολογισθεί το μέγιστο κατακόρυφο 
φορτίο Q0 που μπορεί να φέρει το πέδιλο στο κέντρο του για τις ακόλουθες 
περιπτώσεις: 
- Β = L, B=0.75L, B=0.5L και φ = 30ο. 
- Β = L, B=0.75L, B=0.5L και φ = 0ο. 
O συντελεστής ασφαλείας της φέρουσας ικανότητας του ορθογωνικού πεδίλου 
λαμβάνεται ίσος με FS = 3. 
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Υλοποίηση της εφαρμογής.  
Α. Ο χρήστης ανοίγει την εφαρμογή MS EXCEL και σώζει το νέο αρχείο με το 
όνομα «εφαρμογή 1».  
Β. Η εφαρμογή θα υλοποιηθεί στο Φύλλο 1. Σε αυτό ο χρήστης εφαρμόζει την 
παρακάτω οργάνωση των στηλών και των γραμμών: 
- Οι γραμμές χωρίζονται σε 4 ομάδες ανάλογα με το ρόλο που λαμβάνουν τα 
εισαγόμενα δεδομένα ή οι εισαγόμενοι τύποι στα αντίστοιχα κελιά των γραμμών. 
Σημειώνεται ότι για λόγους ευκρίνειας του φύλλου, η πρώτη και η τελευταία 
γραμμή κάθε ομάδας γραμμών μένει κενή. 
- Οι γραμμές από 1 έως 7 αφιερώνονται στην εισαγωγή του τίτλου του 
«προγράμματος» που θα κατασκευασθεί, όπως επίσης και σε κάποια επικουρικά 
σχόλια. Οι γραμμές από 1 έως 7 περιλαμβάνουν στα κελιά τους μόνο 
αλφαριθμητικά δεδομένα. 
- Οι γραμμές από 8 έως 16 χρησιμοποιούνται για την εισαγωγή των 
δεδομένων που απαιτούνται για την επίλυση του προβλήματος. Εδώ εισάγονται τα 
αριθμητικά δεδομένα που αντιπροσωπεύουν τις τιμές των μεγεθών και που θα 
χρησιμοποιηθούν στους υπολογισμούς. 
- Οι γραμμές από 17 έως 26 χρησιμοποιούνται για την εισαγωγή των τύπων 
που εκτελούν τους ενδιάμεσους υπολογισμούς. Είναι σε αυτές τις γραμμές όπου η 
διαδοχή των τύπων απαρτίζει τον αλγόριθμο επίλυσης του προβλήματος. 
- Οι γραμμές από 27 έως 31 τέλος, χρησιμοποιούνται για την εμφάνιση των 
αποτελεσμάτων των υπολογισμών. 
Οι στήλες αντιστοίχως οργανώνονται ως εξής: 
- Η στήλη Α χρησιμοποιείται για την εισαγωγή των τίτλων των ομάδων 
γραμμών. 
- Η στήλη Β χρησιμοποιείται για την εισαγωγή της περιγραφής των 
δεδομένων που φέρουν ή υπολογίζουν τα κελιά στις αντίστοιχες γραμμές.  
- Η στήλες C, D, E, F, G, H χρησιμοποιούνται για την επίλυση των έξι 
περιπτώσεων ορθογωνικών πεδίλων που ορίζονται από την εκφώνηση. 
Γ. Εν συνεχεία εισάγονται και διαμορφώνονται ένα προς ένα τα κελιά στο 
λογιστικό φύλλο. Πριν δοθεί η αναλυτική επεξήγηση του περιεχομένου κάθε 
κελιού σκόπιμο είναι να δοθεί η τελική εικόνα του λογιστικού φύλλου. Αυτή 
φαίνεται στο παρακάτω σχήμα:   

Στο λογιστικό φύλλο με κανονικά γράμματα διακρίνονται τα κελιά που 
περιέχουν αριθμητικά δεδομένα ή κείμενο, ενώ με πλάγια γράμματα τα κελιά που 
περιέχουν τύπο. Οι στήλες του λογιστικού φύλλου διαμορφώνονται ως εξής: 
 Στήλη Α. Επιλέγονται τα κελιά Α1:Α7 και με δεξί κλίκ από το μενού “Format 
Cells…”, στην καρτέλα “Alignment” γίνεται η επίλογή “Merge cells”. Εν συνεχεία, 
στην περιοχή “Orientation” εισάγεται η τιμή 90 στην περιοχή “degrees”. Mε “OK” 
επανέρχεται ο χρήστης στο λογιστικό φύλλο και πληκτρολογεί στην ενοποιημένη 
περιοχή των κελιών Α1:Α7 το κείμενο «ΤΙΤΛΟΣ – ΣΧΟΛΙΑ». Με παρόμοιο τρόπο, 
διαμορφώνει και τις περιοχές Α8:Α16, Α17:Α26, Α27:Α31, εισάγοντας τα 
αντίστοιχα περιοχόμενα στα συγχωνευμένα και κατάλληλα διαμορφωμένα κελιά. 
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 Στήλη Β. Στη στήλη Β ο χρήστης απλώς πληκτρολογεί το περιεχόμενο των 
κελιών, όπως φαίνεται ενδεικτικά στην εικόνα του λογιστικού φύλλου. Επίσης 
διαμορφώνει το πλάτος της στήλης Β, έτσι ώστε να διακρίνονται ευκρινώς τα 
αλφαριθμητικά δεδομένα που εισήχθησαν. Ο χρήστης μπορεί να διαμορφώσει το 
πλάτος της στήλης με τους ακόλουθους τρόπους: α) Επιλέγοντας όλη τη στήλη 
(αυτό γίνεται κάνοντας κλικ στο γκρι κελί που φέρει το όνομα της στήλης «Β», 
ακριβώς κάτω από τη γραμμή εργαλείων) και στη συνέχεια επιλέγοντας >Format 
>Column >Autofit Selection ή >Format >Column >Width… και εισάγοντας το 
πλάτος της στήλης που τον βολεύει. β) Οδηγώντας το ποντίκι στο σύνορο των 
γκρι κελιών «Β» και «C» ακριβώς κάτω από τη γραμμή εργαλείων. Εκεί ο δείκτης 
του ποντικιού μετατρέπεται σε σταυρό με βέλη στα οριζόντια στελέχη, οπότε με 
διπλό κλικ η στήλη αποκτά το κατάλληλο πλάτος. Ο τρόπος β) είναι μία 
συντόμευση της εντολής Autofit Selection. 
 Στήλη C. Η στήλη C είναι η στήλη όπου εισάγονται τα δεδομένα και 
γίνονται οι υπολοσισμοί για την πρώτη περίπτωση υπολογισμού της εκφώνησης. 
Τα κελιά C1:C7 διαμορφώνται όπως και τα Α1:Α7 και εισάγεται το κείμενο 
«ΠΕΡΙΠΤΩΣΗ 1». Στα κελιά C8:C16 εισάγονται τα αριθμητικά δεδομένα του 
προβλήματος για την περίπτωση 1. Στα κελιά C17:C26 εισάγονται οι τύποι για την 
εκτέλεση των ενδιάμεσων υπολογισμών (Το πρώτο και το τελευταίο για λόγους 
ευκρίνειας μένουν κενά). 
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ΚΕΛΙ ΤΥΠΟΣ 
C18 =C9*C10 
C19 =C14*3,14159/180 
C20 =(TAN(3,14159/4+C19/2))^2*EXP(3,14159*TAN(C19)) 

C21 
=IF(C14>0;(C20-

1)*1/TAN(C19);(IF(C14=0;2+PI();"error"))) 
C22 =2*(C20-1)*TAN(C19) 
C23 =1+C10/C9*SIN(C19) 

C24 
=IF(C14>0;(C23*C20-1)/(C20-

1);(IF(C14=0;(1+0,2*C10/C9);"error"))) 
C25 =1-0,3*C10/C9 

    
Προσέξτε την εντολή IF στο κελί C21 και στο κελί C24 που ορίζει το 

συντελεστή φέρουσας ικανότητας Nc και Sc αντίστοιχα όταν φ>0ο και όταν φ = 0ο, 
ενώ δίνει το μήνυμα «error» όταν ο χρήστης δίνει αρνητική τιμή στο φ. Η ίδια 
ασφαλιστική δικλείδα σε περίπτωση εισαγωγής αρνητικών δεδομένων μπορεί να 
εφαρμοσθεί και στους άλλους τύπους Επίσης σημειώστε ότι μπορείτε να 
εισαγάγετε το π στους τύπους σας είτε με την προσέγγιση 3,14159… είτε ως pi(), 
με υποχρεωτικές τις καμπύλες, που είναι το σύμβολο του MS EXCEL για το τον 
αριθμό π.  
Η περιοχή C27:C31 περιέχει επίσης τύπους που δίνουν και τα τελικά 
αποτελέσματα. Έτσι η περιοχή αυτή διαμορφώνεται ως εξής: 
 
 

ΚΕΛΙ ΤΥΠΟΣ 
C28 =C24*C13*C21+C23*C12*C11*C20+0,5*C25*C10*C12*C22 
C29 =C28/C15 
C30 =C29*C18 

 
Είναι σκόπιμο, για την καλύτερη εικόνα του λογιστικού φύλλου να 

διαμορφωθούν όλοι οι αριθμοί του φύλλου με δύο δεκαδικά ψηφία. Αυτό γίνεται 
επιλέγοντας όλο το φύλλο από το γκρι κελί που βρίσκεται πάνω και αριστερά, 
κάτω από τη γραμμή εργαλείων και επιλέγοντας από δεξί κλικ: Format cells > 
Number > Στο πεδίο Category επιλέγεται Number και στο πεδίο Decimal Places 
επιλέγεται η τιμή 2. 

Ο χρήστης έχει τη δυνατότητα να διαμορφώσει τα κελιά που περιέχουν τα 
αποτελέσματα κατά την αρέσκειά του, κάνοντας τα γράμματα έντονα ή 
μεγαλύτερα κ.ο.κ. 

Στήλες D, E, F, G, H. Οι στήλες αυτές διαμορφώνονται με την εντολή 
Autofill και με τη διπλή εντολή Copy/Paste από τη στήλη C. Οι τύποι στις γραμμές 
17:31 μεταφέρονται κανονικά με Αutofill. Για τα δεδομένα στις γραμμές 8:16, ο 
χρήστης μπορεί να χρησιμοποιήσει την εντολή Copy/Paste και να αλλάζει τα 
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δεδομένα όπου απαιτείται για να διαμορφώνει τα δεδομένα της εκάστοτε 
περίπτωσης. Έτσι ολοκληρώνεται η πρώτη ενότητα εφαρμογών. Τα αποτελέσματα 
του προβλήματος για το οριακό κατακόρυφο φορτίο ορθογωνικού πεδίλου είναι τα 
ακόλουθα: 
 

ΠΕΡΙΠΤΩΣΗ 1 4182,78 kΝ 

ΠΕΡΙΠΤΩΣΗ 2 2844,17 kΝ 

ΠΕΡΙΠΤΩΣΗ 3 1690,79 kN 

ΠΕΡΙΠΤΩΣΗ 4 437,99 kN 

ΠΕΡΙΠΤΩΣΗ 5 315,64 kN 

ΠΕΡΙΠΤΩΣΗ 6 201,86 kN 

 
Συμπεράσματα 

Η εφαρμογή αυτή κατέδειξε τη δυνατότητα χρησιμοποίησης του MS EXCEL 
ως προγραμματιστικού εργαλείου με την κλασσική έννοια του όρου «πρόγραμμα». 
Η στήλη C (περικλείεται από μία έντονη γραμμή στην είκονα του λογιστικού 
φύλλου) είναι ουσιαστικά εκείνη όπου καταγράφεται το «καθαρό πρόγραμμα», 
από την εισαγωγή των δεδομένων (C8:C16) και την υλοποίηση των ενδιάμεσων 
υπολογισμών (C17:C26) ως την εξαγωγή των αποτελεσμάτων (C27:C31). Οι 
εντολές και τα δεδομένα σε αυτό το σύνολο κελιών είναι πολύ εύκολο, με τις 
δυνατότητες που παρέχει το MS EXCEL, να μεταφερθούν σε άλλα κελιά, να 
αντιγραφούν, να διαμορφωθούν ανάλογα και να σχολιασθούν.  
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4.4 ΔΕΥΤΕΡΗ ΕΝΟΤΗΤΑ ΕΦΑΡΜΟΓΩΝ: ΤΟ ΕΡΓΑΛΕΙΟ SOLVER ΤΟΥ EXCEL 

4.4.1 Αντικειμενικός στόχος της ενότητας  

 Ο αντικειμενικός στόχος της δεύτερης ενότητας είναι η παρουσίαση του 
εργαλείου Solver του ΜS EXCEL. O Solver είναι ένα ισχυρό και χρήσιμο εργαλείο 
του ΜS EXCEL, το οποίο επιτρέπει τον υπολογισμό λύσεων σε σενάρια του τύπου 
«αν το μέγεθος y=f(x) είναι ίσο με a πόσο είναι το x; ». Έτσι όταν δεν είναι 
εύκολο να αντιστραφεί η συνάρτηση f έτσι ώστε να προκύψει x = f-1(a) τότε είναι 
επιθυμητή και χρήσιμη η χρησιμοποίηση του εργαλείου Solver. Ο Solver μπορεί να 
χρησιμοποιηθεί σε γραμμικά αλλά και σε μη γραμμικά προβλήματα. Η επόμενη 
παράγραφος περιγράφει τον τρόπο με τον οποίο δουλεύει ο Solver στο ΜS EXCEL 
με επεξηγήσεις στο παράθυρο διαλόγου Solver, αλλά και δύο παραδείγματα 
εφαρμογών. 
 

4.4.2 Απαιτούμενες γνώσεις στο Excel  

Ενεργοποίηση του εργαλείου Solver. Το εργαλείο 
Solver του MS EXCEL ενεργοποιείται από το μενού 
Tools > Solver. Υπάρχει το ενδεχόμενο, αν ο χρήστης 
δεν έχει ξαναχρησιμοποιήσει αυτή το εργαλείο στο 
σύστημά του, να μην είναι φορτωμένο στο μενού Tools 
του MS EXCEL. Σε αυτή την περίπτωση ο χρήστης 
μπορεί να φορτώσει την εφαρμογή Solver με την 
ακόλουθη διαδικασία: Επιλέγει Τools > Add ins… και 
εμφανίζεται το επόμενο παράθυρο διαλόγου: 
Στο παράθυρο αυτό παρουσιάζονται οι διαθέσιμες 
πρόσθετες εφαρμογές που μπορούν να συνοδεύουν το 
MS EXCEL. Ο χρήστης επιλέγει την εφαρμογή Solver 
Add – In, αλλά και όποια άλλη εφαρμογή χρειάζεται και με ΟΚ επιστρέφει στο 
λογιστικό φύλλο.  Tώρα μπορεί να ενεργοποιήσει την επιλογή Solver με Tools > 
Solver… 
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οπότε εμφανίζεται το παράθυρο διαλόγου Solver Parameters: 
 

 
 

Στο παραπάνω παράθυρο καθορίζονται από το χρήστη οι παρακάτω πληροφορίες: 
• Set Target Cell: Στο πεδίο αυτό εισάγεται το κελί που περιέχει τον τύπο 
της συνάρτησης, η οποία ζητούμε να πάρει μια συγκεκριμένη τιμή. Με άλλα λόγια 
τοποθετείται το κελί που περιέχετι τον τύπο της συνάρτησης f, την οποία και θα 
αντιστρέψει ο Solver. Στο πεδίο αυτό μπορεί να τοποθετηεθεί μόνο ένα κελί. Ο 
χρήστης μπορεί να γράψει το όνομα του κελιού στο πεδίο ή κάνοντας κλικ στο 
εικονίδιο επιλογής  να επιλέξει το κελί που θέλει από το λογιστικό φύλλο 
με το ποντίκι. Το εικονίδιο αυτό εμφανίζεται και σε άλλα μενού του MS 
EXCEL πάντα εξυπηρετώντας τον ίδιο σκοπό. 
• Equal To: Στο πεδίο αυτό ο χρήστης έχει τρεις δυνατότητες: α) Max: 
Επιλέγοντας τη δυνατότητα αυτή ο χρήστης αναζητά το μέγιστο της συνάρτησης f. 
Δηλαδή, αναζητά εκείνο το x που μεγιστοποιεί τη συνάρτηση f, καθώς και την τιμή 
του μεγίστου. β) Min: Επιτελεί παρόμοια λειτουργία με την επιλογή Max 
βρίσκοντας όμως το ελάχιστο της συνάρτησης f. γ) Value of: Στο πεδίο αυτό ο 
χρήστης εισάγει την τιμή a, για την οποία f(x) = a, και αναζητά το x.  
• By changing cells: Στο πεδίο αυτό εισάγονται τα κελιά που περιέχουν τις 
μεταβλητές από τις οποίες εξαρτάται η συνάρτηση f, και οι τιμές των οποίων θα 
αλλάξουν για να δοθεί λύση στο πρόβλημα. Παρατηρήστε ότι εδώ ο χρήστης έχει 
τη δυνατότητα να εισαγάγει και περισσότερα του ενός κελιά, ανάλογα με το αν η 
συνάρτηση έχει περισσότερες από μία μεταβλητές αλλά και σε σχέση με τη φύση 
του προβλήματος. Ο χρήστης έχει τρεις επιλογές για την εισαγωγή των ονομάτων 
των κελιών: α) Να πληκτρολογήσει τα ονόματα των κελιών χωρίζοντας 
περισσότερα του ενός κελιά με κόμμα β) Να τα επιλέξει κάνοντας χρήση του 
εικονιδίου επιλογής κελιών και χωρίζοντας με κόμμα τα ονόματα που εμφανίζονται 
στο πεδίο, όταν επιλέγει περισσότερα του ενός κελιά γ) Ακολουθώντας τη 
δυνατότητα Guess που παρέχει το παράθυρο Solver. Αυτή η εντολή δεν κάνει 
τίποτε άλλο από το να εντοπίζει ποιά κελιά, που το όνομά τους δεν περιέχει τύπο, 
εμφανίζονται στον τύπο του κελιού που εισήχθη ως Target Cell. Αν η μεταβλητή 
της συνάρτησης εμφανίζεται έμμεσα μέσω μίας ενδιάμεσης συνάρτησης στον τύπο 
στο Target Cell, η εντολή Guess πάλι εντοπίζει την αρχική μεταβλητή. Ουσιαστικά 
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δηλαδή με την εντολή αυτή, εντοπίζονται αυτόματα όλες οι μεταβλητές της  
συνάρτησης f.  
• Subject to the Constraints: Στο πεδίο αυτό εισάγονται οι περιορισμοί που 
αφορούν στις μεταβλητές της συνάρτησης f αλλά και στην ίδια την f. Πατώντας το 
κουμπί Add εμφανίζεται ο διάλογος εισαγωγής περιορισμών με τη βοήθεια του 
οποίου καταστρώνονται οι περιορισμοί του προβλήματος από το ακόλουθο 
παράθυρο διαλόγου: 
 

Στην περιοχή Cell Reference 
γίνεται η αναφορά του κελιού, η 
τιμή του οποίου υπόκειται σε 
κάποιο περιορισμό. Ο χρήστης 
μπορεί να επιλέξει μεταξύ πέντε 
επιλογών περιορισμών που είναι: 

α) Μικρότερο ή ίσο < =, β) Ακριβώς ίσο =, γ) Μεγαλύτερο ή ίσο > =, δ) Η λύση 
να είναι ακέραιος αριθμός int, ε) Η λύση να είναι δυαδικός αριθμός bin. Για τις 
επιλογές μεγαλύτερο ή ίσο, μικρότερο ή ίσο και ακριβώς ίσο ο χρήστης μπορεί να 
εισαγάγει την επιθυμητή τιμή στο πεδίο Constraint ή μέσω του εικονιδίου επιλογής 
κελιών να την επιλέξει από το κελί που την περιέχει στο λογιστικό φύλλο. Μόλις 
ολοκληρώσει ο χρήστης τη σύνταξη του περιορισμού, επιστρέφει με Add ή ΟΚ στο 
παράθυρο Solver Parameters.  
• Change – Delete: Κάνοντας χρήση αυτών των εντολών και έχοντας 
προεπιλέξει έναν περιορισμό, ο χρήστης έχει τη δυνατότητα να τον αλλάξει ή να 
τον διαγράψει τελείως από την εφαρμογή του. 
• Options: Κάνοντας κλικ στο κουμπί Options εμφανίζεται το παρακάτω 
παράθυρο παραμέτρων και επιλογών για το εργαλείο Solver του MS EXCEL: 
 

Στο παράθυρο αυτό εμφανίζονται οι 
ακόλουθες επιλογές: 
• Max Time: Η εντολή αυτή 
θέτει ένα μέγιστο χρόνο διάρκειας 
της διαδικασίας επίλυσης. Ο χρήστης 
μπορεί να επιλέξει μέχρι και την τιμή 
32,767 sec, ωστόσο η 
προεπιλεγμένη τιμή των 100 sec 
συνήθως αρκεί για τις συνήθεις 
εφαρμογές. 
• Iterations: Η εντολή αυτή 
επίσης θέτει ένα μέγιστο χρόνο 
διάρκειας της διαδικασίας επίλυσης 

αυτή τη φορά όμως περιορίζοντας τον αριθμό των ενδιάμεσων υπολογισμών. Η 
μέγιστη τιμή είναι και εδώ 32,767 ενώ η προκαθορισμένη τιμή είναι 100. 
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• Precision: Η τιμή αυτή ελέγχει την ακρίβεια των λύσεων χρησιμοποιώντας 
τον αριθμό που εισάγει ο χρήστης για να καθορίσει αν η τιμή σε κάποιο κελί που 
υπόκειται σε περιορισμό ικανοποιεί μία λύση ή ένα άνω ή κάτω φράγμα. Με άλλα 
λόγια, η τιμή στο πεδίο Precision καθορίζει την ακρίβεια στη μεταβλητή x της 
συνάρτησης f. H τιμή στο Precision είναι στο διάστημα (0,1) και όσο μικρότερη 
είναι, τόσο ακριβέστερη προκύπτει η λύση στο πρόβλημα 
• Tolerance: Η τιμή αυτή έχει νόημα μόνο για περιορισμούς με ακεραίους 
αριθμούς (int). Aναφέρεται δε στο ποσοστό λάθους μεταξύ της ακέραιας λύσης και 
της πραγματικής λύσης σε ένα πρόβλημα. Όσο μεγαλύτερο το Tolerance τόσο 
πιθανότερη και γρηγορότερη η εύρεση λύσης. 
• Convergence: Όταν η διαφορά των τιμών του Target Cell είναι μικρότερη 
από τον αριθμό στο πεδίο Convergence στις πέντε τελευταίες επαναλήψεις του 
Solver, τότε η εφαρμογή σταματά και ο Solver κρατά τη λύση. Ο αριθμός αυτός 
αναφέρεται μόνο σε μη γραμμικά προβλήματα και ανήκει επίσης στο (0,1). Όσο 
μικρότερο το Convergence, τόσο περισσότερος χρόνος απαιτείται για τη λύση στο 
πρόβλημα. 
• Assume Linear Model: Με την επιλογή αυτή επιταχύνεται η διαδικασία 
επίλυσης καθορίζοντας ο χρήστης πως όλες οι σχέσεις στο πρόβλημα είναι 
γραμμικές. 
• Show Iteration Results: Ο Solver σταματά και παρουσιάζει τα 
αποτελέσματα στο τέλος κάθε επανάληψης. 
• Use Automatic Scaling: Χρησιμοποιείται όταν οι τιμές των μεταβλητών 
διαφέρουν κατά πολλές τάξεις μεγέθους από τα εξαγόμενα της συνάρτησης. 
• Assume Non – Negative: Θεωρεί ελάχιστη τιμή μηδέν για όσα κελιά δεν 
υπόκεινται σε κάποιον άλλο περιορισμό. 
• Estimates: Καθορίζει τη μέθοδο εύρεσης εκτίμησης στην αρχή κάθε 
επανάληψης και για κάθε μεταβλητή 
• Tangent: Η εύρεση της εκτίμησης γίνεται με τη μέθοδο γραμμικής 
παρεμβολής εφαπτόμενου διανύσματος. 
• Quadratic:  Η εύρεση της εκτίμησης γίνεται με τετραγωνική παρεμβολή. 
Χρησιμοποιείται σε έντονα μη γραμμικά προβλήματα. 
• Derivatives: Καθορίζει τη μέθοδο υπολογισμού μερικών παραγώγων. 
• Forward: Για χρήση όταν η συνάρτηση παρουσιάζει όχι απότομες 
μεταβολές. 
• Central: Για χρήση όταν η συνάρτηση παρουσιάζει απότομες μεταβολές. 
• Search: Καθορίζει τον αλγόριθμο με τον οποίο καθορίζεται η εκτίμηση σε 
κάθε επανάληψη. 
• Newton: Απαιτεί περισσότερη μνήμη αλλά λιγότερες επαναλήψεις. 
• Conjugate: Απαιτεί περισσότερες επαναλήψεις αλλά χρησιμοποιεί λιγότερη 
μνήμη. Χρησιμοποιείται σε μεγάλα προβλήματα ή όταν ο χρόνος που χρειάζεται για 
κάθε επανάληψη είναι πολύς. 
• Load Model: Κρατά τις ρυθμίσεις στο μενού Options και για άλλες χρήσεις 
του Solver. 
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• Save Model: Όταν υπάρχουν περισσότερες από μία εφαρμογές του Solver 
σε ένα λογιστικό φύλλο και ο χρήστης θέλει να κρατήσει τις επιλογές στο μενού 
Options. 
 
Οι παραπάνω πληροφορίες ολοκληρώνουν την περιγραφή του Εργαλείου Solver 
του MS EXCEL. Ακολουθούν οι εφαρμογές στο πρόβλημα της φέρουσας 
ικανότητας ορθογωνικού πεδίλου. 
ΕΚΤΕΛΕΣΗ ΤΗΣ ΕΝΟΤΗΤΑΣ ΕΦΑΡΜΟΓΩΝ 

 
Εκφώνηση.   

Α. Δίνεται ορθογωνικό πέδιλο με μεγάλη διάσταση L =0,50m και μικρή 
διάσταση Β = 0,75L. Το πέδιλο είναι θεμελιωμένο στην επιφάνεια  εδαφικού 
υλικού που παρουσιάζει συνοχή c = 50kPa και εσωτερική γωνία τριβής φ [ο], η 
τιμή της οποίας είναι άγνωστη. Το ειδικό βάρος του εδάφους είναι γ = 20kN/m3. 
Για να προσδιορισθεί η τιμή της γωνίας τριβής του εδάφους φ, το πέδιλο 
φορτίσθηκε με κατακόρυφο φορτίο στο κέντρο του  και αστόχησε για Q0 = 500kN. 
Ζητείται να υπολογισθεί η γωνία τριβής φ του εδαφικού υλικού. Ο συντελεστής 
ασφαλείας θα θεωρηθεί ίσος με τη μονάδα. 

Β. Από τη στατική ανάλυση ενός κτιρίου προκύπτει ότι το μέγιστο 
κατακόρυφο φορτίο σε ένα υποστύλωμα είναι Q0 = 5000kN. To υποστύλωμα θα 
θεμελιωθεί σε βάθος Df = 1,5m σε εδαφικό υλικό όμοιο με αυτό του ερωτήματος 
Α. Ζητείται να βρεθούν οι διαστάσεις του πεδίλου με το ελάχιστο εμβαδόν κάτοψης 
ώστε η μεταφορά του κατακόρυφου φορτίου να επιτυγχάνεται με ασφάλεια. 
Δίνεται ο συντελεστής ασφαλείας FS = 3. 
 

4.4.3 Υλοποίηση της εφαρμογής.  

Α. Ο χρήστης ανοίγει το λογισμικό MS EXCEL και σώζει το νέο αρχείο με 
το όνομα «εφαρμογή 2».  
 Β. Για τη βασική διαμόρφωση του λογιστικού φύλλου ο χρήστης μπορεί 
να αντιγράψει τις τρεις πρώτες στήλες από το Φύλλο 1 του αρχείου «εφαρμογή 1» 
που περιέχουν τη βασική δομή του προγράμματος για την εύρεση του οριακού 
φορτίου ενός ορθογωνικού πεδίλου. Αρχικά επιλύεται το ερώτημα Α με χρήση του 
εργαλείου Solver:  
 ΕΡΩΤΗΜΑ Α: Όπως διατυπώνεται στην εκφώνηση, το ζητούμενο τώρα 
δεν είναι το οριακό φορτίο του θεμελίου, αλλά η γωνία τριβής του εδάφους 
έδρασης. Δηλαδή αν θεωρηθεί η συνάρτηση f(c, γ, φ, Β, L, Df) = Q0 τώρα πρέπει 
να βρεθεί ποίο είναι εκείνο το συγκεκριμένο φ που θα δώσει την επιθυμητή τιμή 
στο Q0 = 500kN. Το πρόβλημα αντιστροφής της συνάρτησης f ως προς τη 
μεταβλητή φ δεν είναι και το πλέον απλό, οπότε σε αυτή την περίπτωση 
ενδείκνυται η εφαρμογή του εργαλείου Solver. 
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Ο χρήστης έχοντας αντιγράψει τη βασική δομή του προγράμματος στο φύλλο 
εργασίας του αρχείου «εφαρμογή 2» μετονομάζει την περιοχή C1:C7 σε ερώτημα 
Α, Εν συνεχεία τοποθετεί τα δεδομένα του προβλήματος στα αντίστοιχα κελιά: 
 

ΚΕΛΙ ΠΕΡΙΕΧΟΜΕΝΟ ΚΕΛΙΟΥ 
C9 =0,50 
C10 =0,75*C9 
C11 =0 
C12 =20 
C13 =50 
C14 Ο χρήστης εισάγει μία τυχαία τιμή 
C15 =1 

 
Στο κελί όπου εισάγεται η τιμή της εσωτερικής γωνίας τριβής, ο χρήστης εισάγει 
μία τυχαία τιμή έστω φ = 30ο, την οποία θα διορθώσει ο Solver. Έχοντας 
συμπληρώσει τα δεδομένα λαμβάνει την εικόνα του παρακάτω σχήματος: 
 

 
 

Στη συνέχεια ενεργοποιεί το εργαλείο 
Solver με Tools > Solver…οπότε 
ανοίγει το παράθυρο Solver 
Parameters, το οποίο διαμορφώνεται 
ως εξής: 
 
Στο πεδίο Set Target Cell επιλέγεται το 
κελί που περιέχει τον τύπο του οριακού 
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φορτίου $C$30 (τα δολλάρια υποδηλώνουν απόλυτη θέση κελιού). Στο πεδίο 
Equal To επιλέγεται η επιλογή Value of και πληκτρολογείται η τιμή 500. Στο πεδίο 
By Changing Cells, πληκτρολογείται ή επιλέγεται από το εικονίδιο επιλογής κελιού 
το $C$14 που περιέχει την τιμή της εσωτερικής γωνίας τριβής του εδάφους. Δεν 
είναι απαραίτητο να τεθεί κανένας περιορισμός. Ο χρήστης επιλέγει την επιλογή 
Solve οπότε και εμφανίζεται το παράθυρο Solver Results:  
 

 
 

Tο παράθυρο αυτό περιέχει το μήνυμα: «Solver found a solution. All constraints 
and optimality conditions are satisfied (Ο Solver βρήκε μία λύση. Όλοι οι 
περιορισμοί και οι συνθήκες βελτιστοποίησης ικανοποιούνται). Αυτό σημαίνει ότι 
βρέθηκε λύση που ικανοποιεί τα κριτήρια που τέθηκαν. Ο χρήστης μπορεί να 
επιλέξει “ Keep Solver Solution” για να κρατήσει τη λύση ή “Restore Original 
Values” για να ακυρώσει τη λύση του Solver. Επισης μπορεί να επιλέξει αν θέλει 
να εμφανίσει αναφορές με τα αποτελέσματα του Solver για την λύση (Answer) για 
την ευαισθησία της λύσης (Sensitivity) και για τα Όρια (Limits), από το πεδίο 
Reports. Τσεκάροντας “Keep Solver Solution” και ΟΚ, επιστρέφει στο λογιστικό 
φύλλο όπου έχει υπολογισθεί η γωνία τριβής φ που δίνει οριακό φορτίο Q0 = 
500kN και η οποία είναι φ = 32,3ο. 
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  ΕΡΩΤΗΜΑ Β.  Για την επίλυση του ερωτήματος Β, σε πρώτη 
φάση αντιγράφουμε τη στήλη C στη στήλη D αντικαθιστώντας τις τιμές των 
μεγεθών που καθορίζονται στην εκφώνηση και μετονομάζοντας την περιοχή 
D1:D7 σε ΕΡΩΤΗΜΑ Β. Εδώ το ζητούμενο είναι οι ελάχιστες διαστάσεις Β και L του 
πεδίλου που μπορεί να μεταφέρει με ασφάλεια στο έδαφος κατακόρυφο φορτιο Q0 
= 5000kN. Έτσι έχουμε τα εξής: 
 

ΚΕΛΙ ΠΕΡΙΕΧΟΜΕΝΟ ΚΕΛΙΟΥ 
D9 Εισάγεται μία τυχαία τιμή 
D10 Εισάγεται μία τυχαία τιμή μικρότερη ή ίση του D9 
D11 =1,5 
D12 =20 
D13 =50 
D14 =32,30 
D15 =3 

 
οπότε λαμβάνεται η παρακάτω εικόνα 
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Στη συνέχεια ο χρήστης ενεργοποιεί το εργαλείο Solver με Tools > Solver…οπότε 
ανοίγει το παράθυρο Solver Parameters, το οποίο διαμορφώνεται ως εξής: 
 

Στο πεδίο Set Target 
Cell επιλέγεται το κελί 
που περιέχει τον τύπο 
του εμβαδού κάτοψης 
του πεδίλου $D$18 (τα 
δολλάρια υποδηλώνουν 
απόλυτη θέση κελιού). 
Στο πεδίο Equal To 
επιλέγεται Min που 
απαιτεί την 
ελαχιστοποίηση του 

περιεχομένου του κελιού $D$18. Στο πεδίο By Changing Cells, πληκτρολογείται ή 
επιλέγεται από το εικονίδιο επιλογής κελιού η περιοχή $D$9:$D$10 που περιέχει 
τα μέγεθη Β και L. Ο χρήστης μπορεί να κάνει και χρήση της εντολης Guess, οπότε 
λαμβάνει ακριβώς το ίδιο όρισμα στην περιοχή By Changing Cells. Στην περιοχή 
Subject to the Constraints εισάγονται οι εξής περιορισμοί: Πρώτον, το κελί $D$30 
που περιέχει την τιμή του οριακού φορτίου τίθεται ίσο με 5000. Δεύτερον, η τιμή 



ΚΕΦΑΛΑΙΟ 6: Εφαρμογές λογιστικών Φύλλων στην Υδρολογία                          

 

93 

στο κελί $D$10 που περιέχει το Β 
τίθεται πάντα μικρότερη από 
αυτήν στο $D$9 που περιέχει το 
L. Ο χρήστης κλείνει κάνοντας 
Solve και λαμβάνει το παρακάτω 
μήνυμα: 
 

 
Με “Keep Solver Solution” επιστρέφει στο λογιστικό φύλλο όπου βλέπει τα 
αποτελέσματα: 
 
 
 
Δηλαδή, οι διαστάσεις του πεδίλου είναι ίσες μεταξύ τους. Εύκολα διαπιστώνει 
κανείς ότι και μεταξύ πεδίλων ίδιου εμβαδού, το τετραγωνικό πέδιλο παρουσιάζει 
τη μέγιστη φέρουσα ικανότητα. (Ο αναγνώστης αν θέλει μπορεί να κατασκευάσει 
μία εφαρμογή στο Solver για να αποδείξει την παραπάνω πρόταση). 
 

Β = L = 1 86m
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4.5  ΤΡΙΤΗ ΕΝΟΤΗΤΑ ΕΦΑΡΜΟΓΩΝ – ΕΦΑΡΜΟΓΕΣ ΤΩΝ ΣΤΑΤΙΣΤΙΚΩΝ ΚΑΙ 

ΓΕΝΙΚΟΤΕΡΑ ΤΩΝ ΣΥΝΑΡΤΗΣΕΩΝ ΑΝΑΛΥΣΗΣ ΔΕΔΟΜΕΝΩΝ ΤΟΥ MS 

EXCEL 

4.5.1   Αντικειμενικός στόχος της ενότητας  

 Το MS EXCEL παρέχει ένα μεγάλο αριθμό στατιστικών συναρτήσεων και 
γενικότερα συναρτήσεων ανάλυσης δεδομένων, οι οποίες καλύπτουν το σύνολο 
των σχετικών εφαρμογών που είναι δυνατό να συναντηθούν στα προβλήματα 
Πολιτικού Μηχανικού. Η παρουσίαση όλων των συναρτήσεων και των τεχνικών 
που διαθέτει το MS EXCEL για την ανάλυση δεδομένων υπερβαίνει κατά πολύ τους 
στόχους και τις δυνατότητες αυτής της παρουσίασης. Αυτό που είναι ωστόσο 
εφικτό, είναι η παρουσίαση, μέσω ενός παραδείγματος, ορισμένων μεθοδολογιών 
εργασίας στο MS EXCEL για προβλήματα στατιστικής ανάλυσης ή ανάλυσης 
δεδομένων. 

4.5.2  Εκτέλεση της ενότητας εφαρμογών  

 
ΕΦΑΡΜΟΓΗ 1 - ΕΚΦΩΝΗΣΗ. Στον πίνακα που ακολουθεί δίνονται τα αποτελέσματα 
υπολογισμού της συνοχής c ενός εδάφους συναρτήσει του βάθους: 

 

α/α Βάθος 
Υπολογισμένη Τιμή 

Συνοχής 
- [m] [kPa] 
1 3 28 
2 4 58 
3 7 50 
4 7 83 
5 9 71 
6 10 101 
7 10 129 
8 12 150 
9 14 129 
10 15 158 

 
Να εξετασθεί με βάση τα πειραματικά δεδομένα αν η συνοχή του εδάφους είναι 
γραμμική συνάρτηση του βάθους. 
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ΕΠΙΛΥΣΗ.  Το πρόβλημα επιλύεται μέσω στατιστικής ανάλυσης που αφορά στην 
αναζήτηση σχέσης γραμμικής παλινδρόμησης μεταξύ του βάθους και της συνοχής 
του εδάφους: 

c = a + bz 
ή γενικότερα  

y = a + bx. 
Το ζητούμενο είναι ο υπολογισμός των όρων a και b καθώς επίσης και του 
συντελεστή προσδιορισμού R2, ο οποίος αποτελεί δείκτη του κατά πόσον η 
γραμμική σχέση είναι ικανοποιητική για τα δεδομένα του προβλήματος. 
 
Για τον τρόπο με τον οποίο προκύπτουν οι τύποι των παραπάνω όρων, ο 
αναγνώστης παραπέμπεται σε στοιχειώδη βιβλία στατιστικής (π.χ. Εφαρμογές 
Πιθανοτήτων και Στατιστικής στη μελέτη και προγραμματισμό Τεχνικών Έργων – 
Ang & Tang, Μετάφραση Δ. Παναγιωτακόπουλος). Ο παρακάτω πίνακας 
παρουσιάζει το απαραίτητο τυπολόγιο: 
 

Παράμετρος Εξίσωση Συνάρτηση του MS EXCEL 

Σταθερός όρος )()( xbEyEa −=  INTERCEPT (y-range;x-range) 

Συντελεστής 

Παλινδρόμησης ∑
∑

−

−−
= 2))((

))())(((
xEx

yEyxEx
b

i

ii
 SLOPE(y-range;x-range) 

Υπό συνθήκη τυπική 

απόκλιση 

 2
1

2

/ −
=

∑
=

n

e
S

n

i
i

xy  
STEYX(y-range;x-range) 

Συντελεστής 

Προσδιορισμού ∑
=

−
−= n

i
i

xy

yEy

S
R

1

2

2
/2

))((
1  

RSQ(y-range;x-range) 

 
Για τα παραπάνω ορίζονται και τα ακόλουθα: 
 

- ∑
=

=
n

i

i

n
x

xE
1

)( , η μέση τιμή του μεγέθους x. 

 

- ∑
=

=
n

i

i

n
y

yE
1

)( , η μέση τιμή του μεγέθους y. 

 
- )( iii bxaye +−= , το σφάλμα μεταξύ της τιμής yi και της τιμής που 

υπολογίζεται με βάση την εξίσωση της γραμμικής παλινδρόμησης. 
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Στο MS EXCEL το πρόβλημα μπορεί να επιλυθεί με διάφορες μεθόδους, κάποιες 
από τις οποίες παρουσιάζονται παρακάτω: 
 - Πρώτη Μέθοδος: Με χρήση των ενσωματωμένων συναρτήσεων 
του MS EXCEL. Αρχικά, ο χρήστης ανοίγει ένα καινούριο βιβλίο εργασίας και το 
σώζει με το όνομα «εφαρμογή 3». Στη πρώτη γραμμή εισάγει τους τίτλους των 
τρίων στηλών δεδομένων 
Α1  «Α/Α», Β1  «Βάθος», C1  «Συνοχή» και στη συνέχεια γεμίζει τις γραμμές 
από 2:11 με τα δεδομένα που δίνονται στην εκφώνηση λαμβάνοντας την 
ακόλουθη εικόνα. 

 
 
Στη συνέχεια, ορίζει τέσσερα 
κελία, στα οποία θα 
τοποθετήσει τις συναρτήσεις 
της γραμμικής παλινδρόμησης 
και εισάγει στον καθένα την 
αντίστοιχη συνάρτηση του MS 
EXCEL προσέχοντας να ορίσει 
σωστά τα ορίσματα. 
Εκτελώντας τα παραπάνω 
λαμβάνει την ακόλουθη 
εικόνα: 
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Έτσι τα κελιά D15:D18 περιέχουν αντίστοιχα τους παρακάτω τύπους: 
 

ΟΝΟΜΑΣΙΑ 
ΚΕΛΙΟΥ 

ΤΥΠΟΣ 

D15 =INTERCEPT(C2:C11;B2:B11) 
D16 =SLOPE(C2:C11;B2:B11) 
D17 =STEYX(C2:C11;B2:B11) 
D18 =RSQ(C2:C11;B2:B11) 

 
Είναι προφανές πως η συνοχή μπορεί να περιγραφεί προσεγγίστικά από μία σχέση 
της μορφής: 

c = 1,839 + 10,314z 
όπου ο συντελεστής προσδιορισμού R2 = 0,836. 
 
ΔΕΥΤΕΡΗ ΜΕΘΟΔΟΣ. Με χρήση της ολοκληρωμένης εφαρμογής 
Regression από το εργαλείο Data Analysis του μενού Tools.  
 

Το εργαλείο Data Analysis είναι και αυτό ένα από 
τα πρόσθετα εργαλεία του MS EXCEL, που μπορεί 
να αποδειχθούν ιδιαίτερα χρήσιμα σε πολλές 
εφαρμογές. Το εργαλείο αυτό ενεργοποιείται και 
εμφανίζεται στο μενού Tools (σε περίπτωση που 
δεν εμφανίζεται αρχικά) με τον ίδιο τρόπο που 
ενεργοποιείται και ο Solver. Δηλαδή με Tools > Add 
ins… o χρήστης εμφανίζει το διπλανό μενού από 
στο οποίο επιλέγει Analysis Toolpak. 
Με ΟΚ επανέρχεται στο λογιστικό φύλλο και με 
Tools > Data Analysis…ανοίγει το κεντρικό 
παράθυρο του εργαλείου: 
 
 

 
 

Στο παράθυρο αυτό παρουσιάζονται όλα τα υπο – εργαλεία της εφαρμογής Data 
Analysis…Είναι εργαλεία που έχουν μεγάλη χρησιμότητα. Ο αναγνώστης μπορεί να 



ΚΕΦΑΛΑΙΟ 6: Εφαρμογές λογιστικών Φύλλων στην Υδρολογία                          

 

98 

αναζητήσει περισσότερες πληροφορίες για όλες αυτές τις δυνατότητες σε 
συγγράμματα όπως τα: 
• Ασημακόπουλος, Δ. & Αραμπαζής, Γ., (2002) «Τεχνικές Ανάλυσης 
Δεδομένων και Λήψης Αποφάσεων» Παπασωτηρίου, Αθήνα.  
• Μiddleton, M. (2000) «Data Analysis using Microsoft Excel», Duxbury, 
Thomson Learning. 
 
Εδώ θα εξετασθεί μόνο η επιλογή Regression, που αφορά στη γραμμική 
παλινδρόμηση για ένα πλήθος δεδομένων με τη μέθοδο των ελαχίστων 
τετραγώνων. Επιλέγοντας με το ποντίκι Regression και πατώντας ΟΚ, ο χρήστης 
εμφανίζει το επόμενο παράθυρο: 

Σχετικά με το παράθυρο 
Regression ισχύουν τα παρακάτω: 
• Input Y Range: Ο χρήστης 
εισάγει εδώ τα δεδομένα που 
διαθέτει για την εξαρτώμενη 
μεταβλητή. Δηλαδή, αν πρόκειται 
να εκτέλεσει παλινδρόμηση μεταξύ 
δύο μεγεθών x, y ώστε να πάρει 
μία γραμμική σχέση της μορφής y 
= ax + b, εδώ εισάγονται τα 
δεδομένα της στήλης y. 
• Input X Range: Εδώ 
εισάγονται τα δεδομένα για την 
ανεξάρτητη μεταβλητή x. 
Σημειωτέον, ότι το εργαλείο έχει 
τη δυνατότητα να εκτελέσει 
γραμμική παλινδρόμηση για 

περισσότερες από μία ανεξάρτητες μεταβλητές και συγκεκριμένα μέχρι και για 
δεκαέξι. 
• Labels: Επιλέγοντας αυτήν την επιλογή ο χρήστης καθορίζει στο Excel ότι 
το περιεχόμενο των πρώτων κελιών, στις στήλες των δεδομένων που εισάγει, 
περιέχουν το όνομα των μεγεθών y και x. 
• Confidence Level: Ο χρήστης με την επιλογή αυτή καθορίζει το ποσοστό 
εμπιστοσύνης για το δείμγα που απαρτίζουν τα δεδομένα του. Το ποσοστό αυτό 
εφαρμόζεται σε συνδυασμό με την προκαθορισμένη τιμή του προγράμματος που 
είναι 95%.  
• Constant is Zero: Με αυτή την επιλογή προκαθορίζεται ότι η σταθερά b, 
στη σχέση y = ax + b, είναι μηδέν. 
• Output Range: Στο πεδίο αυτό εισάγεται το όνομα του πρώτου πάνω και 
αριστερά κελιού της περιοχής, στην οποία θέλει ο χρήστης να εισαχθούν τα 
αποτελέσματα. 
• New Worksheet Ply: Ο χρήστης επιλέγει αυτήν την επιλογή όταν θέλει τα 
αποτελέσματά του να εισαχθούν σε καινούριο φύλλο εργασίας. Στο πεδίο εισάγει 
το όνομα που θέλει να δώσει στο φύλλο όπου θα εισαχθούν τα αποτελέσματα. 
• New Workbook: Με την επιλογή αυτή ο χρήστης εισάγει τα αποτελέσματα 
σε ένα καινούριο βιβλίο εργασίας, δηλαδή σε ένα καινούριο αρχείο Excel. 
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• Residuals: Με την επιλογή αυτή εισάγονται και τα υπόλοιπα (η απόσταση 
των σημείων από τη γραμμή παλινδρόμησης) στα αποτελέσματα της εφαρμογής 
Regression. 
• Standardized Residuals: Με την επιλογή αυτή εισάγονται στα 
αποτελέσματα και τα σχετικά υπόλοιπα (η απόσταση των σημείων από τη γραμμή 
παλινδρόμησης διά την τυπική απόκλιση). 
• Residual Plots: Η επιλογή αυτή παράγει ένα διάγραμμα που παριστάνει τα 
υπόλοιπα για κάθε ανεξάρτητη μεταβλητή. 
• Line Fit Plots: Η επιλογή αυτή παράγει ένα διάγραμμα που παριστάνει τη 
γραμμή παλινδρόμησης και τα δεδομένα. 
• Normal Probability Plots: Η επιλογή αυτή παράγει ένα διάγραμμα 
κανονικής κατανομής για τα δεδομένα της εφαρμογής. 
• Ηelp: Δίνει οδηγίες και εξηγήσεις για όλα τα πεδία που εμφανίζονται στο 
παράθυρο. 

 
Βάσει των παραπάνω ο χρήστης 
συμπληρώνει το παράθυρο 
Regression όπως αυτό που 
εικονίζεται δίπλα. Στο πεδίο 
Input Y Range εισάγει την 
περιοχή των κελιών όπου 
δίνονται τα δεδομένα της 
συνοχής. Στην περιοχή Input X 
Range προσθέτει την περιοχή 
των δεδομένων του βάθους. Εν 
συνεχεία, τσεκάρει την επιλογή 
Labels αφού το C1 περιέχει τον 
τίτλο «Συνοχή» ενώ το Β1 τον 
τίτλο «Βάθος». Στην επιλογή 

Output Options επιλέγεται New Workbook, ενώ στην περιοχή Residuals 
επιλέγονται τα Residual Plots και Line Fit Plots. Mε ΟΚ ο χρήστης δημιουργεί 
ένα νέο βιβλίο εργασίας του ΕXCEL το οποίο μπορεί να ονομάσει Regression και το 
οποίο παρουσιάζεται στην επόμενη σελίδα. Σε αυτό μπορεί κανείς εύκολα να 
διακρίνει τους συντελεστές γραμμικής παλινδρόμησης, στις περιοχές Β17 και Β18 
καθώς και το συντελεστή προσδιορισμού στην περιοχή Β5. Στο φύλλο εργασίας με 
τα αποτελέσματα της παλινδρόμησης δίνονται επίσης και στοιχεία από τη 
στατιστική ανάλυση των δεδομένων καθώς επίσης και τα διαγράμματα Residual 
Plot, που παριστάνει τη διαφορά μεταξύ των πραγματικών δεδομένων και αυτών 
που προβλέπονται από την παλινδρόμηση, και Line Fit Plot, που παριστάνει σε 
διάγραμμα Συνοχής – Βάθους, τα πραγματικά δεδομένα και την πρόβλεψη της 
παλινδρόμησης. Καταδείχθηκε λοιπόν ότι, με την εφαρμογή Regression του 
εργαλείου Data Analysis μπορεί να γίνει μία ολοκληρωμένη και επισταμένη μελέτη 
γραμμικής παλινδρόμησης. 
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Αποτελέσματα εργαλείου Data Analysis > Regression 

 

ΤΡΙΤΗ ΜΕΘΟΔΟΣ. Με χρήση του χαρακτηριστικού Trend line.  
 
Η μέθοδος αυτή είναι σίγουρα η 
ευκολότερη και περισσότερο 
πρακτική. Με την πρακτική αυτή 
σχεδιάζεται αυτόματα η καμπύλη 
παλινδρόμησης πάνω σε ένα ήδη 
κατασκευασμένο διάγραμμα 
διασποράς (Scatter Diagram), 
ενώ ταυτόχρονα δίνεται και η 
μορφή της εξίσωσής της. Τα 
αποτελέσματα ωστόσο δεν είναι 

άμεσα διαθέσιμα στα φύλλα εργασίας και δεν παρέχονται αρκετές στατιστικές 
πληροφορίες για την ακρίβεια της προσέγγισης, όπως συμβαίνει στην περίπτωση 
της ολοκληρωμένης εφαρμογής Regression από το Data Analysis…Aκόμη το 
χαρακτηριστικό Trend line δεν μπορεί να εφαρμοσθεί για πολλαπλή παλινδρόμηση, 
παρέχει όμως τη δυνατότητα εξεύρεσης προσεγγιστικής σχέσης και πέραν της 
γραμμικής. Στα προηγούμενα εργαστήρια έχει παρουσιασθεί ο τρόπος εφαρμογής 
αυτού του χαρακτηριστικού σε γραφήματα.  Με εφαρμογή της γνωστής μεθόδου 
εισαγωγής μιας γραμμής τάσης σε ένα γράφημα, μπορεί ο χρήστης και για το 
συγκεκριμένο παράδειγμα να πάρει την εικόνα αυτής της παραγράφου.  Μία από 
τις σημαντικότερες δυνατότητες που παρέχει η δυνατότητα εισαγωγής γραμμής 
τάσης σε ένα γράφημα είναι η εισαγωγή σχέσης παλινδρόμησης και εκτός της 
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γραμμικής. Ως παράδειγμα εφαρμογής μη γραμμικής παλινδρόμησης θα εξετασθεί 
ο διορθωτικός συντελεστής των Booker και Davies για τη φέρουσα ικανότητα. Από 
το διάγραμμα των Booker & Davies είναι δυνατόν να συναχθούν οι τιμές που 
εμφανίζονται στο διπλανό πίνακα. Ωστόσο, δεν είναι γνωστή μία αναλυτική σχέση 
που να δίνει το συντελεστή F συναρτήσει του λόγου ρB/c0. Για μεμονωμένες 
περιπτώσεις είναι δυνατόν ο χρήστης να καταφεύγει στο διάγραμμα, αλλά στην 
περίπτωση που θελήσει να αυτοματοποιήσει την εύρεση του διορθωτικού 
συντελεστή μπορεί να αναζητήσει μια μη γραμμική σχέση παλινδρόμησης μεταξύ 
του F και του λόγου ρB/c0 κάνοντας χρήση της δυνατοτήτων του παράθυρου 
εισαγωγής γραμμών τάσεων σε διαγράμματα  Scatter του EXCEL.  

 
Στην εν λόγω περίπτωση, 
αν υποτεθεί ότι η σχέση 
μεταξή F και λόγου ρB/c0 
μπορεί να περιγραφεί 
από ένα πολυώνυμο 
τετάρτου βαθμού, τότε 
μπορεί να προκύψει το 
ακόλουθο διάγραμμα, 

που περιέχει και την επιθυμητή γραμμή τάσης: 
 

y = -6E-06x4 + 0,0004x3 - 0,0088x2 + 0,0962x + 1,0003
R2 = 0,9998

y = 0,0185x + 1,1495
R2 = 0,758

1

1,1

1,2

1,3

1,4

1,5

1,6

0 5 10 15 20
ρΒ/c0

F

 

 
Στην εικόνα φαίνεται το αποτέλεσμα της παλινδρόμησης με πολυώνυμο τετάρτου 
βαθμού όπου R2 = 0,9998 και της γραμμικής παλινδρόμησης με R2 = 0,758. 
Κάνοντας λοιπόν χρήση της δυνατότητας Add Trend Line στάθηκε εφικτό να 
αποκτηθεί μία πάρα πολύ καλή αναλυτική σχέση που περιγράφει το διορθωτικό 
συντελεστή F των Booker & Davies συναρτήσει του λόγου ρΒ/c0.  

 

ρB/c0 F 
0 1 
2 1,16 
4 1,27 
6 1,33 
8 1,37 
10 1,4 
12 1,41 
14 1,42 
16 1,43 
18 1,44 
20 1,45 
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4.6 TETΑΡΤΗ ΕΝΟΤΗΤΑ ΕΦΑΡΜΟΓΩΝ – ΕΙΣΑΓΩΓΗ ΣTON 

ΠΡΟΓΡΑΜΜΑΤΙΣΜΟ ΓΙΑ ΜΑΚΡΟΕΝΤΟΛΕΣ ΚΑΙ ΠΡΟΣΑΡΜΟΣΜΕΝΕΣ 

ΣΥΝΑΡΤΗΣΕΙΣ ΣΤΟ EXCEL 

4.6.1 Αντικειμενικός στόχος ενότητας 

Ο αντικειμενικός στόχος της τέταρτης και τελευταίας ενότητας εφαρμογών 
είναι μια εισαγωγή σε ένα πλήθος δυνατοτήτων επέκτασης των εφαρμογών του 
MS EXCEL που υλοποιούνται εξαιτίας της πανίσχυρης γλώσσας προγραμματισμού 
που κρύβεται πίσω από αυτό και που δεν είναι άλλη από τη γνωστή VBA (Visual 
Basic for Applications). H VBA είναι αναμφισβήτητα μία γλώσσα που μπορεί να 
φανεί χρήσιμη σε πολλές περιπτώσεις, οι βασικότεροι λόγοι όμως που οδηγούν 
κάποιον στη χρήση της είναι: 
  

Α. Η καταγραφή και χρήση μακροεντολών. 
 Β. Η δημιουργία προσαρμοσμένων συναρτήσεων.  
 Γ. Η ανάπτυξη ολοκληρωμένων εφαρμογών. 
 
 Στην παρούσα τελευταία ενότητα θα συζητηθούν οι περιπτώσεις Α και Β. Η 
εξέταση της περίπτωσης Γ ξεφεύγει από τα πλαίσια αυτής της παρουσίασης. 
 

4.6.2 Μακροεντολές 

ΑΠΑΙΤΟΥΜΕΝΕΣ ΓΝΩΣΕΙΣ ΣΤΟ MS EXCEL. Μία μακροεντολή δεν είναι παρά μία 
σειρά απλών εντολών του Excel, οι οποίες ομαδοποιούνται και αποθηκεύονται για 
μετέπειτα χρήση. Η χρησιμότητα των μακροεντολών βρίσκεται στην 
αυτοματοποίηση καθημερινών, επαναλαμβανόμενων ενεργειών. Συχνά 
εμφανίζεται η ανάγκη επαναληπτικής εκτέλεσης κάποιων ενεργειών, όπως για 
παράδειγμα μίας σύνθετης μορφοποίησης ενός τίτλου. Στην περίπτωση που οι 
ενέργειες αυτές καταγραφούν και αποθηκευθούν με τη μορφή μιας μακροεντολής, 
είναι δυνατή η επαναληπτική εφαρμογή τους στο ίδιο ή σε διαφορετικά φύλλα 
εργασίας.  
 
Δημιουργία Μακροεντολών. Για τη δημίουργια μιας μακροεντολής, ο χρήστης 
ακολουθεί τα εξής βήματα. Από το βασικό μενού επιλέγει Tools > Macro > Record 
New Macro… : 
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οπότε λαμβάνει το παρακάτω παράθυρο: 
 
Σε αυτό το εισαγωγικό παράθυρο, ο χρήστης 
εισάγει το όνομα της μακροεντολής που θα 
κατασκευάσει (θα καταγράψει) στο πεδίο Macro 
Name. Στο πεδίο Shortcut key, έχει τη 
δυνατότητα να ορίσει ένα πλήκτρο συντόμευσης 

για την εκτέλεση της 
μακροεντολής που είναι 
πάντα της μορφής Ctrl + 
κάποιο πλήκτρο. Από τη 
λίστα Store macro in: έχει 
τη δυνατότητα να 
αποθηκεύσει τη 
μακροεντολή του είτε στο 
παρόν βιβλίο εργασίας (This 
workbook), είτε σε ένα 
καινούριο (New Workbook) 
είτε στο προσωπικό βιβλίο 
εργασίας μακροεντολών 
του.  
 



ΚΕΦΑΛΑΙΟ 6: Εφαρμογές λογιστικών Φύλλων στην Υδρολογία                          

 

104 

Αφού έχει ορίσει τις παραπάνω παραμέτρους ο χρήστης επιστρέφει με ΟΚ στο 
φύλλο εργασίας του όπου και βλέπει τη διπλανή εικόνα. Στο φύλλο έχει 
εμφανισθεί ένα μικρό παράθυρο, το οποίο περιέχει την εντολή Stop recording και 
η εντολή Relative Reference. Στο σημείο αυτό ο χρήστης εκτελεί το πλήθος των 
εντολών στο MS EXCEL, που θέλει να συγκροτήσει σε μία μακροεντολή ώστε να 
μπορεί μετά να τις αναπαράγει κατ’ ευθείαν εκτελώντας τη μακροεντολή. Αφού 
εκτελέσει όλες τις εντολές ο χρήστης καταγράφοντάς τες στη μακροεντολή με 
Stop Recording σταματά και αποθηκεύει τη μακροεντολή. H εντολή Relative 
Reference, αναφέρεται στην επιλογή των κελιών κατά τη διάρκεια καταγραφής της 
μακροεντολής και συγκεκριμένα στο αν αυτή θα είναι απόλυτη ή σχετική.  
  

Εκτέλεση Μακροεντολής. Με την 
τεχνική που περιγράφηκε στην 
προηγούμενη παράγραφο είδαμε πώς 
είναι δυνατόν να καταγραφεί μία 
μακροεντολή. Για την εκτέλεση της 
μακροεντολής μπορεί να 
χρησιμοποιηθεί το πλήκτρο 
συντόμευσης, υπάρχει όμως και ένα 
συγκεντρωτικό παράθυρο διαχείρισης 
των μακροεντολών που εμφανίζεται 
από Tools > Macro > Macros… :  
Στο παράθυρο αυτό περιέχονται όλες 

οι μακροεντολές που έχει καταγράψει ο χρήστης. Επιλέγοντας μία μακροεντολή, ο 
χρήστης μπορεί: 

 
 
 
 
 
 
 
 
 

 
 
 
 

Α) Να την τρέξει με την εντολή Run. 
Β) Να γυρίσει στο φύλλο εργασίας με Cancel. 
Γ) Να δει τον κώδικα της μακροεντολής σε VBA και πιθανόν να τον τροποποιήσει 
με τις εντολές Step Into και Edit. 
Δ) Να διαγράψει μία μακροεντολή με Delete. 
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Ε) Να δει και πιθανόν να αλλάξει τις ιδιότητες μίας μακροεντολής με Options…που 
ανοίγει το διπλανό παράθυρο. 
 

Ανάθεση Μακροεντολής. Οι μακροεντολές που χρησιμοποιούνται συχνά 
μπορούν να ανατεθούν σε ένα κουμπί οποιασδήποτε γραμμής εργαλείων ή στην 
επιλογή κάποιου μενού. Η δημιουργία ενός κουμπιού σε μία γραμμή εργαλείων και 
η ανάθεση σε αυτό μιας μακροεντολής, γίνεται με τα παρακάτω βήματα: 
• Από το μενού View επιλέγεται η εντολή Toolbars και στη συνέχεια η 
υποεντολή Customize, οπότε εμφανίζεται το διπλανό παράθυρο:  
• Στο παράθυρο αυτό επιλέγεται η καρτέλα Commands και στη λίστα 
Categories η επιλογή Macros. Στο παράθυρο Commands επιλέγεται το Custom 
Button. Αυτό θα είναι το κουμπί στο οποίο θα ανατεθεί η μακροεντολή. Έχοντας 
επιλέξει Custom Button, ο χρήστης σύρει (δηλαδή μετακινεί έχοντας το αριστερό 
κλικ του ποντικιού πατημένο) το εικονίδιο (τη γελαστή φατσούλα) στην 
εργαλειομπάρα όπου θέλει να τοποθετήσει το εικονίδιο και στη συνέχεια κάνει δεξί 
κλίκ πάνω στο εικονίδιο εμφανίζει το παρακάτω μενού: Σε αυτό μπορεί να 
διαμορφώσει όπως θέλει το κουμπί της συντόμευσης, το σημαντικό όμως είναι ότι 
μπορεί να αναθέσει την επιθυμητή μακροεντολή επιλέγοντας Assign Macro και το 
όνομα της μακροεντολής. 

 
 
 
 
 
 
 
 
 
 
 
 
Με παρόμοιο τρόπο μπορεί να γίνει και ανάθεση 
της μακροεντολής σε κάποιο μενού. Τα 
παραπάνω θα γίνουν περισσότερο κατανοητά 
μέσω ενός παραδείγματος.  
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ΕΚΦΩΝΗΣΗ. Να καταγραφεί μία μακροεντολή στο πρόγραμμα της 
εφαρμογής 1 έτσι ώστε όταν εισάγονται αρνητικές τιμές στα μεγέθη Β, L, c και Df 
το κελί να βγάζει το μήνυμα “error”. Η μακροεντολή να ανατεθεί σε κατάλληλο 
κουμπί στη βασική γραμμή εργαλείων. 
 

ΕΠΙΛΥΣΗ.  Ο χρήστης ανοίγει το αρχείο εφαρμογή1 και το σώζει με το 
όνομα efarmogi4. Ανοίγοντας το πρώτο φύλλο εργασίας, βρίσκει τα εξής 
δεδομένα: 
 

 
 
Ο χρήστης επιλέγει το κελί C9 και στη συνέχεια επιλέγει Tools > Record New 
Macro…και στο παράθυρο διαλόγου που εμφανίζεται συμπληρώνει τα παρακάτω 

στοιχεία: 
Στην περιοχή Macro Name εισάγεται 
ErrorNegative. Ως πλήκτρο 
συντόμευσης επιλέγει Ctrl + e. 
Αποθηκεύει τη μακροεντολή στο ίδιο 
βιβλίο εργασίας και εισάγει ένα σχόλιο 
για τη εργασία που επιτελεί η 
μακροεντολή. Επιλέγοντας ΟΚ, 
επιστρέφει στο φύλλο εργασίας και 
καταγράφει τα βήματα που θα 
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περιλαμβάνει η μακροεντολή. Αυτά είναι τα ακόλουθα:  
• Με επιλεγμένο το κελί C9 επιλέγεται Data > Validation και ανοίγει το 
παρακάτω παράθυρο: 
 

Στην καρτέλα Settings συμπληρώνει: στην περιοχή Allow  Whole Number, Data 
 Greater Than Equal to, Minimum  0. Στην καρτέλα Error Alert συμπληρώνει 

τα ακόλουθα: Τσεκάρει την επιλογή Show error alert after invalid data is entered, 
Στο πεδίο Style επιλέγει Stop, στον τίτλο γράφει “You gave a negative value” και 
στο πεδίο “Error message” συμπληρώνει “Error”. Με ΟΚ κλείνει το παράθυρο 
διαλόγου και επιστρέφοντας επιλέγει Stop Recording για να σταματήσει την 
καταγραφή της μακροεντολής. Στη συνέχεια αναθέτει τη μακροεντολή αυτή σε ένα 
κουμπί με τη διαδικασία που περιγράφηκε παραπάνω. Έτσι επιλέγεται το εικονίδιο 
με το καμπανάκι, τοποθετείται στη γραμμή εργαλείων μορφοποίησης και στη 
συνέχεια, με δεξί κλικ του δίνεται το όνομα ErrorNegative και του ανατίθεται η 
εκτέλεση της μακροεντολής ErrorNegative από την επιλογή Assign Macro… 
 

 
 
H εφαρμογή ολοκληρώνεται επιλέγοντας την περιοχή C9:H11 και πατώντας το 
κουμπί ErrorNegative. Ομοιώς και την περιοχή C13:H13 και πατώντας το κουμπί 
ErrorNegative.  
 
Ο χρήστης εφαρμόζοντας τις δυνατότητες που παρέχουν οι μακροεντολές 
κατάφερε να διαμορφώσει ένα μόνο κελί και να αυτοματοποιήσει τη διαδικασία και 
για τη διαμόρφωση  και των υπολοίπων περιοχών κελιών.  
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ΠΑΡΑΤΗΡΗΣΗ. Η εντολή Data > Validate μπορεί να εφαρμοσθεί και σε περιοχές 
κελιών, και όχι σε μόνο σε ένα κελί, αλλά πρέπει να εκτελεσθεί για κάθε περιοχή 
κελιών ξεχωριστά. 
 

4.6.3  Προσαρμοσμένες συναρτήσεις 

 Αν και το MS EXCEL διαθέτει πληθώρα ενσωματωμένων συναρτήσεων, είναι 
πιθανό σε κάποια ειδική περίπτωση να απαιτείται μία συνάρτηση που δεν υπάρχει. 
Οι συναρτήσεις που δημιουργούνται από το χρήστη ονομάζονται προσαρμοσμένες 
συναρτήσεις. Οι προσαρμοσμένες συναρτήσεις, όπως και οι ενσωματωμένες στο 
MS EXCEL συναρτήσεις, δέχονται ορίσματα, εκτελούν υπολογισμούς και 
επιστρέφουν μία τιμή. Από τη στιγμή που μία προσαρμοσμένη συνάρτηση 
δημιουργηθεί και αποθηκευθεί, μπορεί να χρησιμοποιηθεί με τον ίδιο ακριβώς 
τρόπο που χρησιμοποιούνται και οι ενσωματωμένες συναρτήσεις.  
 
Δημιουργία προσαρμοσμένης συνάρτησης. Για τη δημιουργία της συνάρτησης 
ακολουθούνται τα παρακάτω βήματα: 
  1. Από το μενού Tools > Macro > Visual Basic Editor. Με την 
εντολή αυτή εισαγόμαστε στο περιβάλλον της Visual Basic for Applications, της 

γλώσσας 
προγραμματισμού που 
βρίσκεται πίσω από το 
MS EXCEL. Επιλέγοντας 
το κουμπί Project 
Explorer λαμβάνουμε 
την παρακάτω εικόνα: 
Η τοποθέτηση του 
κώδικα για τις 

προσαρμοσμένες 
συναρτήσεις γίνεται 
στην περιοχή Module 

(κανονική λειτουργική μονάδα). Αυτό είναι πολύ σημαντικό. Αν τοποθετήσετε τις 
προσαρμοσμένες συναρτήσεις σας σε μία λειτουργική μονάδα για το Sheet ή για το 
Workbook, δε θα λειτουργούν στους τύπους σας. Κάνοντας κλικ στο Module1 
εισαγόμαστε στην περιοχή κώδικα της κανονικής λειτουργικής μονάδας. Σε αυτόν 
βρίσκουμε ήδη τον κώδικα όλων των μακροεντολών που είναι καταγεγραμμένες 
στο βιβλίο εργασίας μας: 
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Στην περιοχή κώδικα βλέπουμε ήδη τον κώδικα της μακροεντολής ErrorNegative. 
 
Θα μελετηθεί το παράδειγμα της σχεσης που δίνει το συντελεστή Νc συναρτήσει 
της γωνίας τριβής του εδάφους φ [ο]. 
 
Για να εισαγάγουμε μία προσαρμοσμένη συνάρτηση επιλέγουμε στο περιβάλλον 
της VBA: Insert > Procedure λαμβάνοντας το ακόλουθο παράθυρο διαγόγου: 

 
Σε αυτό ορίζουμε το όνομα της 
προσαρμοσμένης συνάρτησης στο πεδίο 
Name. Στο πεδίο Τype επιλέγουμε 
Function, που σημαίνει ότι η διαδικασία 
μας θα είναι προσαρμοσμένη συνάρτηση. 
Στο πεδίο Scope, εισάγεται η επιλογή 
Public, έτσι ώστε η συνάρτηση να είναι 
ενεργή και διαθέσιμη σε όλα τα φύλλα 
εργασίας μας.  
Με ΟΚ επιστρέφουμε στην περιοχή κώδικα 
της λειτουργικής μονάδας μας και 
εισάγουμε τον παρακάτω κώδικα για τη 
δημιουργία της συνάρτησης ΝC: 
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1 Public Function NC(x) 

2  If x > 0 Then 

3  NQ = Tan(3.14159 / 4 + (x * 3.14159 / 180) / 2) * Exp(3.14159 * Tan(x * 

3.14159 / 180)) 

4  NC = 1/tan(x * 3.14159 / 180)*(NQ – 1) 

5  ElseIf x = 0 Then 

6  NC = 5.14 

7  ElseIf x < 0 Then 

8  NC = "error" 

9  End If 

10 End Function 

 

οπότε το παράθυρο του κώδικά μας διαμορφώνεται όπως στην εικόνα της 
επόμενης σελίδας.  Αξίζει να εξετάσουμε εν συντομία τη δομή που διέπει τον 
κώδικα μίας προσαρμοσμένης συνάρτησης. Η σύνταξη για τη δήλωση μίας 
συνάρτησης είναι η εξής: 
 
[Public/Private] [Static] Function name ([arglist]) [As type] 

[name = expression] 

[Exit Function] 

[Instructions] 

[name = expression] 

End Function 

 
H παραπάνω σύνταξη επεξηγείται στον ακόλουθο πίνακα: 
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ΣΥΝΤΑΞΗ 

ΛΕΞΗ ΚΛΕΙΔΙ ή 

ΟΡΙΣΜΟΣ ΑΠΟ 

ΧΡΗΣΤΗ 

ΕΠΕΞΗΓΗΣΗ 

Public Λέξη κλειδί VBA Προαιρετικό. Δηλώνει ότι η διαδικασία Function 

είναι προσπελάσιμη σε όλες τις διαδικασίες σε 

όλες τις άλλες λειτουργικές μονάδες σε όλες 

τις ενεργές εργασίες Εxcel. 

Private Λέξη κλειδί VBA Προαιρετικό. Δηλώνει ότι η διαδικασία Function 

είναι προσπελάσιμη μόνο στις άλλες 

διαδικασίες της ίδιας λειτουργικής μονάδας. 

Μια Function μπορεί να είναι ή Public ή Private.  

Static Λέξη κλειδί VBA Προαιρετικό. Δηλώνει ότι οι τιμές των 

μεταβλητών που δηλώνονται στη διαδικασία 

Function διατηρούνται μεταξύ των κλήσεων. 

Function Λέξη κλειδί VBA Υποχρεωτικό. Είναι η λέξη κλειδί που δηλώνει 

ότι ο κώδικας που καταγράφεται αναφέρεται σε 

προσαρμοσμένη συνάρτηση.  

Name Ορισμός χρήστη Υποχρεωτικό. Είναι το εκάστοτε όνομα που 

δίνει ο χρήστης στη συνάρτηση που 

δημιουργεί. Στο παράδειγμα NC το όνομα της 

συνάρτησης είναι NC.Τα ονόματα 

συναρτήσεων δεν πρέπει να έχουν τη μορφή 

ονομάτων κελιών, π.χ. J21. Στον κώδικα 

πρέπει να υπάρχει οπωσδήποτε και μία γραμμή 

που να ορίζει μία τιμή στο όνομα της 

συνάρτησης. Στο παράδειγμα της συνάρτησης 

NC υπάρχουν τρείς τέτοιες γραμμές: οι 4, 6 και 

8. 

arglist  

(σύντμηση 

του argument 

list) 

Ορισμός χρήστη Προαιρετικό. Αναπαριστά μία λίστα ενός ή 

περισσότερων μεταβλητών που αναπαριστούν 

ορίσματα τα οποία διοχετεύονται στη 

διαδικασία function. Τα ορίσματα 

περιβάλλονται από παρενθέσεις. 

Χρησιμοποιήστε κόμματα για να διαχωρίσετε τα 

ονόματα των ορισμάτων. Στο παράδειγμα NC 

το arglist έιναι το (x)∗ 

As type Ορισμός χρήστη Προαιρετικό. Είναι ο τύπος δεδομένων – 

δηλαδή Τext, Integer, Binary, Single Precision 

 
∗ Εδώ θα εξετασθεί η περίπτωση συναρτήσεων με ένα ή περισσότερα μεμονωμένα ορίσματα. Για 

την περίπτωση προσαρμοσμένων συναρτήσεων με άλλους τύπους ορισμάτων, ο αναγνώστης 
παραπέμπεται στη σχετική βιβλιογραφία. Ενδεικτικά αναφέρεται: Walkenbach, J. “Εγχειρίδιο 
Προγραμματισμού EXCEL 2002 με VBA” Εκδόσεις Γκιούρδας, Αθήνα, 2002, Απόδοση: Χρυσούλα 
Κουτρούμπα, Ηλεκτρ. Μηχανικός. 
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Number κτλ. – που επιστρέφεται από τη 

διαδικσία Function. H λέξη As είναι λέξη – 

κλειδί της γλώσσας VBA. 

instructions Ορισμός χρήστη Προαιρετικό. Είναι οποιοσδήποτε αριθμός 

έγκυρων οδηγιών VBA που απαρτίζουν 

ουσιαστικά το σώμα του κώδικα της 

διαδικασίας. Στο παράδειγμα της συνάρτησης 

NC, γραμμές 2, 3, 5, 7 και 9 είναι instructions.  

Exit Function Λέξη κλειδί VBA Προαιρετικό. Είναι μία πρόταση που αναγκάζει 

σε άμεσο τερματισμό από τη διαδικασία 

Function, πριν την ολοκλήρωση της. Αυτή η 

φράση μπορεί να εμφανίζεται π.χ. στη σύνταξη 

κάποιας εντολής If. 

End Function Λέξη κλειδί VBA Υποχρεωτικό. Είναι μία λέξη κλειδί που 

δηλώνει το τέλος του κώδικα της διαδικασίας 

Function 

 
 Μία πολύ σημαντική παρατήρηση είναι ότι σε μία προσαρμοσμένη συνάρτηση 
γραμμένη σε VBA πρέπει πάντα να εκχωρείται μία τιμή στο όνομά της, τουλάχιστον 
μία φορά, όταν έχει ολοκληρωθεί η εκτέλεσή της.  
 
Ως μία δεύτερη εφαρμογή δίνεται το παρακάτω πρόβλημα.  
 
ΕΚΦΩΝΗΣΗ. Αφού γραφεί μία προσαρμοσμένη συνάρτηση για το διορθωτικό 
συντελεστή Φέρουσας ικανότητας F των Booker & Davies που θα ονομοσθεί 
BOOKDAV να υπολογισθεί ο συντελεστής αυτός για όλους τους συνδυασμούς των 
τιμών : 
 Α) ρ = 5, 10, 15, 20 
 Β) Β = 1, 1.5, 2 
 Γ) c0 = 10, 40 
Παρατήρηση. Να χρησιμοποιηθεί η σχέση που βρέθηκε στην ενότητα εφαρμογών 3 
αλλά με τον πέριορισμό ο λόγος (ρΒ/c0) να είναι μικρότερος του 20. 
 
ΕΠΙΛΥΣΗ. Η σχέση που θα χρησιμοποιηθεί για το διορθωτικό συντελεστή F των 
Booker & Davies είναι η ακόλουθη: 
 
F = -6E-06(ρΒ/c0)4 + 0.0004(ρΒ/c0)3 – 0.0088(ρΒ/c0)2 + 0.0962(ρΒ/c0) + 
1.0003. 
 
 Στο αρχείο efarmogi4 επιλέγουμε Tools > Macro > Visual Basic Editor και 
ανοίγουμε το Module 1 στο Project Explorer. Εκεί επιλέγουμε Insert > Procedure 
…και συμπληρώνουμε το επόμενο παράθυρο διαλόγου: 



ΚΕΦΑΛΑΙΟ 6: Εφαρμογές λογιστικών Φύλλων στην Υδρολογία                          

 

113

 
 
 
 
 
 
Με ΟΚ επιστρέφουμε στον Visual Basic Editor 
και συμπληρώνουμε τον ακόλουθο κώδικα για 
τη συνάρτηση BOOKDAV : 
 
 

 

 

 

1 Public Function BOOKDAV(r, B, c) 

2 ' Ypologizei to diorthwtiko syntelesth twn Booker kai Davies gia times toy 

logoy  rB/c < 20. 

3  If r * B / c > 20 Then 

4  BOOKDAV = "ERROR" 

5  Else: BOOKDAV = -0.000006 * (r * B / c) ^ 4 + 0.0004 * (r * B / c) ^ 3 

- 0.0088 * (r * B / c) ^ 2 + 0.0962 * (r * B / c) + 1.0003 

6  End if 

7 End Function 

 

Στον παραπάνω κώδικα χρησιμοποιήθηκε η εντολή: 
If [υποθετική πρόταση] Then 
[πρόταση] 
Else: [πρόταση] 
 
Επίσης εισήχθησαν κάποια σχόλια στον κώδικα τοποθετώντας στην  αρχή της 
γραμμής την απόστροφο ‘. 
 
Αφού καταγράψουμε το κώδικα επιλέγουμε File > Close and Return to Microsoft 
Excel. Εκεί, δημιουργούμε τον ακόλουθο πίνακα τοποθετώντας στη στήλη Α τον 
αύξοντα αριθμό της περίπτωσης , στη στήλη Β τις τιμές του ρ, στη στήλη C τις 
τιμές του Β και στη στήλη D, τις τιμές του c δημιουργώντας όλους τους 
συνδυασμούς. Στη στήλη Ε τοποθετείται ο τύπος BOOKDAV. 
‘Eτσι, η τιμή στο κελί Ε2 είναι : BOOKDAV(B2;C2;D2) κ.ο.κ. Δηλαδή, όταν η 
συνάρτηση έχει περισσότερα από ένα ορίσματα αυτά στο EXCEL χωρίζονται με το 
ερωτηματικό ;. Με την εντολή Autofill, συμπληρώνονται και τα υπόλοιπα κελιά. 
Στην επόμενη σελίδα φαίνεται η εικόνα του φύλλου εργασίας με τα τελικά 
αποτελέσματα: 
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Στο πεδίο, που τοποθετείται το περιεχόμενο κάθε κελιού, φαίνεται για το Ε2 η εισαγωγή της 
συνάρτησης bookdav, που υπολογίζει το διορθωτικό συντελεστη F της φέρουσας ικανότητας. 

4.6.4 Συμπεράσματα 

 Με τα προηγούμενα παραδείγματα παρουσιάσθηκαν ορισμένες προχωρημένες ιδιότητες του 
MS EXCEL, που αγγίζουν τα όρια του κλασσικού προγραμματισμού. Το EXCEL μπορεί να αποδειχθεί 
όντως ένα πολύ ισχυρο προγραμματιστικό εργαλείο, αν ο χρήστης κάνει χρήση αυτών των 
προχωρημένων δυνατοτήτων και μάθει να χρησιμοποιεί και τη γλώσσα που κρύβεται πίσω από αυτές, 
που δεν είναι άλλη από τη Visual Basic for Applications. 
 Απώτατος στόχος αυτών των σημειώσεων είναι να προτρέψει εν τέλει το φοιτητή όχι μόνο να 
χρησιμοποιήσει το MS EXCEL για τα προβλήματα που θα του θέσει στο μέλλον η επιστήμη του 
Πολιτικού Μηχανικού σε όλο της το φάσμα, αλλά και να του δώσει το έναυσμα για προσωπική μελέτη 
και εμβάθυνση σε αυτό το πανίσχυρο εργαλείο. Η βιβλιογραφία που δίνεται στην επόμενη σελίδα είναι 
το τελευταίο αλλά σπουδαιότερο κομμάτι αυτών των σημειώσεων, εκφράζοντας την ελπίδα ότι ο 
φοιτητής θα την αναζητήαει και θα επεκτείνει τις γνώσεις του. 
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ΚΕΦΑΛΑΙΟ  5 
 
Εφαρμογές λογιστικών φύλλων στη Στατική: 
Γεωμετρικά μεγέθη πολυγωνικά περικλειώμενων 
διατομών 

Α. Σέξτος, Λέκτορας Α.Π.Θ., 
Δ. Ταλασλίδης, Καθηγητής Α.Π.Θ. 
Η. Παρασκευόπουλος, Υπ. Διδ. 

 
5.1 ΑΝΑΓΚΑΙΟΤΗΤΑ 
 
Για τον υπολογισμό της έντασης των δομικών στοιχείων είναι απαραίτητος ο 
υπολογισμός των γεωμετρικών μεγεθών των διατομών 
 

 
 
Α, Ιxx = f(διατομής, x,y) 
 

ΝΝ

σσ = = ΝΝ//ΑΑ

σσ

σσ

σσ = = ΜΜy / y / IIxxxx

--σσ ((θλίψηθλίψη))

++σσ ((εφελκυσμόςεφελκυσμός))

ΝΝ

σσ = = ΝΝ//ΑΑ

σσ

σσ

σσ = = ΜΜy / y / IIxxxx

--σσ ((θλίψηθλίψη))

++σσ ((εφελκυσμόςεφελκυσμός))   
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5.2 ΠΕΔΙΟ ΕΦΑΡΜΟΓΗΣ ΣΤΟΝ ΥΠΟΛΟΓΙΣΜΟ ΚΑΤΑΣΚΕΥΩΝ 
 
Α) Κτηριακά έργα: 
Ο υπολογισμός για συνήθεις διατομές πραγματοποιείται:  
 - με χρήση πινάκων 
 - με χρήση τύπων  
 - συχνά εγγενώς από τα στατικά προγράμματα 
 

 
 
Β) Γεφυροποιία 
 
Σε περιπτώσεις πολύπλοκων διατομών (π.χ. Κυψελοειδείς διατομές γεφυρών) ο 
υπολογισμός των γεωμετρικών μεγεθών δεν μπορεί να πραγματοποιηθεί μέσω 
πινάκων ή τύπων αλλά ούτε και στη μεγάλη πλειοψηφία τους εγγενώς από τα στατικά 
προγράμματα. 
 
 
 
 
 
 
 
 
 
 
 

 

  

Γέφυρα ΚρυσταλλοπηγήςΓέφυρα Κρυσταλλοπηγής
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5.3 Μεθοδος υπολογισμου 
 

π.χ. ( ) ( )[ ]{ }∑∫∫
=

++++ −+−==
n

i
iiiiiiiixx yyyyyxyxdydxyJ

1
1

2
111

2

12
1

 

 
 Απαιτείται επαναλληπτική διαδικασία 

 Do i=1,N 
 (ΓΜ(νέα τιμή) = ΓΜ(παλαιά τιμή) + xiyi+1 

 Με τη χρήση του excel η διαδικασία αυτή πραγματοποιείται μέσω πινάκων 
 Απαιτείται σωστή αρίθμηση της διατομής 

 
Α) Διαχωρισμός σε επιμέρους ευθύγραμμα τμήματα και αρίθμηση 
 

 Εξωτερική αρίθμηση (αντίστροφα της φοράς των δεικτών του ρολογιού) 
 Νοητή τομή 
 Εσωτερική αρίθμηση (σύμφωνα με τη φορά των δεικτών του ρολογιού)  
 Διπλή αρίθμηση 

 

+

η

4

1 2

3

x

ξ

yy

xx

y

s

s

φ

s

s

+
x

y 4

1

11

9

2

8

10 5 6
7

3

ξ

η

 
      
         Σχήμα 1     Σχήμα 2 
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 Διατομή συμπαγής 
 

 

 

 

 

 

 

 

 Διατομή με οπή (κοίλη) 
 

 

 

 

 

 

 

 

 
Β) Τυπολόγιο 

 

Εμβαδόν 

 

( )∑∫∫
=

++ −==
n

i
iiii yxyxdydxA

1
112

1
 (1) 

 

Στατικές ροπές 

 

( ) ( )[ ]∑∫∫
=

+++ +−==
n

i
iiiiiix yyyxyxdydxyS

1
1116

1
 (2) 

 

( ) ( )[ ]∑∫∫
=

+++ +−==
n

i
iiiiiiy xxyxyxdydxxS

1
1116

1
 (3) 

 

 

 

 

+

1

3

2x
y ++

1

3

2x
y

x
y

 

+

+

3

2

1
64

5

7

ΝοητήΝοητή τομήτομή

ΔιπλήΔιπλή αρίθμησηαρίθμηση

++

+

3

2

1
64

5

7

ΝοητήΝοητή τομήτομή

ΔιπλήΔιπλή αρίθμησηαρίθμηση
 

8 
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Ροπές αδράνειας 

 

( ) ( )[ ]{ }∑∫∫
=

++++ −+−==
n

i
iiiiiiiixx yyyyyxyxdydxyJ

1
1

2
111

2

12
1

 (4) 

 

( ) ( )[ ]{ }∑∫∫
=

++++ −+−==
n

i
iiiiiiiiyy xxxxyxyxdydxxJ

1
1

2
111

2

12
1

 (5) 

 

Φυγόκεντρη ροπή αδράνειας (γινόμενο αδράνειας) 

 

( ) ( ) ( ) ( )∑

∫∫

=
++++++

⎭
⎬
⎫

⎩
⎨
⎧

⎥⎦
⎤

⎢⎣
⎡ +−++−=

==

n

i
iiiiiiiiiiii

xy

yxyxyyxxyxyx

dydxxyJ

1
111111 2

1
12
1

 (6) 

 
Θέση των κεντροβαρικών αξόνων ss yx ,  

 

A
S

y
A
S

x x
s

y
s == ,  (7α, β) 

 

Θεώρημα του Steiner 

 

ssxyxyssyyyssxxxs yxAJJxAJJyAJJ −=−=−= ,, 22  (8a-c) 

 

Κύριοι άξονες αδράνειας 

 

( ) ,
2

2tan 0
xsys

xys

IJ
J

t
−

== ϕ  

,tan
2
1

0 tarc=ϕ  

( ) ,
2
1

1 ysxs JJA +=  

( ) ( ) ( )002 2sin2cos
2
1 ϕϕ xysysxs JJJA −−=  
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Μεγίστη και ελαχίστη ροπή αδράνειας 

 

2121 min,max AAJJAAJJ −==+== ηξ  

 

 

 

 

 

 

 

 

 

Διεύθυνση κυρίων αξόνων 

 
ϕ : γωνία στροφής ως προς τον άξονα sx  

 
 ysxs JJ <  ysxs JJ =  ysxs JJ >  

xysJ  0<  0=  0>  0<  0=  0>  0<  0=  0>  

t  0<  0=  0>  ""∞−  0/0  ""∞+  0>  0=  0<  

0ϕ  0<  0=  0>  045−  *) 045+  0>  0=  0<  
ϕ  0

0 90+ϕ  090  
0

0 90−ϕ  045+   045−  0ϕ  0=  0ϕ  

Περίπτωσ
η 

)1(a  )2(b  )3(c  )4(d  )5(  )6(e  )7(f  )8(g  )9(h  

 
*) Απροσδιόριστη περίπτωση (επιφάνεια είναι τετράγωνο, οκτάγωνο κ.τ.λ. ή 
κύκλος). 
 
 
Γ) Παραδείγματα 
 

+

η

4

1 2
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x

ξ

yy
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φ

s

s
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( ) ( )( ) ( )

( )

( )

( )

( ) ,
2
1

2
1

2
1

2
1

12
1

2
1

12
1

4114414141

3443343434

2332232323

1221121212

1

⎭
⎬
⎫

⎥⎦
⎤

⎢⎣
⎡ +−+

⎥⎦
⎤

⎢⎣
⎡ +−+

⎥⎦
⎤

⎢⎣
⎡ +−+

⎩
⎨
⎧

⎥⎦
⎤

⎢⎣
⎡ +−=

⎥⎦
⎤

⎢⎣
⎡ +−++−=

=

∑

∫

=

yxyxYXYX

yxyxYXYX

yxyxYXYX

yxyxYXYX

yxyxyyxxyxyx

dydxxy

ijjijiji

n

i
ijji

 

 
όπου: 1+= ij  

 

ijjiij yxyxYX −= ,  ,jiij xxX +=    jiij yyY += ,   1141 xxxn ≡= ++ ,  11 yyn =+            

 
ΠΑΡΑΡΤΗΜΑ  A:    Απόδειξη των τύπων  (1) έως (6)  
 
1)  Θεώρημα Green  (Green’s theorem)  

(μπορεί επίσης να χρησιμοποιηθεί η πρόταση ολοκλήρωσης Gauss) 
 
a) 
 

dyQdxPdydx
y
P

x
Q

CR

+=⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
∂
∂

−
∂
∂

∫∫∫  

 
 

 
 
 
 

y 
C 

+ 

R 

x 

+ 
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b) Διάσπαση περιοχής R  σε επιμέρους περιοχές iR  με σύνορα iC  

x

y

R R

R

31

2

 
 

( ) ( ) ( ) dydxdydx
y
P

x
QdyQdxP

C R RC
∫ ∫∫ ∫∫∫ ++⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
∂
∂

−
∂
∂

=+++
3 1 31

…………  

 
 

( )∫ ∫∫ ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
∂
∂

−
∂
∂

=+
C R

dydx
y
P

x
QdyQdxP  

 

x

y

c1

R
τοµή

c2

 
c) 
 

( ) ( )∫ ∫ ∫∫ ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
∂
∂

−
∂
∂

=+++
1 2C C R

dydx
y
P

x
QdyQdxPdyQdxP  

 
 
2)  Παράδειγμα dydxx∫∫  

+ 
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( ) 0=−∑ ij xx  

 
 

( ) 022 =−∑ iijj yxyx  

 
 

1+= ij  

 
5.4  ΥΠΟΛΟΓΙΣΜΟΣ ΓΕΩΜΕΤΡΙΚΩΝ ΜΕΓΕΘΩΝ ΔΙΑΤΟΜΗΣ ΜΕ ΤΟ 
ΠΡΟΓΡΑΜΜΑ  EXCEL 2002 
 
ΠΑΡΑΔΕΙΓΜΑ  1 

+

η

4

1 2

3

x

ξ

yy

xx

y

s

s

φ

s

s

 
Βηματική ροή 
 
1. Δίδονται: 
 
α) αρίθμηση κόμβων (βλ. πρώτη στήλη Α) 

b) συντεταγμένες ix  των κόμβων (βλ. δεύτερη στήλη Β) 

c) συντεταγμένες iy  των κόμβων (βλ. τρίτη στήλη C) 

 
Προσοχή:      1ˆ51,4 ==+= nn   (βλ. 7η σειρά) 

 
 
2. Υπολογισμός βοηθητικών μεγεθών (στήλες 61÷ ): 

 
a) Μεγέθη 1+⋅ ii yx  (στήλη αρ. 1-D) 

 
Διαδικασία:  • για το μέγεθος 21 yx ⋅  

  • εισαγωγή του τύπου 4*3 CB=  στο κελί 3D  
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 • για τα υπόλοιπα μεγέθη :,, 144332 yxyxyx ⋅⋅⋅  

αντιγραφή των υπολοίπων τύπων της στήλης με AUTOFILL: 
AUTOFILL: 
Εισάγουμε τον τύπο στο πρώτο κελί. Επιλέγουμε το κελί. 
Το ενεργό κελί έχει ένα μαύρο τετράγωνο (fill handle) στην κάτω δεξιά 
γωνία. Τοποθετούμε το βέλος του δείκτη στο τετράγωνο. Το βέλος 
παίρνει τη μορφή σταυρού. Πατήστε το αριστερό πλήκτρο και σύρατε το 
ποντίκι μέχρι και τον κόμβο 1+n  

 
b) Μεγέθη ii yx 1+  (στήλη αρ. 2-Ε) 

 
Διαδικασία:  • εισαγωγή του τύπου 3*4 CB=   

  • με AUTOFILL συμπληρώνουμε τη στήλη 2 
 
c) Μεγέθη ii xx ++1  ( )ii yy ++1  στη στήλη αρ. 3(4) ή )(GF  

 
Διαδικασία:  • εισαγωγή τύπου ( )3434 CCBB +=+=   

  • Autofill  
 
d) Μεγέθη 1+⋅ ii xx  ( )1+⋅ ii yy  στη στήλη αρ. 5(6) ή )(IH  

 
Διαδικασία:  • εισαγωγή τύπου 

  • Autofill  
 

3. Bοηθητικά μεγέθη: 
πράξεις μεταξύ στηλών και αθροίσματα 

 
a) Μεγέθη iiii yxyx 11 ++ −  και άθροισμα (στήλη 7 =στήλη 1 –στήλη 2 και Σ) 

 
Διαδικασία:   

• εισάγουμε τον τύπο 33 ED −=  στο κελί 3J  

• με Autofill συμπληρώνουμε τη στήλη 7 

• για να αθροίσουμε τα μεγέθη της στήλης: 
AUTOSUM: 
• επιλέγουμε το κελί που θέλουμε να εμφανισθεί το άθροισμα (εδώ )17J  

• από το Menu επιλέγουμε το Σ (AUΤOSUM) 
• εμφανίζεται στο 17J  ο τύπος π.χ. )3:1( JJSUM=  

• εάν τα όρια δεν είναι τα σωστά, πατήστε το πλήκτρο και σύρατε το 
ποντίκι πάνω από τα κελιά που θέλετε να αθροίσετε. 

             • ENTER  ή #  
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b) Μεγέθη ( ) ( )iiiiii yyyxyx +⋅− +++ 111  και άθροισμα 

στήλη 8 =στήλη 7∗  στήλη 4 και Σ 
 
Διαδικασία:    
 • εισάγουμε τον τύπο  3*3 GJ=  

 • AUTOFILL 

 • AUTOSUM   

    στο κελί 17K : 

 ( ) ( ) ( )16:3111 KKSUMyyyxyx iiiiii =+−∑ +++  

 
c) Μεγέθη ( ) ( )iiiiii xxyxyx +− +++ 111  και άθροισμα: 

στήλη 9 =στήλη 7∗  στήλη 3  και Σ 
 
Διαδικασία:    
 • τύπος  3*3 FJ=  

 • βλέπε περίπτωση  (b) 
 

d) Μεγέθη ( ) ( )[ ]iiiiiiii yyyyyxyx ⋅−+− ++++ 1
2

111  και άθροισμα: 

στήλη 10 =στήλη 7∗  [(στήλη 4)2 – στήλη 6]   και Σ 
 
Διαδικασία:   
 • τύπος  ( )32^3*3 IGJ −=  

 • AUTOFILL 

 • AUTOSUM    

    στο ( )16:3:17 MMSUMM =  

 

e) Μεγέθη ( ) ( )[ ]iiiiiiii xxxxyxyx ⋅−+− ++++ 1
2

111  

 
Διαδικασία:    
 • τύπος  ( )32^3*3 HFJ −=  

 • βλέπε περίπτωση ( d ) 

 
4. Υπολογισμός γεωμετρικών μεγεθών διατομής 
 

a) Εμβαδόν:    17*21 JA =  ( )24B  

 
b) Στατικές ροπές:    17*61 KSx =  ( )24C  

 17*61 LSy =  ( )24D  
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c) Συντεταγμένες κέντρου βάρους:    2424 BDxs =  ( )24E  

            2424 BCys =  ( )24F  

 
d) Ροπές αδράνειας:    17*121 MJ xx =  ( )24G  

        17*121 NJ yy =  ( )24H  

        17*121 OJ xy =  ( )24I  

 
e) Κεντροβαρικές ροπές αδρανείας: 

    2^24*2424 FBGJ xs −=   

        2^24*2424 EBHJ ys −=  

        24*24*2424 EFBIJ xys −=  

 
5. Κύριες ροπές αδράνειας: 
 

2424
2422
JK

L
JJ

J
t

xsys

xys

−
=

−
=  

 
t        =IF(ABS(K24-J24)>0;2*L24/(K24-J24)) 

 
 

tarc tan
2
1

0 =ϕ  

 

0ϕ     =IF(ABS(J24-K24)>0;1/2*ATAN(N23)*180/3,14159) 

( Μετατροπή reesradians deg→ ) 

 

( )ysxs JJA +=
2
1

1  

Α1   =1/2*(J24+K24) 
 

( )"
2
1

2 =A  

A2   = 
IF(ABS(J24-K24)>0;ABS(1/2*(J24-K24)*COS(2*N24*3,14159/180)-        
L24*SIN(2*N24*3,14159/180));ABS(L24)) 

 
 

2625max NNJ +=  

 
2625min NNJ −=  
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Προσδιορισμός της γωνίας στροφής ϕ  

 
a) βοηθητικά μεγέθη 

 
:27N 0000001,0)erance( =TOL  

     true:1 , false:0  

 
 

:29N =IF(ABS(J24-K24)>N27;1;0) 

     :1Log if  TOLJJ ysxs >−   then  )(1 true   else )(0 false    

if  ysxs JJ ≠     -//- 

 
:30N =IF(J24-K24<0;1;0) 

       :2Log if  ( ) 0<− ysxs JJ     then 1 (true) else 0 (false) 

if  ysxs JJ <            -//- 

 
:31N =IF(ABS(L24)>N27;1;0) 

   if  TOLJ xys >  -//- 

   if  0≠xysJ   -//- 

 
:32N  =IF(L24<0;1;0) 

    if  0<xysJ   -//- 

 
Προσοχή:Στα επιμέρους παράθυρα των συναρτήσεων οι διάφορες επιλογές 

χωρίζονται με κόμμα )(,  ενώ εδώ με ερωτηματικό )(;  

 
b) Διάφορες περιπτώσεις 

 
Περίπτωση (1), a  0

0 90+= ϕϕ  9024 +N  

 
=IF (AND(N29;N30;N31;N32);1;0) 
  ΙF ( )( )0,1;4;3;2;1 LLLLAND  

 
Εάν   ysxsysxs JJTOLJJ ≠⇒>−  ασφαλιστική δικλείδα 

    »    ysxsysxs JJJJ <⇒<− 0  

    »    0≠⇒> xysxys JTOLJ  

    »     00 <⇒< xysxys JJ  
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Ερώτηση: γιατί δεν αρκούν μόνο οι ;4,2 LL  

 
Περίπτωση (2),b  090=ϕ  

 
=IF(AND(N29;N30;NOT(N31));1;0) 
  ΙF ( )( )0;1;)3(;2;1 LNOTLLAND  

 

Εάν   ysxsysxs JJTOLJJ ≠⇒>−  

    »    ysxsysxs JJJJ <⇒<− 0  

    »    0=⇒> xys

not

xys JTOLJ  

 
Περίπτωση (3), c  0

0 90−ϕ   ( )9024 −N  

 
=IF(AND(N29;N30;N31;NOT(N32));1;0) 
 
ΙF  ( )( )0;1;)4(;3;2;1 LNOTLLLAND  

 

Εάν   ysxsysxs JJTOLJJ ≠⇒>−  

    »    ysxsysxs JJJJ <⇒<− 0  

    »    0≠⇒> xysxys JTOLJ  

    »     00 >⇒< xysxys JJ  

 
Περίπτωση (4), d  045  

 
=IF(AND(NOT(N29);N31;N32);1;0) 
  ΙF  ( )( )0;1;4;3);1( LLLNOTAND  

 

Εάν   ⇒>− TOLJJ ysxs not  ysxs JJ =  

    »    ⇒> TOLJ xys  0≠xysJ  

    »     ⇒< 0xysJ  0<xysJ  

 
Περίπτωση (5) απροσδιόριστη 

 
=IF(AND(NOT(N29);NOT(N31));1;0) 
 

Εάν   TOLJJ ysxs >− not  ysxs JJ =⇒  
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    »    TOLnotJ xys >   0=⇒ xysJ  

 
Περίπτωση (6), e  045−    

 
=IF(AND(NOT(N29);N31;NOT(N32));1;0) 

 
Εάν   ⇒>− TOLnotJJ ysxs      ysxs JJ =  

    »    ⇒> TOLJ xys 0≠xysJ  

    »     ⇒< 0notJ xys 0>xysJ  

 
Περίπτωση (7), f  240 N== ϕϕ    

 
=IF(AND(N29;NOT(N30);N31;N32);1;0) 

 
;ysxs JJ ≠   ;ysxs JJ >   ;0≠xysJ   0<xysJ  

 
Περίπτωση (8), g  0=ϕ    

 
=IF(AND(N29;NOT(N30);NOT(N31));1;0) 

 
;ysxs JJ ≠   ;ysxs JJ >   ;0=xysJ  

 
Περίπτωση (9), h  0ϕϕ =    

 
=IF(AND(N29;NOT(N30);N31;NOT(N32));1;0) 
 

,ysxs JJ ≠   ,ysxs JJ >   ,0≠xysJ   0>xysJ  

 
Προσδιορισμός της περίπτωσης που ανήκει το παράδειγμα 

=MATCH(1;M35:M43;0) 
 
Γωνία ϕ   (κελί P26 ) 

=CHOOSE(P35;N35;N36;N37;N38;N39;N40;N41;N42;N43) 
 
Περίπτωση (κελί Q26) 
=CHOOSE(P35;O35;O36;O37;O38;O39;O40;O41;O42;O43) 
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ΠΑΡΑΡΤΗΜΑ  Β 
 
1) Μαθηματικές συναρτήσεις  

(Math and Trigonometry functions) 
 
για την επιλογή μιάς συνάρτησης ακολουθούμε (π.χ.) την παρακάτω διαδικασία 
(βλέπε εναλλακτική διαδικασία) 
 
• Πατάμε με το αριστερό πλήκτρο το βέλος δεξιά από το Σ (AUTOSUM) 

 
 
 
 
 
 
 
 
 
 
 

 
 
• Επιλογή: More functions 
 
• Εμφανίζεται INSERT FUNCTION  παράθυρο 
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• Επιλογή Math & Trig, OK 
• Από το παράθυρο Select a function επιλέγουμε π.χ. 
  ABS : |number| 

 
 

 
ATAN :   arc tan  in radians 

 

 
 
COS  
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SIN  

 

 
 
 
2) Λογικές συναρτήσεις 

(logical functions) 
 
• Βέλος στο AutoSum > More functions > Logical, 
 
 
 
• Επιλέγουμε π.χ. 

 
=ΙF 
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AND 

 
 
NOT 

 
 

3) Lookup and reference functions 
• Βέλος στο  AutoSum > More functions > Lookup & Reference 
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• Επιλέγουμε π.χ. 
CHOOSE 
 

 
 
MATCH 

 

 

 

 

5.5 ΛΟΓΙΣΤΙΚΑ ΦΥΛΛΑ  EXCEL  
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ΚΕΦΑΛΑΙΟ  6 
Εφαρμογές Λογιστικών Φύλλων στην Υδρολογία 
Μ. Βαφειάδης, αναπλ. καθηγητής Α.Π.Θ. 
 
6.1 Υ∆ΡΟΛΟΓΙΑ Υ∆ΡΟΛΟΓΙΑ 

Η Υδρολογία είναι η επιστήµη που διαπραγµατεύεται τα σχετικά µε τα 
φυσικά ύδατα, την προέλευση, κυκλοφορία και διανοµή τους, τις φυσικές και 
χηµικές τους ιδιότητες και την αντίδραση τους µε το περιβάλλον σε σχέση και προς 
τα έµβια όντα. Η µελέτη του πολυσύνθετου αυτού αντικειµένου της Υδρολογίας 
δεν επιδιώκει απλώς την ικανοποίηση της επιστηµονικής περιέργειας, αλλά 
συγκεκριµένα πρακτικά αποτελέσµατα: 
Α) Την ανακάλυψη, αξιοποίηση, διαχείρηση και προστασία των υδατικών πόρων 
Β) Την εξασφάλιση του ανθρώπου και των υλικών δηµιουργηµάτων του (τεχνικά 
έργα, καλλιέργειες) από τις καταστροφές των πληµµυρών και της ξηρασίας 
Πρόκειται για δύο µεγάλες κατηγορίες προβληµάτων που απασχολούν τον πολιτικό 
µηχανικό 

 
6.2 ΑΝΤΙΠΛΗΜΜΥΡΙΚΗ ΠΡΟΣΤΑΣΙΑ ΑΝΤΙΠΛΗΜΜΥΡΙΚΗ ΠΡΟΣΤΑΣΙΑ 
6.2.1 Πλημμύρες  

Με τον τυποποιηµένο όρο “ακραίες υδρολογικές καταστάσεις” 
προσδιορίζουµε τις ακραίες περιπτώσεις ανεπάρκειας του νερού (ξηρασία) ή της 
επικίνδυνα υπερβολικής ποσότητας του (πληµµύρες). Όπως και σε κάθε άλλο 
χώρο, έτσι και στην υδρολογία οι ακραίες καταστάσεις είναι αυτές που κυρίως 
προσελκύουν το ενδιαφέρον µας, απαιτούν την προσοχή µας και την συστηµατική 
µελέτη και ανάπτυξη ειδικών µεθόδων για την ανάλυση, την περιγραφή, την 
πρόγνωση και αντιµετώπιση τους.  

Πέρα από το καθαρά επιστηµονικό και τεχνικό ενδιαφέρον που 
παρουσιάζουν, οι ακραίες υδρολογικές καταστάσεις έχουν µία έντονη κοινωνική 
διάσταση αφού όταν γίνουν ανεξέλεγκτες µπορούν να επηρεάσουν, να 
διαταράξουν ή ακόµη και να καταστρέψουν τον φυσιολογικό ρυθµό της ζωής σε 
µεγάλες περιοχές. 

Τα µέσα µαζικής ενηµερώσεως παρουσιάζουν συχνά τοπικές πληµµύρες ως 
ξαιρετικά καταστροφικές. Αυτό δεν οφείλεται µόνο στην συνηθισµένη 
υπερδιόγκωση των γεγονότων από τους δηµοσιογράφους. Οι πληµµύρες 
επισύρουν τη µοµφή της κοινής γνώµης κατά των µηχανικών και της πολιτείας για 
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δύο λόγους: 1ο) διότι φαίνεται περίεργο να συµβαίνουν στην Ελλάδα, χώρα που 
θεωρείται γενικά ξηρή, και 2ο) διότι ενώ ο καθένας δέχεται ότι η ξηρασία είναι ένα 
άµεσο και έµµεσο αποτέλεσµα της ανοµβρίας, για τις πληµµύρες υπάρχει η γνώµη 
ότι µπορούν να αντιµετωπιστούν πλήρως µε την κατάλληλη τεχνική υποδοµή. 
 
6.2.2 Ορισµός της πληµµύρας.  

Με τον όρο πληµµύρα εννοούµε γενικά την ανεξέλεγκτη κατάκλυση µίας 
περιοχής από το νερό. Για την Επιφανειακή Υδρολογία, τον επιστηµονικό κλάδο 
που µελετά την κίνηση των φυσικών υδάτων επάνω στην επιφάνεια της γης, η 
έννοια της πληµµύρας είναι λίγο διαφορετική και έχει να κάνει απλά µε τη σχετικά 
µεγαλύτερη παροχή σε ένα υδατόρρευµα. 

Αναφέρονται ακόµη οι όροι: Πληµµυρική απορροή, παροχή πληµµύρας, 
µέγιστες παροχές και ακραίες παροχές. Αυτοί οι όροι έχουν τους αντίστοιχους τους 
για το φαινόµενο της ξηρασίας, που είναι: παροχές ξηρών περιόδων, χαµηλές 
παροχές, ελάχιστες παροχές. 

Σαν αντικείµενο µελέτης η πληµµύρα έχει δύο σκέλη: 
1. Φυσικό φαινόµενο, συνέπειες, και αντιµετώπιση µε τεχνικά έργα και διοικητικά 
µέτρα 

2. Μαθηµατική και υπολογιστική αντιµετώπιση του φαινοµένου. 

Σαν φυσικό φαινόµενο η πληµµύρα είναι ένα δυναµικό, βίαιο µπορούµε να 
πούµε, 
φαινόµενο, εξαιρετικά επικίνδυνο και καταστρεπτικό, που εµφανίζεται γενικά 
“απρόβλεπτα” και που αφήνει ελάχιστα χρονικά περιθώρια για να µπορέσει να 
εκδηλώσει κανείς κάποια αντίδραση για την αντιµετώπιση του. Στον ελληνικό 
χώρο εµφανίζεται τοπικά και έχει µικρή διάρκεια. 

Το κύριο αντικείµενο µελέτης του φαινοµένου και µέληµα των µηχανικών 
είναι το πώς θα αποφύγει ακραίες παροχές, “πληµµυρικές παροχές”, να 
µετατραπούν σε πληµµύρα, σε συνδυασµό πάντα µε τις αλλαγές που επιφέρει η 
ανάπτυξη µίας περιοχής στην φυσική διαµόρφωση της επιφάνειας της περιοχής 
(τεχνικά έργα, κατασκευές, αστικοποίηση). 

Ποία είναι τα αίτια που µπορούν να προκαλέσουν πληµµύρα; ∆εν είναι η 
υπερβολική αύξηση της επιφανειακής απορροής που οδηγεί από µόνη της σε 
πληµµύρα αλλά η απώλεια του ελέγχου της απορροής αυτής. 

Υπάρχουν φυσικά και ανθρωπογενή αίτια που προκαλούν πληµµύρες: 

1. Φυσικά αίτια: Μετεωρολογικά φαινόµενα (καταιγίδα, τήξη χιονιού από αύξηση 
της θερµοκρασίας, τήξη χιονιού από βροχή), γεωλογικά φαινόµενα 
(κατολισθήσεις, συµπεριφορά καρστικών εδαφών), διατάραξη της φυσικής 
απορροής στα κατάντη (απόφραξη φυσικού υδατορρεύµατος από εναποθέσεις και 
κορµούς δέντρων που παρασύρθηκαν, απόφραξη από κοµµάτια πάγου). 

2. Ανθρωπογενή αίτια: Θραύση φράγµατος, κακός χειρισµός υδραυλικών 
εγκαταστάσεων (υπερχειλιστές, φράγµατα εκτροπής), θραύση αναχωµάτων, 
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θραύση αγωγών υπό πίεση, κακός σχεδιασµός ή συντήρηση στραγγιστικών 
δικτύων. 

3.Έµµεσα ανθρωπογενή αίτια: Αποψίλωση δασών, αστικοποίηση 
(αδιαβροχοποίηση επιφανειών και αύξηση του συντελεστού απορροής) 
καταστροφή φυσικών ρευµάτων και διατάραξη του υδρογραφικού δικτύου µίας 
περιοχής 
 
6.3 ΘΕΩΡΙΑ ΜΟΝΑ∆ΙΑΙΟΥ Υ∆ΡΟΓΡΑΦΗΜΑΤΟΣ 
 

6.3.1 Το υδρογράφημα απορροής  

 

Το διάγραµµα της παροχής σαν συνάρτηση του χρόνου Q = Q(t) σε ένα 
ορισµένο σηµείο της κοίτης ενός υδατορρεύµατος καλείται υδρογράφηµα και έχει 
τα γενικά χαρακτηριστικά που φαίνονται στο ακόλουθο σχήµα: 

 
Σχήμα 6.1 Το υδρογράφηµα και τα χαρακτηριστικά του (παράδειγµα). 

 

Το νερό που ρέει στα υδατορρεύµατα, προέρχεται από πηγές που έχουν 
σχετικά σταθερή παροχή στην διάρκεια του χρόνου (υπόγεια ή βασική ροή) και 
από την άµεση απορροή που οφείλεται στην βροχή. Εάν έχουµε µια περίοδο 
χωρίς βροχή η παροχή είναι σχετικά σταθερή, αυξάνει όµως απότοµα µετά από 
έντονες βροχοπτώσεις ή καταιγίδες, δηµιουργώντας πληµµυρικές αιχµές, 
δηλαδή µικρές χρονικές περιόδους µε απότοµη αύξηση και κατόπιν µείωση της 
παροχής. Οι πληµµυρικές αιχµές αντιστοιχούν σε παροχή πολλές φορές 
µεγαλύτερη από την κανονική ροή του ποταµού και µπορούν να δηµιουργήσουν 
υπερχειλίσεις και πληµµύρα. Τα αντίστοιχα πληµµυρικά υδρογραφήµατα ι 
µεταδίδονται από τα ανάντι προς τα κατάντι µε την µορφή κυµάτων.  

Ένα πρώτο µέληµα του Πολιτικού Μηχανικού είναι ο προσδιορισµός του 
υδρογραφήµατος που θα προκύψει από την βροχή ή την καταιγίδα σε µια περιοχή 
που τροφοδοτεί ένα υδατόρρευµα, την λεκάνη απορροής. Η µέγιστη παροχή 
αλλά και το υδρογράφηµα που προσδιορίζει το πώς θα αρχίσει να αυξάνει ή 
παροχή καθώς θα συγκεντρώνονται στο υδατόρρευµα όλο και µεγαλύτερες 
ποσότητες νερού (καµπύλη συγκεντρώσεως), σε πόσο χρόνο θα φθάσει το 
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µέγιστο της παροχής (χρόνος συγκεντρώσεως) και τέλος µε ποιο ρυθµό θα 
εκτονωθεί η παροχή (καµπύλη εκτονώσεως) και σε πόσο χρόνο θα 
αποκατασταθεί η κανονική ροή (βασική ροή) στο υδατόρρευµα (χρόνος 
εκτονώσεως), εξαρτώνται τόσο από τα χαρακτηριστικά της λεκάνης απορροής 
(επιφάνεια, µορφή, ανάγλυφο, κλίσεις, βλάστηση κλπ), όσο και από την διάρκεια 
και ένταση της βροχής. Το διάγραµµα της βροχής στον χρόνο (P =P(t)) 
ονοµάζεται υετόγραµµα. 
 

6.4 TO ΜΟΝΑΔΙΑΙΟ ΥΔΡΟΓΡΑΦΗΜΑ  
 

Η αρχή του µοναδιαίου υδρογραφήµατος πρωτοπαρουσιάσθηκε από τον 
SHERMAN στα 1942. Σύµφωνα µε αυτήν γίνεται αποδεκτό ότι µία βροχή µε 
σταθερή µοναδιαία ένταση και µε µοναδιαία διάρκεια επάνω σε µία λεκάνη 
απορροής, γεννά ένα µοναδιαίο υδρογράφηµα που είναι χαρακτηριστικό για την 
λεκάνη απορροής. 
 
 

 
Σχήμα 6.2 Μοναδιαίο υδρογράφηµα Q(t) που αντιστοιχεί σε µια µοναδιαία βροχή P(t), για µια 
δεδοµένη λεκάνη απορροής (παράδειγµα). 
 

Τα υδρογραφήµατα που προέρχονται από βροχές πολλαπλάσιας εντάσεως 
ή/και διάρκειας, καθώς και αυτά που προέρχονται από σύνθετες µορφές βροχής 
(σύνθετα υδρογραφήµατα) µπορούν να υπολογισθούν από το µοναδιαίο 
υδρογράφηµα, εφαρµόζοντας τις αρχές α) της γραµµικότητας και β) της 
σταθερότητας στο χρόνο  
 
Σύνθετα υδρογραφήµατα 

Τα υδρογραφήµατα που προέρχονται από βροχές πολλαπλάσιας εντάσεως 
ή/και διάρκειας, καθώς και αυτά που προέρχονται από σύνθετες µορφές βροχής 
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µπορούν να υπολογισθούν από το µοναδιαίο υδρογράφηµα, εφαρµόζοντας τις 
αρχές α) της γραµµικότητας και β) της σταθερότητας στο χρόνο: 
 
Υδρογράφηµα από βροχή διπλάσιας έντασης. 
 

Η διάρκεια του υδρογραφήµατος είναι ή ίδια µε αυτήν του µοναδιαίου 
υδρογραφήµατος, όµως οι αντίστοιχες τιµές της παροχής (τεταγµένες του 
υδρογραφήµατος) είναι διπλάσιες. 

 

 
Σχήμα 6.3 Υδρογράφηµα από βροχή διπλάσιας έντασης 

 

Υδρογράφηµα από βροχή διπλάσιας διάρκειας 
 

Στην περίπτωση που η βροχή συνεχίζεται πέρα από την πρώτη µοναδιαία 
περίοδο και για µια ακόµη µοναδιαία περίοδο, θεωρούµε ότι παράγεται ένα νέο 
υδρογράφηµα που αρχίζει την στιγµή που αρχίζει η δεύτερη περίοδος της βροχής 
και είναι ίδιο µε το πρώτο. Το τελικό αποτέλεσµα προκύπτει από την πρόσθεση των 
τιµών της παροχής (τεταγµένων του υδρογραφήµατος) για το κοινό διάστηµα των 
δύο υδρογραφηµάτων (επαλληλία): 
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Σχήμα 6.4 Υδρογράφηµα από βροχή διπλάσιας διάρκειας 

 
Σύνθεση υδρογραφήµατος 
 

Με τον ίδιο τρόπο µπορούν προσδιοριστού και πιο σύνθετα υδρογραφήµατα 
που αντιστοιχούν σε σύνθετα υετογράµµατα: 

 
Σχήμα 6.5 Σύνθετο υδρογράφημα 
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Με τον τρόπο αυτό είναι δυνατόν να εκτιµηθούν τα αποτελέσµατα 
οποιασδήποτε πραγµατικής βροχοπτώσεως ή να δοκιµασθούν διάφορα «σενάρια», 
δηλαδή υποθετικές βροχοπτώσεις, ώστε να προσδιριστούν οι πλέον κρίσιµες 
καταστάσεις που θα µπορούσαν να προκύψουν. 

Είναι προφανές οτι για να είναι δυνατή η εφαρµογή της µεθόδου του 
µοναδιαίου υδρογραφήµατος , το µοναδιαίο υδρογράφηµα θα πρέπει να είναι γνωστό. 

 
6.5 ΠΡΟΣ∆ΙΟΡΙΣΜΟΣ ΤΟΥ ΜΟΝΑ∆ΙΑΙΟΥ Υ∆ΡΟΓΡΑΦΗΜΑΤΟΣ 

Σε περιπτώσεις υδρολογικών µελετών για τεχνικά έργα τα απαιτούµενα 
µοναδιαία υδρογραφήµατα αποτελούν «δεδοµένα» που προκύπτουν από µετρήσεις 
και υδρολογική ανάλυση. Το µοναδιαίο υδρογράφηµα (ΜΥ) µιας λεκάνης είναι ένα 
σηµαντικό χαρακτηριστικό στοιχείο της λεκάνης και επιτρέπει τον άµεσο 
προσδιορισµό της απορροής για οποιαδήποτε βροχόπτωση. Πως όµως 
προσδιορίζεται το µοναδιαίο υδρογράφηµα; 
Υπάρχουν τρεις τρόποι: 

1. Εάν έχουµε ταυτόχρονη καταγραφή της βροχής και της παροχής στην έξοδο της 
λεκάνης, δηλαδή ένα υετόγραµµα και το αντίστοιχο υδρογράφηµα, λύνουµε το 
“αντίστροφο” πρόβληµα και υπολογίζουµε το µοναδιαίο υδρογράφηµα. 
2. Εκτιµούµε το µοναδιαίο υδρογράφηµα από τα γεωµορφολογικά χαρακτηριστικά 
της λεκάνης (ανάγλυφο, κλίσεις, υδρογραφικό δίκτυο κλπ.) 
3. Με βάση τυπικά µοναδιαία υδρογραφήµατα και τον χωρισµό της λεκάνης σε 
υπολεκάνες. 
 
6.5.1 Προσδιορισμός του ΜΥ από ένα ζεύγος υετογράμματος – υδρογραφήματος 

  
Έστω το ακόλουθο υετόγραµµα και το αντίστοιχο υδρογράφηµα: 

 

 
Σχήμα 6.6 Ζεύγος ταυτόχρονων καταγραφών της βροχής (υετόγραµµα) και της απορροής 
(υδρογράφηµα) 
 
∆ιακριτοποιούµε το υετόγραµµα και το υδρογράφηµα, δηλαδή εκτιµούµε τις 
αντίστοιχες τιµές για χρονικές στιγµές που προκύπτουν από ένα σταθερό χρονικό 
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βήµα που εφαρµόζεται από την έναρξη της βροχής και της απορροής. Επιπλέον για 
την ένταση της βροχής θεωρούµε µια µέση ένταση, σταθερή στην διάρκεια µιας 
περιόδου : 

 
Σχήμα 6.7 ∆ιακριτοποίηση ενός ζεύγους υετογράµµατος-υδρογραφήµατος 

 
Με τη διακριτοποίηση, η συνεχής βροχή επιµερίζεται σε r περιόδους µε 

αντίστοιχες σταθερές εντάσεις P1, P2 , ..., Pr. Το υδρογράφηµα απορροής 
υποδιαιρείται αντίστοιχα σε m περιόδους και οι τεταγµένες του Χ1, Χ2 , ..., Χm-1 
είναι γνωστές. Θεωρούµε ότι το υδρογράφηµα προέκυψε από την σύνθεση ρ 
υδρογραφηµάτων που προέκυψαν από την εφαρµογή της θεωρίας του µοναδιαίου 
υδρογραφήµατος στο διακριτοποιηµένο υετόγραµµα P(t). Ποιο όµως ήταν το 
αντίστοιχο υδρογράφηµα που χρησιµοποιήθηκε; 
 
Το µοναδιαίο υδρογράφηµα θα έχει n περιόδους όπου 

m = n + ( r – 1 ) 
 
Στο παράδειγµα r = 3 και P1, P2 , και P3, m = 7 και Χ1, Χ2 , ..., Χ6, άρα 

n = m – ( r – 1 ) = 7 – 3 + 1 = 5 
  
Εάν υποθέσουµε οτι το µοναδιαίο υδρογράφηµα της λεκάνης έχει τεταγµένες u 
τότε το υδρογράφηµα απορροής θα αντιστοιχεί στη σύνθεση τριών 
υδρογραφηµάτων: 

• Oι τεταγµένες του µοναδιαίου υδρογραφήµατος είναι u1, u2 , u3 , και u4. 
• Οι τεταγµένες του σύνθετου υδρογραφήµατος Χ1, Χ2, …, Χ6 προέκυψαν 

από επαλληλία τριών υδρογραφηµάτων που προέκυψαν το καθένα από το 
γινόµενο των τεταγµένων του µοναδιαίου υδρογραφήµατος (u1, u2 , u3 , 
και u4) επί το αντίστοιχο ύψος βροχής της κάθε περιόδου (P1, P2 , και P3). 
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Σχήμα 6.8 Ανάλυση του σύνθετου υδρογραφήµατος σε τρία υδρογραφήµατα που βασίζονται στο 

µοναδιαίο υδρογράφηµα. 

 
Προκύπτει το ακόλουθο σύστηµα εξισώσεων: 
 

P1u1     = X1 
P2u1 + P1u2   = X2 
P3u1 + P2u2 + P1u3  = X3 
P3u2 + P2u3 + P1u4  = X4 
P3u3 + P2u4   = X5 
P3u4     = X6 

Έχουµε ένα σύστηµα 6 εξισώσεων µε 4 αγνώστους τα u1, u2 , u3 , και u4 . Το 
σύστηµα αυτό µπορεί να επιλυθεί µόνο κατά την έννοια των ελάχιστων 
τετραγωνικών σφαλµάτων (µέθοδος των ελαχίστων τετραγώνων). 

Σε µητρωική µορφή το σύστηµα γράφεται: 

Pu = X 

Το τετραγωνικό σφάλµα στην εκτίµηση των Χ είναι: 

Q = ( Pu – X )T ( Pu – X ) 

Εάν ελαχιστοποιήσουµε αυτό το σφάλµα 

Q = ( Pu – X )T ( Pu – X ) 

Θα προκύψει το αντίστοιχο σύστηµα κανονικών εξισώσεων 

PT Pu = PTX 

το οποίο είναι ένα σύστηµα 4 εξισώσεων µε 4 αγνώστους και λύνεται κατά τα 
γνωστά 

 
 
 
 
 
 



ΚΕΦΑΛΑΙΟ 6: Εφαρμογές λογιστικών Φύλλων στην Υδρολογία                          

 

148 

6.6 ΕΠΙΛΥΣΗ ΤΟΥ ΠΡΟΒΛΗΜΑΤΟΣ ΜΕ ΠΡΟΓΡΑΜΜΑ ΛΟΓΙΣΤΙΚΟΥ ΦΥΛΛΟΥ 
(STAROFFICE Η OPEN OFFICE CALC, MS-EXCEL) 
 

Τα προγράµµατα λογιστικών φύλλων δηµιουργήθηκαν για την 
πραγµατοποίηση σύνθετων υπολογισµών σε πίνακες αριθµών. Εκτός από απλούς 
υπολογισµούς µε µεµονωµένα κελιά επιτρέπουν και τον χειρισµό ολόκληρων 
πινάκων (µητρώων) σαν να πρόκειται για απλούς αριθµούς. Για τον σκοπόν αυτόν 
τα πλέον διαδεδοµένα σήµερα προγράµµατα Calc του Staroffice/Open Office 
και EXCEL του Microsoft Office διαθέτουν µια οµάδα ειδικών εντολών. Οι 
εντολές αυτές είναι οι ίδιες και στα δύο προγράµµατα: 
 
Α. Μαθηµατικές συναρτήσεις για πίνακες. 
MDETERM Ορίζουσα ενός πίνακα 
MMULT Γινόµενο δύο πινάκων 
MINVERSE Αντίστροφος ενός πίνακα 
TRANSPOSE Ανάστροφος ενός πίνακα 
MUNIT ∆ηµιουργία µοναδιαίου πίνακα (Μόνο στο Staroffice/OpenOffice) 
SUMPRODUCT Άθροισµα των γινοµένων των αντίστοιχων στοιχείων του πίνακα 
SUMX2MY2 Άθροισµα της διαφοράς τετραγώνων για τις αντίστοιχες τιµές δύο 
πινάκων 
SUMX2PY2 Άθροισµα του αθροίσµατος τετραγώνων για τις αντίστοιχες τιµές δύο 
πινάκων 
SUMXMY2 Άθροισµα των τετραγώνων της διαφοράς για τις αντίστοιχες τιµές δύο 
πινάκων 
 
Β. Λοιπές συναρτήσεις για πίνακες. 
HLOOKUP Αναζήτηση µιας τιµής στην πρώτη γραµµή ενός πίνακα ή σειράς τιµών, 
και επιστροφή κατόπιν µιας τιµής στην ίδια στήλη από µια σειρά που ορίσθηκε 
στον πίνακα ή την σειρά. 
VLOOKUP Αναζήτηση µιας τιµής στην πρώτη στήλη ενός πίνακα ή σειράς τιµών, 
και επιστροφή κατόπιν µιας τιµής στην ίδια γραµµή από µια σειρά που ορίσθηκε 
στον πίνακα ή την σειρά. 
MATCH Αναζήτηση της θέσεως ενός στοιχείου που ταιριάζει µε µια ορισµένη τιµή 
σε µια δεδοµένη σειρά. 
PEARSON Υπολογισµός του συντελεστή γραµµικής συσχετίσεως ανάµεσα σε δύο 
ανύσµατα. 
LINEST Υπολογισµός µιας ευθείας παλινδροµήσεως. 
LOGEST Υπολογισµός µιας εκθετικής καµπύλης παλινδροµήσεως. 
FORECAST Υπολογισµός ή πρόβλεψη, µιας µελλοντικής τιµής µε βάση γνωστές 
προηγούµενες τιµές. 
TREND Υπολογίζει την ευθεία τάσεως που αντιστοιχεί στα δεδοµένα GROWTH 
Προσαρµόζει µια εκθετική καµπύλη στα σηµεία δεδοµένων που δίνονται. 
FREQUENCY Υπολογισµός της συχνότητας εµφανίσεως ορισµένων τιµών σε µια 
δεδοµένη σειρά τιµών. 
INDEX Τιµή ή αναφορά σε τιµή, σε µια περιοχή τιµών ενός πίνακα. 
MDETERM Αποδίδει _________την ορίζουσα ενός πίνακα  
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6.7 ΕΦΑΡΜΟΓΗ 
 

Να προσδιοριστεί το µοναδιαίο υδρογράφηµα λεκάνης απορροής για την 
οποία διατίθεται το ακόλουθο ζεύγος καταγραφών βροχής και απορροής 
(υετόγραµµα- υδρογράφηµα): 

P1= 1, P2=2, P3=1 
X1=9, X2=42, X3=80, X4=70, X5=35, X6=10 

Λύση 
Η βροχή διαρκεί 3 χρονικές περιόδους, ενώ η απορροή διαρκεί 7 χρονικές 
περιόδους. Το µοναδιαίο υδρογράφηµα που αναζητούµε θα έχει n περιόδους που 
θα ικανοποιούν την σχέση: 

m = n + (r – 1) ή 7 = n + (3-1) και n = 5 
άρα θα προσδιορίσουµε 4 τεταγµένες, τις u1, u2, u3 και u4. Γράφουµε το 
αντίστοιχο σύστηµα των εξισώσεων: 
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Στην συνέχεια υπολογίζουµε µε την σειρά τους απαραίτητους όρους ώστε να 
καταλήξουµε στις τιµές του µοναδιαίου υδρογραφήµατος: 
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Η διαδικασία και οι αντίστοιχες συναρτήσεις του λογιστικού φύλλου φαίνονται στις 
ακόλουθες εικόνες: 
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Οι µαθηµατικοί τύποι και οι γραµµές που περιορίζουν τους πίνακες εισάγονται 
ξεχωριστά σαν κείµενο και σαν µορφοποίηση του περιγράµµατος. 

 
 


